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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements accompanying such 
products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be 
liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with FAR 
12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and Technical Data for 
Commercial Items are licensed to the U.S. Government under vendor's standard commercial license.

Copyright Notices

© Copyright 1997-2009, 2011 Hewlett-Packard Development Company, L.P.

Trademark Notices

Adobe® is a trademark of Adobe Systems Incorporated.

Intel®, Intel® Itanium®, Intel® Xeon™, and Pentium® are trademarks or registered trademarks of Intel Corporation 
or its subsidiaries in the United States and other countries.

Java is a registered trademark of Oracle and/or its affiliates.

Microsoft®, Windows®, and Windows® XP are U.S. registered trademarks of Microsoft Corporation.

Microsoft Vista® is either a registered trademark or trademark of Microsoft Corporation in the United States and/or 
other countries.

Oracle® is a registered U.S. trademark of Oracle Corporation, Redwood City, California.

UNIX® is a registered trademark of The Open Group.
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Documentation Updates

This manual’s title page contains the following identifying information:

Software version number, which indicates the software version

Document release date, which changes each time the document is updated

Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

h20230.www2.hp.com/selfsolve/manuals

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact 
your HP sales representative for details.
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Support

You can visit the HP Software Support Web site at:

hp.com/go/hpsoftwaresupport

HP Software Support Online provides an efficient way to access interactive technical support tools. As a valued 
support customer, you can benefit by using the support site to:

Search for knowledge documents of interest

Submit and track support cases and enhancement requests

Download software patches

Manage support contracts

Look up HP support contacts

Review information about available services

Enter into discussions with other software customers

Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support 
contract.

To find more information about access levels, go to: 

h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to: 

h20229.www2.hp.com/passport-registration.html
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1 Getting Started with Application Lifecycle 
Management
HP Application Lifecycle Management (ALM) software is a solution for 
supporting Change Management and Release Management within your 
organization. The ALM software provides PPM Center entities that support 
standard Information Technology Infrastructure Library (ITIL) processes and 
that can be configured to meet your business needs. 

ALM software enables you to integrate PPM Center with the following 
applications:

Service desk applications, including HP Service Manager

HP Universal Configuration Management Database (Universal CMDB)

HP Quality Center

HP Release Control

HP Change Control Management

These integrations help your IT organization standardize and enforce processes 
that manage application changes throughout the entire software development 
lifecycle, including development, testing, and deployment.

The versions of these products that are supported for integration with PPM 
Center are described in the System Requirements and Compatibility Matrix. 

Installing ALM provides all of the entities that are used by any combination of 
the integrations you choose to configure and use. 

Hereafter in this guide, references to HP Release Control (the successor product to 
HP Change Control Management) also apply to supported versions of HP Change 
Control Management.
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For information about how to obtain the ALM software and how to view or 
print this guide, see Overview of Installation and Configuration on page 25.

Introduction to ITIL and HP Application Lifecycle Management

The Information Technology Infrastructure Library (ITIL) offers the world’s 
most widely accepted approach to IT Service Management (ITSM), furthering 
the goal of aligning IT with business goals and priorities. ITIL provides 
frameworks for both the organization of ITSM as well as a cohesive set of 
industry best practices.

ITIL is a process framework, and HP Project and Portfolio Management 
Center (PPM Center) is unique in its ability to customize, automate, and 
digitize processes, simplifying repeatability, enforcement, and measurement.

ITIL defines the Service Support discipline. Building on this advanced-process 
model, HP Application Lifecycle Management (ALM) uses predefined request 
types (forms), workflows, and special commands to automate processes and 
information gathering, and ALM uses portlets and reports to track key 
performance indicators (KPIs). 

ALM supports the following ITIL processes:

Change Management. Overview of ITIL Change Management on page 14 
provides an overview of the ITIL Change Management process and how 
ALM supports the process. Chapter 3, Using ALM Entities, on page 33 
describes the entities provided by ALM for ITIL Change Management.

Release Management. Overview of ITIL Release Management on page 16 
provides an overview of the ITIL Release Management process and how 
ALM supports the process. Chapter 3, Using ALM Entities, on page 33 
describes the entities provided by ALM for ITIL Release Management.

ALM can be used as a starting point, and then extended to support the process 
requirements that meet the specific needs of your organization. Using these 
tools, ALM helps enforce repeatable ITIL processes to reduce their operating 
cost and risk.
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Chapter 2, Installing and Setting Up ALM Software, on page 25 provides 
instructions for installing ALM and configuring PPM Center to ensure that 
ALM functions properly.

Chapter 3, Using ALM Entities, on page 33 provides information about the 
ALM entities, except for a few that are used only for integration of PPM 
Center with HP Quality Center. 

ALM enables integration of PPM Center with the HP Service Manager service 
desk application. Using these integrations, service desk application changes 
can be automatically converted to ALM requests for change and imported into 
PPM Center. In addition, fields in PPM Center can be configured to send 
updates back to the originating changes in HP Service Manager. For more 
information, see Integration of PPM Center with Service Desk Applications 
on page 17 and Chapter 4, Integration of PPM Center with HP Service 
Manager, on page 93.

For additional Change Management and Release Management functionality, 
ALM provides the ability to integrate PPM Center with HP Universal CMDB, 
with HP Quality Center, and with HP Change Control Management and its 
successor product, HP Release Control. 

Using these integrations and appropriate approvals throughout the process, the 
ALM - Request for Change workflow (and the ALM subworkflows the 
workflow calls) does the following:

Uses HP Universal CMDB to perform preliminary impact analysis on a 
proposed change.

Automatically creates HP Quality Center requirements or defects based on 
associated PPM Center requests and keeps their fields synchronized, 
providing data visibility in both applications and ensuring that QA 
personnel create and execute appropriate test plans.

When adding a package to a release, provides links in an ALM portlet to 
HP Release Control or HP Change Control Management for that release. 
HP Release Control or HP Change Control Management displays impact 
and collision analysis for the release that is poised for deployment to a 
production (live) system.
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For more information about integration of PPM Center with HP Universal 
CMDB, see Integration of PPM Center with HP Universal CMDB on page 19 
and Chapter 5, Integration of PPM Center with Universal CMDB, 
on page 141.

For more information about integration of PPM Center with Quality Center, 
see Integration of PPM Center with HP Quality Center on page 20 and 
Chapter 6, Integration of PPM Center with Quality Center, on page 167.

For more information about integration of PPM Center with Release Control or 
Change Control Management, see Integration of PPM Center with HP Release 
Control or HP Change Control Management on page 21 and Chapter 7, 
Integration of PPM Center with Release Control or Change Control 
Management, on page 241.

Overview of ITIL Change Management

ITIL defines a change as the addition, modification, or removal of an 
approved, supported, or baselined hardware component, network, software, 
application, environment, system, or desktop build, or associated 
documentation. The primary goal of the ITIL Change Management process is 
to ensure that standardized methods and procedures are used for efficient and 
prompt handling of all changes, in order to minimize the impact of 
change-related incidents upon service quality. Although changes often arise as 
a result of unexpected problems, most changes result from planned requests for 
change (RFCs) from the business or IT organization.

ALM allows users to submit RFCs along a predefined Request for Change 
process toward resolution. Portlets provided with ALM can be added to a 
user’s PPM Dashboard to monitor key performance indicators (KPIs) related 
to the submitted RFCs. Additionally, reports can be run to obtain summaries 
and scheduling details.

Chapter 3, Using ALM Entities, on page 33 discusses the PPM Center entities 
that ALM provides for use in the ITIL Change Management process, including 
the following:
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Change Management request type, named ALM - Request for Change 
(RFC)

Associated Change Management workflow, named ALM - Request For 
Change 

Associated Change Management portlets

Associated Change Management reports

These ALM entities simplify each of the supported integrations with PPM 
Center, as introduced in Optional Integrations with PPM Center Enabled by 
ALM on page 17.

Change Management Roles

The following roles play an active part in the ITIL Change Management 
process:

System Owner

Change Manager

CAB group (Change Advisory Board) or CAB/EC group (Change 
Advisory Board – Emergency Committee)

o Change Manager 

o Customer(s) 

o Applications Development Manager

o QA Manager

o Operations Manager (or maintainers where appropriate) 

Change Builder

Independent Tester

Applications Development Manager

In addition to being valuable divisions of responsibility, these roles are used to 
designate user security for the default ALM - Request For Change workflow 
(see ALM - Request For Change Workflow on page 43).
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Overview of ITIL Release Management

ITIL defines a release as a collection of new and/or changed components that 
are tested and introduced into the live (production) environment together. The 
ITIL Release Management process helps to design and implement efficient 
procedures for the distribution and installation of changes. This process 
includes coordinating build and testing activities to help ensure that only the 
authorized and tested versions of changes are implemented in production. 
Ultimately, releasing a change requires the following actions:

Developing the change

Designing the change

Testing the change for functionality, quality, and performance

Pushing the change into production

ALM makes it easier for users to collect information for a release using a 
release form, which is submitted along a predefined release management 
process (see ALM - Release Request Workflow on page 76). After the initial 
release process steps have been completed, the release is created and the RFCs 
that are being processed along the ALM - Request For Change workflow (see 
ALM - Request For Change Workflow on page 43) can be added to the release 
in preparation for its deployment to the test and live environments. The release 
management process then moves through testing and deployment steps toward 
completion. Portlets provided with ALM can be added to a user’s PPM 
Dashboard to monitor the status of releases. Additionally, reports can be run to 
obtain release summaries and scheduling details.

Chapter 3, Using ALM Entities, on page 33 discusses the PPM Center entities 
that ALM provides for use in the ITIL Release Management process, including 
the following:

Release Management request type, named ALM - Release Management

Associated Release Management workflow, named ALM - Release 
Request 

Associated Release Management portlets

Associated Release Management reports
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Release Management Roles

The following roles play an active part in the ITIL Release Management 
process:

Release Manager

Test Manager

Applications Development Manager

Operations Manager

Change Manager

CAB group (Change Advisory Board)

In addition to being valuable divisions of responsibility, these roles are used to 
designate user security for the default ALM - Release Request workflow (see 
ALM - Release Request Workflow on page 76).

Optional Integrations with PPM Center Enabled by ALM

As described in the following sections, PPM Center version 8.00 can be 
integrated with various products to enhance the functionality of PPM Center 
and those products.

Integration of PPM Center with Service Desk Applications 

The entities provided with ALM simplify the integration of PPM Center with 
the HP Service Manager service desk application. Integration provides the 
following benefits:

Changes that originate in the service desk application can be automatically 
imported into PPM Center as requests that PPM Center manages.

Changes in the HP Service Manager service desk application can be 
automatically updated, based on revisions to requests in PPM Center.
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PPM Center acts as a single, comprehensive repository of application 
change requests collected from throughout IT, including change records 
(tickets) from the service desk application.

The ALM software provides configurable adapter files that serve as the 
software interface between PPM Center and the HP Service Manager service 
desk application. An adapter file includes filters and field mappings to convert 
changes from one data model to the other.

This guide assumes that the service desk application has been installed and is 
available for integration. For a list of documents about the service desk 
integrations, see HP Service Manager Documentation on page 22.

For detailed information about configuring and using integration of PPM 
Center with a service desk application, including details about configuring 
parameters in the server.conf file, see Chapter 4, Integration of PPM Center 
with HP Service Manager, on page 93.

Using Integration of PPM Center with HP Quality Center To Enhance Integration of PPM 
Center with Service Desk Applications

Functionality of integration of PPM Center with a service desk application is 
enhanced if PPM Center and HP Quality Center are also integrated—you can 
see HP Quality Center statuses for an RFC in the service desk application and 
in PPM Center. 

See ALM - Request for Change (RFC) Request Type on page 34 for 
descriptions of the ALM - Request for Change (RFC) request type fields that 
are related to integration of PPM Center with HP Quality Center.

Any request type you use for a service desk integration must include the fields in the 
Service Desk System Info section of the ALM - Request for Change (RFC) request 
type, as shown in Table 3-2 on page 37, and those fields must be completed. For 
detailed request type field specifications, see the ALM - Request for Change (RFC) 
request type in the PPM Workbench.

For general information about the benefits of integrating PPM Center and HP Quality 
Center whether or not PPM Center and a service desk application are integrated, see 
Integration of PPM Center with HP Quality Center on page 20. 
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Integration of PPM Center with HP Universal CMDB

PPM Center can be integrated with HP Universal CMDB, providing the 
following benefits:

The Change Advisory Board can use the integration to run an impact 
analysis in HP Universal CMDB and forecast the effects that each change 
request will have on the organization’s IT environment. 

The resulting report provides the Change Advisory Board with an 
indication of how the organization’s system will cope with each change if 
the change is later developed and deployed, and thus assists the Change 
Advisory Board in deciding whether to approve certain changes for 
development.

Your system infrastructure, such as servers or applications, might get 
modified while the software change is being developed and evaluated for 
quality. As a result, the original impact analysis for the change might not 
be valid. After the change has been evaluated and approved for 
deployment, you can perform another impact analysis.

This guide assumes that HP Universal CMDB has been installed and is 
available for integration. 

For a list of documents about HP Universal CMDB, see HP Universal CMDB 
Documentation on page 23.

For detailed information about configuring and using integration of PPM 
Center with HP Universal CMDB, including details about configuring 
parameters in the server.conf file, see Chapter 5, Integration of PPM Center 
with Universal CMDB, on page 141. 
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Integration of PPM Center with HP Quality Center

PPM Center can be integrated with HP Quality Center to incorporate the 
quality assurance (QA) process into the change request development process, 
providing the following benefits:

Integration and enforcement of QA testing into the change process. The 
QA process can be initiated when the development process begins, and QA 
planning activities can proceed in parallel with development. The QA 
teams can then spend more time testing changes after development has 
been completed.

Management and tracking of test requirements, plans, and results in  
HP Quality Center, with visibility in PPM Center.

Data sharing between PPM Center and HP Quality Center.

Automatic activation of HP Quality Center processes by PPM Center. 
Creating a request in PPM Center can create a requirement or defect in  
HP Quality Center.

Automatic ongoing synchronization of defects and requirements in Quality 
Center with requests in PPM Center, as well as hierarchical 
synchronization of requirements in HP Quality Center with requests in 
PPM Center. 

This guide assumes that HP Quality Center has been installed and is available 
for integration. 

For a list of documents about HP Quality Center, see HP Quality Center 
Documentation on page 23.

For detailed information about configuring and using integration of PPM 
Center with HP Quality Center, including details about configuring parameters 
in the server.conf file, see Chapter 6, Integration of PPM Center with 
Quality Center, on page 167. 
20 Chapter 1



Integration of PPM Center with HP Release Control or HP Change Control 
Management

PPM Center can be integrated with HP Release Control or HP Change Control 
Management to assist IT managers and the Change Advisory Board in 
providing the following benefits:

Assessing the business impact of changes that have been developed and 
tested, and deciding whether to approve the changes for deployment

Providing information about the components in the organization’s IT 
environment that will be impacted by the developed changes

Proactively sending notifications of the business risk involved in each 
change

Identifying potential conflicts among concurrently scheduled changes

Improving visibility over the change deployment process

During the impact analysis phase of the Request for Change lifecycle, if PPM 
Center is integrated with both HP Release Control (or HP Change Control 
Management) and Universal CMDB, the Launch HP Release Control button 
appears on the request. When launched, HP Release Control (or HP Change 
Control Management) provides additional impact analysis that helps users 
assess and approve changes.

For each change request, the ALM - Releases portlet provides a link to log in to 
HP Release Control (or HP Change Control Management), where various tabs 
contain information about the change requests. 

This guide assumes that HP Release Control or HP Change Control 
Management has been installed and is available for integration. 

For a list of documents about HP Release Control, see HP Release Control 
Documentation on page 23. For a list of documents about HP Change Control 
Management, see HP Change Control Management Documentation 
on page 24.

For detailed information about configuring and using integration of PPM 
Center with HP Release Control or Change Control Management, including 
details about configuring parameters in the server.conf file, see Chapter 7, 
Integration of PPM Center with Release Control or Change Control 
Management, on page 241. 
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Related Information

The following sections categorize documentation that may be useful for ALM 
deployments.

PPM Center Documentation

The following PPM Center documents provide information that may be useful 
to you: 

HP Demand Management User’s Guide 

HP Demand Management Configuration Guide (includes information 
about configuring request types and workflows)

Creating Portlets and Modules 

Reports Guide and Reference 

HP Deployment Management User’s Guide 

Installation and Administration Guide 

HP Service Manager Documentation 

The following HP Service Manager documents are not directly related to PPM 
Center or integrations with PPM Center, but they may be useful to you: 

HP Service Manager Installation Guide 

HP Service Manager Help system
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HP Universal CMDB Documentation

The following HP Universal CMDB documents are not directly related to PPM 
Center or integrations with PPM Center, but they may be useful to you: 

HP Universal CMDB Deployment Guide 

HP Universal CMDB Database Guide 

HP Universal CMDB Discovery and Dependency Mapping 

HP Universal CMDB Model Management 

HP Universal CMDB CI Attribute Customization 

HP Universal CMDB Glossary 

HP Universal CMDB 7.50 Readme 

HP Quality Center Documentation

The following HP Quality Center documents are not directly related to PPM 
Center or integrations with PPM Center, but they may be useful to you: 

HP Quality Center Installation Guide 

HP Quality Center User’s Guide 

HP Quality Center Administrator’s Guide 

HP Release Control Documentation

The following HP Release Control documents are not directly related to PPM 
Center or integrations with PPM Center, but they may be useful to you: 

HP Release Control Installation and Configuration Guide 

HP Release Control User Guide 
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HP Change Control Management Documentation

The following HP Change Control Management documents are not directly 
related to PPM Center or integrations with PPM Center, but they may be useful 
to you: 

HP Change Control Management Installation and Configuration Guide 

HP Change Control Management User’s Guide 
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2 Installing and Setting Up ALM Software
Overview of Installation and Configuration

Installing and setting up ALM software includes the following procedures, as 
described in this chapter:

Installing the ALM software

Configuring particular ALM-related entities in PPM Center

Restarting the PPM Server

Configuration activities that are unique to the integrations with service desk 
applications, HP Quality Center, HP Release Control or HP Change Control 
Management, and HP Universal CMDB are described in their respective 
chapters.

System Requirements

Before you can install and use HP Application Lifecycle Management version 
2.00, you must install PPM Center version 8.00.

To use the request types and workflows provided by ALM, verify that you 
have user licenses for PPM Center Demand Management. For information 
about permissions, configuration, and security, see the HP Demand 
Management Configuration Guide and the Security Model Guide and 
Reference. 
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Installing HP Application Lifecycle Management

Install HP Application Lifecycle Management (ALM) as described in the 
following sections. 

Considerations If HP Managing Application Change (MAC) Is Installed

If HP Managing Application Change (MAC) was used with PPM Center 
version 7.5, the ALM entities such as request types and workflows do not 
overwrite the analogous MAC entities when ALM is installed. The ALM and 
MAC entities can coexist and can be used independently.

If PPM Center was upgraded from version 7.5 to version 8.00, if you used 
Managing Application Change (MAC) entities with version 7.5 for 
integrations, and if you plan to use ALM entities with version 8.00 for 
integrations, you must reestablish the integrations as described in this guide. 

Integration of PPM Center with Mercury Application Mapping was supported 
with PPM Center version 7.5 and MAC, but integration of PPM Center with 
Mercury Application Mapping is not supported with PPM Center version 8.00 
and ALM. The MAM Impact Analysis field group is no longer available in 
version 8.00. During an upgrade of PPM Center to version 8.00, any MAM 
Impact Analysis reports in version 7.5 are attached to the associated requests as 
references, so the reports remain available to view after the upgrade.
26 Chapter 2



General Preparations for Installation

To prepare for installation:

1. Obtain the ALM software.

2. Log on to the PPM Server.

3. Confirm that the system requirements have been met. See System 
Requirements on page 25.

4. Save the ALM installation file (ppm-800-ALM.jar) to the <PPM_Home> 
directory. <PPM_Home> represents the path where the PPM Center instance 
is installed. For example: xyzserver/E/PPMServer.

Perform Backup and Restart the PPM Server in Restricted Mode

The steps in this section are recommended but not required. 

Before installation, do the following:

1. Back up the database and file system for the PPM Server.

2. Stop the PPM Server and restart it in restricted mode, as follows:

a. Stop the PPM Server.

b. Run the following script: 

sh ./setServerMode.sh RESTRICTED

c. Start the PPM Server.

You do not need to unpack the installation file. The installation process 
automatically unpacks it.

For more information about the steps in this procedure, see the Installation and 
Administration Guide. 
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Run the Installation Script

To run the installation script to install the ALM software:

1. Navigate to the <PPM_Home>/bin directory.

2. Run the following script:

sh ./kDeploy.sh -i ALM

3. As kDeploy.sh runs, respond to its prompts.

When the installation completes successfully, the following message is 
displayed:

Deployment ALM has been successfully installed.

The following sections in this chapter describe initial configuration of ALM.

Configuring ALM-Related Entities in PPM Center

After installing ALM software, perform the procedures described in the 
following sections.

Creating Contact User Data

To use the ALM - Request for Change (RFC) request type, you must create a 
global user data field of type Contact User Data, whether or not you will be 
establishing any of the integrations of PPM Center with other applications. 
When you select a contact in the RFC, the value in the contact’s USER_DATA1 
field populates the Contact Location field in the RFC. Table 2-1 describes the 
important parameters for this field. Figure 2-1 shows the User Data Context 
window.

In the PPM Workbench, select Configuration > User Data and select Contact 
User Data to access the User Data Context window. For more information 
about creating user data, see the HP Demand Management Configuration 
Guide. 
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Figure 2-1. Contact user data field

Table 2-1. Contact user data field parameters

Field Name Value

Prompt Location:

Token LOCATION

User Data Column USER_DATA1

Displayed Y

Component Type Text Field

Validation (any text field of reasonable length)
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Configuring the CRT - Priority - Enabled Validation

To use the ALM - Request for Change (RFC) request type, you must add the 
values listed in Table 2-2 to the CRT - Priority - Enabled validation, whether or 
not you will be establishing any of the integrations of PPM Center with other 
applications. These priority values are used as default values and in rules. The 
rules determine priority from values specified in the Impact and Severity fields 
in the RFC. Figure 2-2 shows the Validation window.

In the PPM Workbench, select Configuration > Validations and select 
CRT - Priority - Enabled to access the Validation window. For more 
information about modifying validations, see the Commands, Tokens, and 
Validations Guide and Reference. 

Figure 2-2. CRT - Priority - Enabled validation

Table 2-2. Values to add to CRT - Priority - Enabled validation

Code Meaning

MEDIUM Medium

IMMEDIATE Immediate

PLANNING Planning
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Assigning Users to ALM Security Groups

ALM provides the following security groups:

ALM - Application Developer

ALM - Applications Development Manager

ALM - CAB group (Change Advisory Board)

ALM - Change Builder

ALM - Change Manager

ALM - Customer

ALM - IT Executive Board

ALM - Independent Tester

ALM - Operations Manager

ALM - QA Manager

ALM - Release Manager

ALM - SOX - System Owner

Users must belong to an appropriate security group to be able to see particular 
portlets. Add users to these security groups, whether or not you will be 
establishing any of the integrations of PPM Center with other applications. In 
the PPM Workbench, select Sys Admin > Users, open a user, and click the 
Security Groups tab. For more information about security groups, see the 
Security Model Guide and Reference. 

Assigning Security Groups to ALM Workflows

ALM provides several workflows. The major ones are described in detail in 
this document. Assign security groups to each workflow step in the manner 
that best meets your business needs, whether or not you will be establishing 
any of the integrations of PPM Center with other applications. In the PPM 
Workbench, select Configuration > Workflows, open a workflow, and edit it. 
For more information about configuring security groups in workflows, see the 
HP Demand Management Configuration Guide. 
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Restarting the PPM Server in Normal Mode

After you have completed all installation and configuration procedures, if you 
previously restarted the PPM Server in restricted mode, to stop and restart the 
PPM Server in normal mode:

1. Stop the PPM Server.

2. Run the following script: 

sh ./setServerMode.sh NORMAL

3. Start the PPM Server.

For More Information

ALM provides request types, workflows, portlets, and reports that can be 
configured to fit your business needs. For detailed information, see Chapter 3, 
Using ALM Entities, on page 33.

You can use the ALM entities whether or not you establish any of the 
supported integrations of PPM Center with other applications. You can 
configure those integrations at any time after you have installed and configured 
ALM as described in this chapter. For more information, see Optional 
Integrations with PPM Center Enabled by ALM on page 17 and the 
integration-related chapters to which that section refers.

For more information about the steps in this procedure, see the Installation and 
Administration Guide. 
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3 Using ALM Entities
Overview of ALM Entities

This chapter describes the request types, workflows, portlets, reports, and 
special commands (the “entities”) provided in ALM to facilitate 
implementation of ITIL processes. Some of these entities are also used by the 
integrations with external service desk applications and other HP products. 

The ALM entities provided for change management are described first, then 
the entities for release management are described, and then the special 
commands.

Several ALM entities that are used only for integrations of PPM Center with 
HP Quality Center are described in Chapter 6, Integration of PPM Center with 
Quality Center, on page 167.
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For More Information

The request types, workflows, portlets, reports, and special commands 
provided with ALM can be configured to fit your business needs. Table 3-1 
lists the types of entities and the associated PPM Center guides to which you 
should refer for configuration information. 

ALM - Request for Change (RFC) Request Type

In its implementation of the ITIL Change Management process, ALM uses the 
ALM - Request for Change (RFC) request type and sends an RFC request 
along the ALM - Request For Change workflow (see ALM - Request For 
Change Workflow on page 43).

Figure 3-1 and Figure 3-2 show the top and bottom of the Create New 
ALM - Request for Change (RFC) page that appears when you create a request 
and select the ALM - Request for Change (RFC) request type. Table 3-2 
on page 37 describes the fields in the ALM - Request for Change (RFC) 
request, including some fields that do not appear until the request is created or 
until other conditions are met.

Table 3-1. PPM Center entities and associated configuration guides

Entity Configuration Guide

Request type HP Demand Management Configuration Guide 

Workflow HP Demand Management Configuration Guide 

Portlet Creating Portlets and Modules 

Report Reports Guide and Reference 

Special command Commands, Tokens, and Validations Guide and Reference 
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Figure 3-1. Top of ALM - Request for Change (RFC) request
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Figure 3-2. Bottom of ALM - Request for Change (RFC) request
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Table 3-2. ALM - Request for Change (RFC) request fields (page 1 of 6)

Field Name (*Required) Description

RFC Summary section

RFC ID (Read-only. Added after the RFC is created.) Number of 
the RFC, linked to the RFC.

Created By (Read-only) User who created the RFC.

Created On (Read-only. Added after the RFC is created.) Date the 
RFC was created.

RFC Status (Read-only) Status of the RFC.

Contact Name Name of the person proposing the change.

Contact Phone (Read-only) Telephone number of the person proposing 
the change.

RFC Priority (Read-only) Priority of the change request. Determined 
by a combination of the Urgency and Impact fields.

Contact Email (Read-only) Email address of the RFC contact person.

Contact Location (Read-only) Location of the person proposing the 
change.

RFC Summary Summary description of the RFC request.

Expected Start Date Expected start date for work on the RFC.

Expected Finish Date Expected end date for work on the RFC.

Assigned Developer Developer assigned to work on the RFC.

Release ID Number of the release if the change was released.

RFC Details section

*RFC Source Source of the RFC request (for example, from a problem 
or incident).

*Urgency Urgency of the change request (for example, from 
problem urgency).

*Impact Business impact of doing or not doing the change (for 
example, from problem impact).
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*Reason For Change Reason for the change.

Category
(Required only after the 
request is created) 

Category of the change, based on the scope of the 
change. 

RFC Type Type of change being requested.

Service IT service that needs the change.

Change Item

(Looks like a separate section in the interface)
Expand to display a table of change items.
If the RFC has been created, click the Modify Table 
button to add a change item. The table consolidates 
existing change items (CIs), each having an 
automatically assigned sequence number (Seq), a CI 
Type (Software, Hardware, or Network), a CI Name, 
and a CI Description. 

*Effect of no change Effect of not implementing the change.

RFC Description Description of the change request.

Authorized By (Added after the RFC is created and assigned to a 
developer) Person who authorized the change.

Authorization Date (Added after the RFC is created and assigned to a 
developer) Date the developer was assigned.

SOX Information section 

*System System that is impacted by the change.

SOX - In Scope System

(Read-only) SOX requirement: SOX oversight is 
required for any application that directly or indirectly 
affects financial reporting. 
This field is automatically populated with a value of Yes 
or No before the RFC is created, based on the option 
chosen for the System field.

Table 3-2. ALM - Request for Change (RFC) request fields (page 2 of 6)

Field Name (*Required) Description
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SOX Risk

SOX requirement: Risk is determined as part of SOX 
oversight.
Note: A change to a non-SOX system could be high-risk 
based on possible infrastructure/network impact.

System Owner

(Read-only. Added after the RFC is created.) Owner of 
the system.
This field is automatically populated, based on the 
option chosen for the System field.

Implementation Details section

Actual Start Date Actual start date for creation of the change.

Actual Finish Date Actual finish date for creation of the change.

Actual Duration Actual duration for creation of the change.

Actual Effort Actual effort expended during creation of the change.

Assigned Change 
Builder Details of the change builder/implementer.

Actual Cost Actual cost of the change.

Functional 
Specifications

Allows you to add and view the functional specification 
document directly on the RFC.

Design Specifications Allows you to add and view the design specification 
document directly on the RFC.

Table 3-2. ALM - Request for Change (RFC) request fields (page 3 of 6)

Field Name (*Required) Description
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Impact & Resource Assessment section

Impact Severity

Specify after evaluating the Impact Analysis Report. 
This field becomes required by the ALM - Impact & 
Resource Assessment Sub WF subworkflow after CIs 
are selected in the Impacted Configuration Items 
section. 

Impact Analysis Report Allows you to add and view an Impact Analysis Report 
generated by Universal CMDB directly on the request.

Impact Assessment 
Summary

Risk assessment of the impact of the change on related 
components in the configuration management database 
(CMDB).

Impact Assessment 
Report

Allows you to add and view a manually generated 
impact assessment report based on the Impact Analysis 
Report directly on the RFC.

Expected Duration Expected duration for creation of the change.

Expected Effort Expected effort for creation of the change.

Expected Cost Expected cost of the change.

Backout Plan Allows you to add and view the backout plan document 
directly on the RFC.

CAB Recommendations CAB recommendations, where appropriate.

Users Impacted Users expected to be impacted by the change.

Impacted Configuration Items section a 

Select Configuration 
Items button

Button to launch the CI selector applet provided by 
Universal CMDB.

Impacted Configuration 
Items list

List of CIs added to the request, both manually and by 
using the CI selector applet from Universal CMDB.

QA Details section

Assigned Tester Person assigned to test the change.

Table 3-2. ALM - Request for Change (RFC) request fields (page 4 of 6)

Field Name (*Required) Description
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Test Plan Allows you to add and view the test plan directly on the 
RFC.

Detailed Test Results 
(SOX)

Allows you to add and view the detailed test results 
directly on the RFC.

Quality Center Info section b

Quality Center Instance Quality Center instance that will receive the new PPM 
Center request.

Quality Center Domain Quality Center domain of the working project.

Quality Center Project Quality Center project that is linked with this request.

Quality Center Assigned 
To User User assigned to the Quality Center requirement.

Quality Center 
Requirement No. (Read-only) Quality Center requirement number.

Quality Center Status (Read-only) Quality Center requirement status.

Quality Center Message (Read-only) Message indicating whether the last update 
to the request was successful in Quality Center.

Quality Center 
Attachments (Read-only) URL of the attached requirement document.

Service Desk System Info section c

System Name (Read-only) Name of the service desk application.

Ticket Id (Read-only) Ticket ID in the service desk application.

Ticket Creation Date (Read-only) Ticket creation date in the service desk 
application.

Ticket Info (Read-only) Ticket info from the service desk 
application.

Ticket Priority (Read-only) Ticket priority in the service desk 
application.

Ticket Last Update (Read-only) Date the ticket was last updated in the 
service desk application.

Table 3-2. ALM - Request for Change (RFC) request fields (page 5 of 6)

Field Name (*Required) Description
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To submit an ALM - Request for Change (RFC) request:

1. Log on to PPM Center.

2. From the menu bar, select Create > Request. 

The Create New Request page appears.

3. On the Create New Request page, in the Request Type field, select 
ALM - Request for Change (RFC) and click Create. 

The Create New ALM - Request for Change (RFC) page appears, 
displaying the appropriate RFC fields.

Required fields have a red asterisk. All other fields are optional, but are 
often helpful when others are reviewing an open request. For information 
concerning a specific field, click the Help icon next to the field (if 
available). 

Review Summary section

Review Date Review date for the change.

Review Summary Summary of the review for the change.

a. The Impacted Configuration Items section is visible only if the Universal CMDB Impact Analysis 
field group is enabled in the request type. Data is presented for the Impacted Configuration Items 
list in this section only if PPM Center is integrated with Universal CMDB.

b. Fields in the Quality Center Info section remain visible by default but are not used if PPM Center is 
not integrated with HP Quality Center.

c. Fields in the Service Desk System Info section remain visible by default but are not used if PPM 
Center is not integrated with a service desk system. However, when this request type (or any other 
request type) is used for a service desk integration, these fields are required.

Table 3-2. ALM - Request for Change (RFC) request fields (page 6 of 6)

Field Name (*Required) Description

The administrator can remove the Impacted Configuration Items section or the 
Quality Center Info section from the request type by removing the Universal CMDB 
Impact Analysis field group or the Quality Center Info field group, respectively, from 
the ALM - Request for Change (RFC) Header request header type. 
See the HP Demand Management Configuration Guide for details about request 
header types and field groups.
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4. Complete the fields in all sections as appropriate.

The Notes section contains fields where notes and information concerning 
the RFC can be entered and stored. Typically, when you create an RFC, 
you do not need to add a note to it. However, add a note if you want to 
convey additional information to the reviewers and processors of the RFC.

In the References section of the RFC, you can add useful references such 
as a Web-accessible file or a document or file attached from a local 
machine. Additionally, other entities such as packages, releases, or other 
related requests may be automatically referenced based on the workflow 
steps that have been executed. For more information about adding 
references, see the HP Demand Management User’s Guide. 

5. On the Create New Request page, click Submit. 

The RFC is submitted. The Request Creation Confirmed page appears.

After submitting the request, on the Request Creation Confirmed page you 
can click the link for the particular request number in the Request # field to 
view the detail page of the newly generated RFC. 

When the RFC is submitted, it is assigned an initial status, such as New. 
The RFC is then routed along the ALM - Request For Change workflow 
(see ALM - Request For Change Workflow).

ALM - Request For Change Workflow

The ALM - Request For Change workflow is the sequence of approvals, 
decisions, or actions by which the RFC is processed. The RFC starts at the 
beginning of the workflow. When the RFC reaches the end of the workflow, its 
lifecycle is complete. 

Upon creation, an ALM - Request For Change (RFC) request is automatically 
set to use the ALM - Request For Change workflow.

PPM Center can be configured to allow you to save the request before you submit 
it. To have this feature enabled, see your application administrator.
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Figure 3-3 shows the workflow. Table 3-3 lists the important steps in the 
workflow and the user roles associated with those steps.

Figure 3-3. ALM - Request For Change workflow
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Table 3-3. ALM - Request For Change workflow steps (page 1 of 3)

Step User Security Description

1. Filter Request ALM - Change 
Manager

Perform initial review and classification of 
the change request, and determine if this 
RFC is acceptable based on company 
policy.

4. SOX - In 
Scope System?

Fully automated 
step

SOX requires identification of key systems 
related to accurate financial reporting, 
directly or indirectly. This field is 
automatically determined based on the 
system selected.

3. SOX - Impact 
Assessment

ALM - SOX - 
System Owner

SOX requires additional impact assessment 
for any change that could affect financial 
reporting. The impact of not doing the 
change must be considered as well.

6. Allocate 
Priority

ALM - Change 
Manager

Validate RFC priority and determine if this is 
an Urgent Change request.

5. Urgent/
Emergency 
Changes

(None)

Call a subworkflow designed to handle 
urgent or emergency changes, described in 
ALM - RFC - Urgent Change Management 
Sub WF Subworkflow on page 49.

9. Change 
Review and 
Approval Sub WF

ALM - Change 
Manager

Call a subworkflow to manage the review 
and approval process for the RFC, 
described in ALM - Change Review and 
Approval Sub WF Subworkflow on page 50. 
(This subworkflow can, in turn, call the 
ALM - Impact & Resource Assessment 
Sub WF subworkflow.) 

7. Authorize & 
Schedule 
Change

ALM - Change 
Manager

Authorize the change request and schedule 
change for implementation.

11. Application 
Change ?

ALM - Change 
Manager Determine if this is an application change.
Using ALM Entities 45



13. Infrastructure 
Changes Sub WF (None)

Call a subworkflow to handle 
non-application changes, described in 
ALM - Infrastructure Changes Sub WF 
Subworkflow on page 53. 

12. Detailed 
Design

ALM - 
Application 
Developer

Create functional and design specification 
documents.

14. Build 
Application 
Change

ALM - 
Application 
Developer

Build application code for the change.

15. Create 
Package

ALM - 
Application 
Developer

Create a package with the code changes.
This step automatically creates a package 
and adds the package as a reference to the 
RFC request. Figure 3-4 on page 48 
illustrates a typical RFC package.

17. Plan Tests 
Sub WF (None)

Call a subworkflow to manage the test 
planning process for the RFC, described in 
ALM - Plan Tests Sub WF Subworkflow 
on page 54.

20. Build ALM - Change 
Builder

Build the change, in preparation for 
implementation. For an application change, 
add code components to the referenced 
package in the PPM Workbench (see the 
Create Package step).

21. Release 
Decision

ALM- Change 
Builder

Select the option to implement this 
application change as part of a release or 
independently.

22. Deploy and 
Test Changes 
Sub WF

(None)

Call a subworkflow for deploying and testing 
changes, described in ALM - Deploy and 
Test Changes Sub WF Subworkflow 
on page 56.

23. Non Release 
Sub WF (None)

Call a subworkflow for change deployment 
not involving a release, described in 
ALM - Non Release Sub WF Subworkflow 
on page 58.

Table 3-3. ALM - Request For Change workflow steps (page 2 of 3)

Step User Security Description
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24. Release 
Sub WF (None)

Call a subworkflow for change deployment 
involving a release, described in 
ALM - Release Sub WF Subworkflow 
on page 60.

25. Change 
Working?

ALM - Change 
Manager

Review whether the change was 
successfully implemented with no adverse 
impact.

26. Implement 
Backout Plans

ALM - 
Operations 
Manager

If the change is not working, implement 
backout plans to back out the change from 
the LIVE environment.

27. Requestor 
Sign-Off

ALM - Change 
Manager

Get sign-off from the requestor of the 
change to acknowledge that the change 
was implemented.

28. Post 
Implementation 
Review

ALM - Change 
Manager

Review the change after implementation to 
determine whether the change process was 
followed correctly.

29. Close 
(Immediate 
Success) - 100%

(None) Update status to Closed. 

Table 3-3. ALM - Request For Change workflow steps (page 3 of 3)

Step User Security Description
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Step 15 in the ALM - Request for Change workflow creates a package to 
deploy and test changes, and the step adds the package as a reference to the 
RFC request. This package requires specifying a workflow, and the default is 
the ALM - Change Migration workflow, as shown in the example in 
Figure 3-4. Step 22 in the ALM - Request for Change workflow calls the 
ALM - Deploy and Test Changes Sub WF subworkflow to deploy and test the 
package.

Figure 3-4. Package created for ALM - Request For Change workflow
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ALM - RFC - Urgent Change Management Sub WF Subworkflow
ALM provides an “Urgent Change” process. If a change is categorized as 
Urgent, the RFC is routed along the Urgent Change process. The 
ALM - RFC - Urgent Change Management Sub WF subworkflow is designed 
to efficiently handle impact assessment, prioritization, and creation of the 
change. Figure 3-5 shows the subworkflow.

Figure 3-5. ALM - RFC - Urgent Change Management Sub WF subworkflow
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ALM - Change Review and Approval Sub WF Subworkflow

The ALM - Change Review and Approval Sub WF subworkflow provides a 
modular review and approval process for the RFC. Figure 3-6 shows the 
subworkflow. Table 3-4 lists the important steps in the subworkflow and the 
user roles associated with those steps.

Figure 3-6. ALM - Change Review and Approval Sub WF subworkflow
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Table 3-4. ALM - Change Review and Approval Sub WF subworkflow steps

Step User Security Description

1. Categorize 
Change

ALM - Change 
Manager

Categorize the change to determine the next 
step in the workflow.

2. Create 
Project 
Proposal

ALM - CAB group 
(Change 
Advisory Board)

If the change is classified as “Major,” create a 
project proposal that includes impact.

3. IT 
Executive 
Board

ALM - IT 
Executive Board

If the change is classified as “Major,” an IT 
Executive Board is responsible for approving 
the change.

4. Impact & 
Resource 
Assessment 
Sub WF

(None)

If the change is classified as “Significant,” call a 
subworkflow to determine the impact on 
dependent infrastructure components and 
estimate the time and cost of resources, as 
described in ALM - Impact & Resource 
Assessment Sub WF Subworkflow on page 52.

5. CAB 
approval

ALM - CAB group 
(Change 
Advisory Board)

Iterative review by CAB members, resulting in 
an authorization go/no go decision (includes 
change priority, schedule, impact, and cost). 

6. Standard 
Sub WF (None) Call a subworkflow to track standard changes.
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ALM - Impact & Resource Assessment Sub WF Subworkflow

The ALM - Impact & Resource Assessment Sub WF subworkflow provides a 
modular process for assessing change impact and planning resource usage. 
Figure 3-7 shows the ALM - Impact & Resource Assessment Sub WF 
subworkflow. Table 3-5 lists the important steps in the subworkflow and the 
user roles associated with those steps.

Figure 3-7. ALM - Impact & Resource Assessment Sub WF subworkflow
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ALM - Infrastructure Changes Sub WF Subworkflow

If an authorized request for change is not an application change, the 
ALM - Request for Change workflow calls the ALM - Infrastructure Changes 
Sub WF subworkflow to manage the approval and deployment of changes to 
TEST and LIVE environments. Figure 3-8 shows this subworkflow. 

Figure 3-8. ALM - Infrastructure Changes Sub WF subworkflow

Table 3-5. ALM - Impact & Resource Assessment Sub WF subworkflow steps

Step User Security Description

1. Resource 
Assessment

ALM - Change 
Manager User estimates time and cost of resources.

2. Select CIs ALM - Change 
Manager

User manually selects an initial set of 
configuration items (CIs) for the change.

3. Impact 
Assessment

ALM - Change 
Manager

User approves having Universal CMDB 
generate the Impact Analysis report, which 
adds CIs to the CI list based on predefined 
rules in Universal CMDB. 
User then evaluates the Impact Analysis 
report and creates an impact assessment 
report with recommendations.

4. Review 
Impact 
Analysis

ALM - Change 
Manager

User reviews the request, the list of selected 
CIs, and the Impact Analysis and impact 
assessment reports. The user can approve 
the change based on the impact reports, or 
return to the Select CIs step to select a 
different initial set of CIs.
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ALM - Plan Tests Sub WF Subworkflow

The ALM - Plan Tests Sub WF subworkflow provides a modular process for 
planning tests that can communicate automatically with Quality Center. If no 
integration exists, a manual process is also provided. Figure 3-9 shows the 
subworkflow. Table 3-6 lists the important steps in the subworkflow and the 
user roles associated with those steps.

Figure 3-9. ALM - Plan Tests Sub WF subworkflow
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Table 3-6. ALM - Plan Tests Sub WF subworkflow steps

Step Name User Security Description

1. Quality 
Process Mode

ALM - QA 
Manager

Determine the method of test planning, either 
automatic through Quality Center, or manual.

4. Quality 
Process Entry

ALM - QA 
Manager

The quality process entry needs to be 
approved for integration of PPM Center with 
Quality Center.

5. Generate 
Requirement in 
Quality Center

ALM - QA 
Manager

Automated step that generates a requirement 
in Quality Center.

7. Quality Center 
Requirements 
Setup

ALM - QA 
Manager

QA to complete requirement setup in Quality 
Center.

8. Quality Center 
Test Plan Setup

ALM - QA 
Manager

QA to complete test plan setup in Quality 
Center.

9. Quality Center 
Test Lab Setup

ALM - 
Independent 
Tester

QA to complete test lab setup in Quality 
Center.

2. QC 
Requirements

ALM - QA 
Manager Create test requirements in Quality Center.

3. Create Tests ALM - QA 
Manager Create test plans in Quality Center.
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ALM - Deploy and Test Changes Sub WF Subworkflow

The ALM - Deploy and Test Changes Sub WF subworkflow provides a 
modular process for deploying and testing changes. The process can 
communicate automatically with Quality Center. If no integration exists, a 
manual process is also provided. Figure 3-10 shows the subworkflow. 
Table 3-7 lists the important steps in the subworkflow and the user roles 
associated with those steps.

Figure 3-10. ALM - Deploy and Test Changes Sub WF subworkflow
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Table 3-7. ALM - Deploy and Test Changes Sub WF subworkflow steps

Step Name User Security Description

1. Approve 
changes to TEST

ALM - 
Change 
Manager

Approve deployment of changes to the TEST 
environment.

2. Deploy 
Changes to TEST

ALM - 
Change 
Manager

Deploy changes to the TEST environment.

3. Quality 
Process Mode

ALM - QA 
Manager

Determine the method of testing, either 
automatic through Quality Center or manual.

5. Quality Center 
Test Execution

ALM - 
Independent 
Tester

Quality Center tests the changes in a TEST 
environment.

7. Evaluate 
Quality

ALM - QA 
Manager

After test execution (manual or using Quality 
Center), evaluate quality.

8. Impact & 
Resource 
Assessment 
Sub WF

(None)

Call a subworkflow to determine the impact of 
the changes that will be deployed, as 
described in ALM - Impact & Resource 
Assessment Sub WF Subworkflow 
on page 52.

9. Approve 
changes to LIVE

ALM - 
Change 
Manager

Approve deployment of changes to the LIVE 
environment.

10. Deploy 
Changes to LIVE

ALM - 
Change 
Manager

Deploy changes to the LIVE environment.

11. Quality 
Process Mode

ALM - QA 
Manager Initiate sanity tests in Quality Center.

12. Running 
Sanity Tests in 
Quality Center

ALM - QA 
Manager Run sanity tests in Quality Center.
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ALM - Non Release Sub WF Subworkflow

The ALM - Non Release Sub WF subworkflow provides a modular process for 
change deployment that can communicate automatically with Quality Center. 
If no integration exists, a manual process is also provided. Figure 3-11 shows 
the subworkflow. Table 3-8 lists the important steps in the subworkflow and 
the user roles associated with those steps.

Figure 3-11. ALM - Non Release Sub WF subworkflow
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Table 3-8. ALM - Non Release Sub WF subworkflow steps

Step Name User Security Description

1. Approve 
Deployment to 
TEST

ALM - 
Change 
Manager

Coordinate the change implementation to the 
test environment.

4. Quality 
Process Mode

ALM - QA 
Manager

Determine the quality process mode, either 
automatic through Quality Center or manual.

5. Run Tests
ALM - 
Independent 
Tester

If manual mode is chosen in the Quality 
Process Mode step, the changes need to be 
manually tested based on test plans.

6. Quality Center 
Test Execution

ALM - 
Independent 
Tester

If Quality Center mode is chosen in the Quality 
Process Mode step, once QA signals through 
Quality Center that Test execution is complete, 
this step moves the workflow ahead.

8. Evaluate 
Quality

ALM - QA 
Manager

Approve/reject the quality of the change 
deployed to the test environment.

9. Impact & 
Resource 
Assessment 
Sub WF

(None)

Call a subworkflow to determine the impact on 
dependent infrastructure components and 
estimate the time and cost of resources, as 
described in ALM - Impact & Resource 
Assessment Sub WF Subworkflow 
on page 52.

15. Rework 
Change

ALM - 
Applications 
Development 
Manager

If the quality of the change deployed to the test 
environment is rejected, the change must be 
fixed.

10. Approve 
Deployment to 
LIVE

ALM - 
Change 
Manager

Coordinate the change implementation to the 
production environment. 

14. Running 
Sanity Tests in 
Quality Center

ALM - 
Independent 
Tester

Run sanity tests in Quality Center.
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ALM - Release Sub WF Subworkflow

The ALM - Release Sub WF subworkflow is called in order to add a change 
into an existing release. The subworkflow can be called multiple times, once 
for each change to be added to the release. Once a release is specified as 
Completed, no new changes can be added to that release. Figure 3-12 shows 
the subworkflow. (For information about creating a new release, see 
ALM - Release Management Request Type on page 70.)

Figure 3-12. ALM - Release Sub WF subworkflow

ALM - Defect Template with Quality Center Integration Request 
Type and Workflow

The ALM - Defect Template with Quality Center Integration request type and 
the associated ALM - Defect Template with Quality Center Integration 
workflow are the only ALM entities that can be used only when a particular 
integration (with Quality Center, in this case) is established. These ALM 
entities are described in Chapter 6, Integration of PPM Center with Quality 
Center, on page 167.
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ALM - Change Migration Workflow

The ALM - Change Migration workflow is used to migrate changes from the 
DEV environment to the TEST environment and from the TEST environment 
to the LIVE environment. Figure 3-13 shows the workflow. The 
ALM - Change Migration workflow is the default workflow used in step 15 
of the ALM - Request For Change workflow to create a package. See 
ALM - Request For Change Workflow on page 43.

Figure 3-13. ALM - Change Migration workflow
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Change Management Portlets to Display KPIs

ALM provides several portlets that can be added to your PPM Dashboard to 
provide real-time views into several key performance indicators (KPIs). 

For information about adding portlets to your PPM Dashboard, see the Getting 
Started guide.

ALM - My RFCs Portlet

The ALM - My RFCs portlet is provided to users with the role of Change 
Manager. The portlet lists RFCs that have been created by or assigned to the 
logged-on user. 

Table 3-9 describes the filter fields for the portlet.

Figure 3-14 shows an example ALM - My RFCs portlet. 

Figure 3-14. ALM - My RFCs portlet

Table 3-9. ALM - My RFCs portlet filter fields

Field Name Description

Request Type (Read-only) Preset to ALM - Request for Change (RFC) 

Category Category of the RFC
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ALM - Open RFCs Portlet

The ALM - Open RFCs portlet is provided to users with the role of Change 
Manager. The portlet lists RFCs that are currently being worked on. 

Table 3-10 describes the filter fields for the portlet.

Figure 3-15 shows an example ALM - Open RFCs portlet. 

Figure 3-15. ALM - Open RFCs portlet

Table 3-10. ALM - Open RFCs portlet filter fields

Field Name Description

Request Type (Read-only) Preset to ALM - Request for Change (RFC) 

Assigned To User to whom the RFC is assigned

Category Category of the RFC
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ALM - RFCs By Category Portlet

The ALM - RFCs By Category portlet is provided to users with the role of 
Change Manager. The portlet displays a pie chart showing the percentage of 
RFCs in each category. 

The only filter field for the portlet, Request Type, is read-only and is preset to 
ALM - Request for Change (RFC). 

Figure 3-16 shows the ALM - RFCs By Category portlet.

Clicking the pie chart drills down to a list portlet.

Figure 3-16. ALM - RFCs By Category portlet
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ALM - RFCs By Reason for Change Portlet

The ALM - RFCs By Reason for Change portlet is provided to users with the 
role of Change Manager. This portlet displays a pie chart showing the 
percentage of RFCs by each type of change being considered (for example, 
new feature, enhancement, or defect fix). 

Table 3-11 describes the filter fields for the portlet.

Figure 3-17 shows an example ALM - RFCs By Reason for Change portlet. 

Clicking the pie chart drills down to a list portlet.

Figure 3-17. ALM - RFCs By Reason for Change portlet

Table 3-11. ALM - RFCs By Reason for Change portlet filter fields

Field Name Description

Request Type (Read-only) Preset to ALM - Request for Change (RFC) 

Status Status of the RFC
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ALM - RFCs By Status Portlet

The ALM - RFCs By Status portlet displays a pie chart showing the percentage 
of RFCs of each status. 

The only filter field for the portlet, Request Type, is read-only and is preset to 
ALM - Request for Change (RFC). 

Figure 3-18 shows an example ALM - RFCs By Status portlet.

Clicking the pie chart drills down to the ALM - RFCs By Status - List portlet.

Figure 3-18. ALM - RFCs By Status portlet
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Change Management Reports

ALM provides several reports that can be run to provide summary data and 
scheduling information about RFCs in the system, as well as to process 
participant data for SOX auditing. To run an ALM report:

1. Log on to PPM Center.

2. From the menu bar, select Open > Reports > Create Report. 

3. On the Submit New Report page, in the Report Category field, select 
Demand Management. 

4. Click the link for the desired report, and complete all required and any 
optional filter fields. 

5. Click Submit. 

For more information about reports, see the Reports Guide and Reference. 

ALM - Change Summary Report

The ALM - Change Summary Report provides a list of RFCs that have been 
implemented, grouped by change category. 

Table 3-12 describes the filter fields for the report. 

Table 3-12. ALM - Change Summary Report filter fields

Field Name Description

Request Type (Read-only) Preset to ALM - Request for Change (RFC) 

Change Status Status of the change request

Change Priority Priority of the change request

Time Period From Earliest date the RFCs were created

Time Period To Latest date the RFCs were created
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Figure 3-19 shows sample output for the ALM - Change Summary Report.

Figure 3-19. ALM - Change Summary Report output

ALM - Forward Schedule of Changes for RFC Report

The ALM - Forward Schedule of Changes for RFC report is a key report used 
in the change management process. The output of this report is a list of all the 
RFCs that are scheduled to be implemented. 

Table 3-13 describes the filter fields for the report.
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Figure 3-20 shows sample output for the ALM - Forward Schedule of Changes 
for RFC report. 

Figure 3-20. ALM - Forward Schedule of Changes for RFC report output

Table 3-13. ALM - Forward Schedule of Changes for RFC report filter fields

Field Name Description

Report Title Title of the report

Start FSC Period Earliest start date of the scheduled RFCs

End FSC Period Latest start date of the scheduled RFCs

Request Type (Read-only) Preset to ALM - Request for Change (RFC) 
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ALM - Release Management Request Type

The ITIL Release Management process as modeled by ALM sends a release 
request of the ALM - Release Management request type along the 
ALM - Release Request workflow (see ALM - Release Request Workflow 
on page 76) to be examined and resolved. 

Figure 3-21 shows the Create New ALM - Release Management page that 
appears when you create a request and select the ALM - Release Management 
request type. Table 3-14 describes the fields in the ALM - Release 
Management request, including some fields that do not appear until the request 
is created or until other conditions are met.
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Figure 3-21. ALM - Release Management request
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Table 3-14. ALM - Release Management request fields (page 1 of 4)

Field Name (*Required) Description

Summary section

Request Status (Read-only) Status of the release request. Preset to 
Logged before the request is created

Request No. (Read-only. Added after the request is created.) 
Number of the request

*Release Category Release category, based on the scope of the 
release (number of changes in a release)

*Release Type Type of release

*Release Summary Summary description of the release

*Release ID
(Required only after the 
request is created) 

ID for the release

Work Item Fields section a

Release Planning section

*Release Definition Summary Summary of the definition of this release

Release Definition Allows you to add and view the release definition 
document directly on the release request

*Release Policy Summary
(Required only after the 
request is created)

Summary of the policy that governs this release

Release Policy Allows you to add and view the release policy 
document directly on the release request

Release Plans Summary Summary of rollout plans for this release

Release Plans

Allows you to add and view the rollout plans for this 
release (for example: a timetable of events, a 
resource plan, and who will do what and when) 
directly on the release request
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QA Information section

Release Test Plan Summary Summary of the test plan for this release

Release Test Plan

Allows you to add and view the release test plan 
(the plan that describes tests to be performed on 
this release in the TEST environment) directly on 
the release request

Release Acceptance Criteria 
Summary

Summary of the release acceptance criteria for this 
release

Release Acceptance Criteria

Allows you to add and view the release acceptance 
criteria document (which details criteria that qualify 
the acceptance of this release before deployment 
to the LIVE environment) directly on the release 
request

Test Results Allows you to add and view the test results directly 
on the release request

Known Defects Summary Summary of known defects that will be carried 
forward into the LIVE environment

Known Defects
Used to specify RFCs relating to known defects 
that will be carried forward into the LIVE 
environment

Quality Center Info section b

Quality Center Instance Quality Center instance that will receive the new 
PPM Center request

Quality Center Domain Quality Center domain of the working project

Quality Center Project Quality Center project that is linked with this 
request

Quality Center Assigned To 
User User assigned to the Quality Center requirement

Quality Center Requirement 
No. (Read-only) Quality Center requirement number

Quality Center Status (Read-only) Quality Center requirement status

Table 3-14. ALM - Release Management request fields (page 2 of 4)

Field Name (*Required) Description
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Quality Center Message
(Read-only) Message indicating whether the last 
update to the request was successful in Quality 
Center

Quality Center Attachments URL of the attached requirement document

Release Preparation section

Communication Plan 
Summary

Summary of the communication plan for this 
release

Communication Plan

Allows you to add and view the communication plan 
(the plan that describes the various notifications 
that need to be sent out prior to release deployment 
into the LIVE environment) directly on the release 
request

Training Plan Summary Summary of the training plan for this release

Training Plan

Allows you to add and view the training plan (the 
plan that describes the training that needs to be 
provided prior to release deployment into the LIVE 
environment) directly on the release request

Release Backout Plans 
Summary Summary of the backout plans for this release

Release Backout Plans

Allows you to add and view the backout plan (the 
release plan that describes procedures to back out 
the release to its original state) directly on the 
release request

License Agreements
Allows you to add and view any license agreement 
documents for software licensed in this release 
directly on the release request

Support Agreements
Allows you to add and view any support agreement 
documents for support policies of software licensed 
in this release directly on the release request

Table 3-14. ALM - Release Management request fields (page 3 of 4)

Field Name (*Required) Description
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To submit an ALM - Release Management request:

1. Log on to PPM Center.

2. From the menu bar, select Create > Request. 

The Create New Request page appears.

3. On the Create New Request page, in the Request Type field, select 
ALM - Release Management and click Create. 

The Create New ALM - Release Management page appears, displaying the 
appropriate release request fields.

Required fields have a red asterisk. All other fields are optional, but are 
often helpful when others are reviewing an open request. For information 
concerning a specific field, click the Help icon next to the field (if 
available). 

Service Level Agreements
Allows you to add and view any SLAs for ordering 
new equipment or software directly on the release 
request

Leasing Agreements
Allows you to add and view any leasing agreement 
documents for software leased in this release 
directly on the release request

a. Fields in the Work Item Fields section are useful if you want to include Release Management 
requests as work items to be tracked using HP Resource Management. For more information, see 
the HP Resource Management User’s Guide. 

b. Fields in the Quality Center Info section remain visible by default but are not used if PPM Center is 
not integrated with HP Quality Center.

Table 3-14. ALM - Release Management request fields (page 4 of 4)

Field Name (*Required) Description

The administrator can remove the Quality Center Info section from the request type 
by removing the Quality Center Info field group from the ALM - Release Request 
Header request header type. See the HP Demand Management Configuration Guide 
for details about request header types and field groups.
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4. Complete the fields in all sections as appropriate.

The Notes section contains fields where notes and information concerning 
the release can be entered and stored. Typically, when you create a release 
request, you do not need to add a note to it. However, add a note if you 
want to convey additional information to the reviewers and processors of 
the release request.

In the References section, you can add useful references such as a 
Web-accessible file or a document or file attached from a local machine. 
For more information about adding references, see the HP Demand 
Management User’s Guide. 

5. On the Create New Request page, click Submit. 

The release request is submitted. The Request Creation Confirmed page 
appears.

After submitting the request, on the Request Creation Confirmed page you 
can click the link for the particular request number in the Request # field to 
view the detail page of the newly generated release request. 

When the release request is submitted, it is assigned an initial status, such 
as New. The request is then routed along the ALM - Release Request 
workflow (see ALM - Release Request Workflow).

ALM - Release Request Workflow

The ALM - Release Request workflow is the sequence of approvals, decisions, 
or actions that the release request follows. The release request starts at the 
beginning of the ALM - Release Request workflow. When the release request 
reaches the end of the workflow, its lifecycle is complete. After the release 
request has been through initial planning, the release is created, and the 
packages for the RFCs can be aggregated into the release. The deployment 
steps in the release request workflow coordinate with the actual release to 
automate the deployment of all packages in the release into the TEST and 
LIVE environments.

PPM Center can be configured to allow you to save the request before you submit 
it. To have this feature enabled, see your application administrator.
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Upon creation, an ALM - Release Management request is automatically set to 
use the ALM - Release Request workflow.

Figure 3-22 shows the ALM - Release Request workflow. Table 3-15 lists the 
important steps in the workflow and the user roles associated with those steps.

Figure 3-22. ALM - Release Request workflow
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Table 3-15. ALM - Release Request workflow steps (page 1 of 2)

Step Name User Security Description

1. Release Policy ALM - Release 
Manager

Define the release policy for this 
release (including release number and 
rules for accepting changes into the 
release).

2. Release 
Planning

ALM - Release 
Manager

Review and approval of the release 
policy and other planning documents 
(such as release acceptance criteria).

3. Integrate with 
Quality Center? ALM - QA Manager

Determine whether the user wants to 
use Quality Center integration, if 
enabled. See Integration of PPM 
Center with HP Quality Center 
on page 20.

4. Quality Process 
Entry ALM - QA Manager Secure approval for release entry into 

Quality Center-integrated process.

5. Create Release 
Requirement in 
Quality Center

ALM - QA Manager
Create a test requirement in Quality 
Center for the release if integration has 
been enabled.

7. Accept Changes 
into Release

ALM - Release 
Manager

Add RFC-related changes to the 
release. This can be done from the 
RFC workflow directly (for changes that 
qualify for this release).

8. Build and Deploy 
Release to TEST

ALM - Release 
Manager

Deploy the entire release into QA or 
staging environment and prepare for 
integration testing.
This step automatically migrates the 
release and related packages to the 
TEST environment.

10. Fit-for-Purpose 
Testing

ALM - Release 
Manager Fit-for-purpose testing of this release.

11. Evaluate 
Quality

ALM - Release 
Manager

Testing of this release, including testing 
of backout plan.
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12. Release 
Acceptance

ALM - Release 
Manager

Based on test results and known 
defects, determine if this release is 
acceptable for LIVE deployment.

13. Rollout 
Planning

ALM - Release 
Manager

Plan the rollout into LIVE environment. 
The key document is the release plan 
(who does what and when).

14. Communication 
Preparation and 
Training

ALM - Release 
Manager

Prepare for LIVE rollout, and determine 
logistics, training, and communication.

15. Deploy 
Release to LIVE

ALM - Release 
Manager

Distribute and install this release to the 
LIVE environment.
This step automatically migrates the 
release and related packages to the 
LIVE environment.
SOX Segregation of Duties prohibits 
developers and testers from being 
involved in deployment of code into 
production. It is important that users 
with either of these roles not be 
involved in this step.

16. Working? ALM - Release 
Manager

Determine if the release is working 
based on sanity check and testing.

17. Update All 
RFCs Status

ALM - Release 
Manager

Update the status of RFCs related to 
this release.

18. Close 
(Immediate 
success) - 100%

(None) Update status to Closed.

19. Implement 
Backout Plans

ALM - Release 
Manager

If the release is not working, implement 
the backout plan.

20. Update All 
RFCs Status

ALM - Release 
Manager

Update the status of RFCs related to 
this release.

Table 3-15. ALM - Release Request workflow steps (page 2 of 2)

Step Name User Security Description
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ALM - Release Distribution Workflow and Subworkflow

The ALM - Release Distribution workflow, along with the ALM - Release 
Distribution Sub WF subworkflow that it calls to migrate the release to TEST 
and then to LIVE environments, are used to control distribution among 
environments of a release that consolidates multiple changes.

Figure 3-23 shows the ALM - Release Distribution workflow.

Figure 3-23. ALM - Release Distribution workflow

Release Management Portlets to Display KPIs

ALM provides several portlets that can be added to your PPM Dashboard to 
provide real-time views into several key performance indicators (KPIs).

For information about adding portlets to your PPM Dashboard, see the Getting 
Started guide.
80 Chapter 3



ALM - Deployed Releases Portlet

The ALM - Deployed Releases portlet is provided to users with the role of 
Release Manager. The portlet displays a list of recently deployed releases. 

Table 3-16 describes the filter fields for the portlet.

Figure 3-24 shows an example ALM - Deployed Releases portlet.

Figure 3-24. ALM - Deployed Releases portlet

Table 3-16. ALM - Deployed Releases portlet filter fields

Field Name Description

Child RFC 
Request Type

Request types, at least one of which must be in the releases 
that are to be listed

Status Status of the release

Category Category of the release (Emergency, Major, or Minor)

Type Type of release (Full, Delta, or Package Release)

Request Type (Read-only) Preset to ALM - Release Management 

In order for the portlet to display data, RFCs need to be added as child or related 
references to the release request.
Using ALM Entities 81



ALM - My Releases Portlet

The ALM - My Releases portlet is provided to users with the role of Release 
Manager and other roles involved in the release management process. The 
portlet lists release requests that have been created by or assigned to the 
logged-on user. 

Table 3-17 describes the filter fields for the portlet.

Figure 3-25 shows an example ALM - My Releases portlet. 

Figure 3-25. ALM - My Releases portlet

Table 3-17. ALM - My Releases portlet filter fields

Field Name Description

Request Type (Read-only) Preset to ALM - Release Management 

Category Category of the release (Emergency, Major, or Minor)
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ALM - Open Releases Portlet

The ALM - Open Releases portlet is provided to users with the role of Release 
Manager. The portlet lists releases that do not have the status of Closed. 

Table 3-18 describes the filter fields for the portlet.

Figure 3-26 shows an example ALM - Open Releases portlet. 

Figure 3-26. ALM - Open Releases portlet

Table 3-18. ALM - Open Releases portlet filter fields

Field Name Description

Request Type (Read-only) Preset to ALM - Release Management 

Assigned to User assigned to the release

Category Category of the release (Emergency, Major, or Minor)
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ALM - Releases Portlet

The ALM - Releases portlet displays a list of release requests. If PPM Center is 
integrated with HP Release Control or HP Change Control Management, the 
portlet provides a Click to View link in the View Impact column for each 
request to log in to HP Release Control, where various tabs provide 
information about the request. 

Figure 3-27 shows an example ALM - Releases portlet.

Figure 3-27. ALM - Releases portlet

For more information about tabs in HP Release Control or HP Change Control 
Management, see Using the Integration of PPM Center with Release Control 
on page 246.
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ALM - Releases By Category Portlet

The ALM - Releases By Category portlet is provided to users with the role of 
Release Manager. The portlet displays a pie chart showing the percentage of 
releases in each category. 

The only filter field for the portlet, Request Type, is read-only and is preset to 
ALM - Release Management. 

Figure 3-28 shows an example ALM - Releases By Category portlet.

Figure 3-28. ALM - Releases By Category portlet

Clicking the pie chart drills down to the ALM - Releases By List portlet.
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ALM - Releases By Type Portlet

The ALM - Releases By Type portlet is provided to users with the role of 
Release Manager. The portlet displays a pie chart showing the percentage of 
releases of each type. 

The only filter field for the portlet, Request Type, is read-only and is preset to 
ALM - Release Management. 

Figure 3-29 shows an example ALM - Releases By Type portlet.

Figure 3-29. ALM - Releases By Type portlet

Clicking the pie chart drills down to the ALM - Releases By List portlet.
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ALM - RFCs per Release Portlet

The ALM - RFCs per Release portlet is provided to users with the role of 
Release Manager. The portlet displays a list of RFCs that constitute a release. 

Table 3-19 describes the filter fields for the portlet.

Figure 3-30 shows an example ALM - RFCs per Release portlet.

Figure 3-30. ALM - RFCs per Release portlet

Table 3-19. ALM - RFCs per Release portlet filter fields

Field Name Description

Release Request Number of the release request

Request Type Request types of the RFCs. Preset to ALM - Release For 
Change (RFC) by default

Status Status of the release

Priority Priority of the release
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Release Management Reports

ALM provides several reports that can be run to provide summary data and 
scheduling information about releases in the system.

To generate a report, from the PPM Center menu bar:

1. Select Open > Reports > Create Report. 

2. On the Submit New Report page, in the Report Category field, select 
Demand Management. 

3. Click the link for the desired report, and complete all required and any 
optional filter fields, 

4. Click Submit. 

For more information about reports, see the Reports Guide and Reference. 
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ALM - Forward Schedule of Releases Report

The ALM - Forward Schedule of Releases report is a key report used in the 
release management process. The output of this report is a list of all releases 
that are scheduled to be implemented into the LIVE environment. 

Table 3-20 describes the filter fields for the report.

Figure 3-31 shows sample output for the ALM - Forward Schedule of Releases 
report. 

Figure 3-31. ALM - Forward Schedule of Releases report output

Table 3-20. ALM - Forward Schedule of Releases report filter fields

Field Name Description

Report Title Title of the report

Start FSC Period Searches for releases created after the specified FSC date

End FSC Period Searches for releases created before the specified FSC date

Request Type (Read-only) Preset to ALM - Release Management 
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ALM - Release Content Report

The ALM - Release Content Report provides a list of RFCs that have been 
incorporated into a release. 

Table 3-21 describes the filter fields for the report.

Figure 3-32 shows sample output for the ALM - Release Content Report. 

Figure 3-32. ALM - Release Content Report output

Table 3-21. ALM - Release Content Report filter fields

Field Name (*Required) Description

Report Title Title of the report

Request Type (Read-only) Preset to ALM - Release Management 

*Release ID Specify the release whose contents you want to list
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ALM - Release Summary Report

The ALM - Release Summary Report provides a list of releases that have been 
implemented. 

Table 3-22 describes the filter fields for the report.

Figure 3-33 shows sample output for the ALM - Release Summary Report 
report. 

Figure 3-33. ALM - Release Summary Report output

Table 3-22. ALM - Release Summary Report filter fields

Field Name Description

Request Type (Read-only) Preset to ALM - Release Management 

Release Status Searches for releases with the specified statuses

Release Type Searches for releases of a specific type

Time Period From Searches for releases created after the specified date

Time Period To Searches for releases created before the specified date
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Special Commands

Table 3-23 describes the special commands provided by ALM to support 
integration of PPM Center with Quality Center.

Table 3-23. Special commands for integration of PPM Center with Quality 
Center

Special Command Description

ksc_create_defect_in_QC Creates an execution step that will create a 
defect in Quality Center

ksc_create_requirement_in_QC Creates an execution step that will create a 
requirement in Quality Center
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4 Integration of PPM Center with HP Service 
Manager
Introduction to Integration of PPM Center with HP Service 
Manager 

For an overview of the integration of PPM Center with HP Service Manager, 
see Integration of PPM Center with Service Desk Applications on page 17. 

The integration is enabled by a configurable HP Service Manager adapter file 
in PPM Center along with the request types and workflows provided by ALM, 
so that PPM Center acts as a single repository for application-related requests 
for change (RFCs). The adapter converts changes (tickets) in HP Service 
Manager to requests for change (RFCs), and then imports those RFCs into 
PPM Center for processing. 

Conversely, using a configurable PPM Center adapter file that also resides in 
PPM Center, the integration can optionally update HP Service Manager 
changes based on subsequent changes made in PPM Center to the RFCs. 

If the HP Service Manager adapter file and the associated PPM Center adapter 
file are both configured, such that data can be sent in both directions between 
HP Service Manager and PPM Center, the integration is said to be 
“bidirectional.” 

A separate adapter file is required for each mapping between a HP Service 
Manager change and a PPM Center request type.

ALM provides two default adapter files—a HP Service Manager adapter file 
and an associated default PPM Center adapter file.
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The integration runs as a service in the PPM Server. As described later, the 
configuration of an adapter file controls various aspects of its import process. 

This chapter describes how to configure the adapters in PPM Center and the 
HP Service Manager application for integration. This chapter is intended for 
HP Service Manager administrators or for PPM Center system administrators 
who are also familiar with HP Service Manager. 

For information about the supported versions of HP Service Manager, see the 
System Requirements and Compatibility Matrix. 

For information about the ALM - Request for Change (RFC) request type in 
PPM Center that is used to establish integration of PPM Center with  
HP Service Manager, see ALM - Request for Change (RFC) Request Type 
on page 34.

For references to more information about HP Service Manager, see HP Service 
Manager Documentation on page 22.

No software needs to be installed on the HP Service Manager server for integration 
with PPM Center. However, see the System Requirements and Compatibility Matrix. 
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Conversion of HP Service Manager Changes to PPM Center RFCs

Figure 4-1 depicts the flow for converting a change in HP Service Manager to 
an ALM request for change (RFC), and importing the RFC into PPM Center.

Figure 4-1. Using the HP Service Manager adapter to import changes from  
HP Service Manager into PPM Center

The HP Service Manager adapter consists of the following three components:

Connector. Collects changes from the HP Service Manager system.

Converter. Uses field mapping to convert the changes from the  
HP Service Manager data model in which the changes were created to 
RFCs for the PPM Center data model.

The converter also contains two optional filters to control which changes 
are imported into PPM Center. The preFilter filters out categories of 
changes you specify in the HP Service Manager data model before those 
changes are converted. After the HP Service Manager changes are 
converted to RFCs, the postFilter filters out categories of requests you 
specify before those requests are presented to the sender.

Sender. Using the RFC data from the converter, creates the RFCs in PPM 
Center.
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Conversion of PPM Center RFCs to HP Service Manager Change Updates

Similar to the HP Service Manager adapter, the PPM Center adapter consists of 
connector, converter, and sender components. In this case, these components 
allow HP Service Manager to import updates from PPM Center. 

Figure 4-2 depicts the flow for converting an ALM RFC (request for change) 
in PPM Center to an update to a change in HP Service Manager, and importing 
the update into HP Service Manager. 

Figure 4-2. Using the PPM Center adapter to import change updates  
from PPM Center into HP Service Manager
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Overview of Configuring the HP Service Manager Integration

Before configuring the integration, you must identify the HP Service Manager 
data attributes that will be integrated with PPM Center, including which of the 
attributes of HP Service Manager changes to send to PPM Center, and, for 
bidirectional integration, which of the attributes to receive back from PPM 
Center.

Before you can begin importing changes from HP Service Manager into PPM 
Center, you must configure HP Service Manager and configure the HP Service 
Manager adapter in PPM Center to enable integration. The procedures are 
summarized as follows:

Configure HP Service Manager in the particular ways required for 
integration of PPM Center with HP Service Manager.

Generate HP Service Manager Web service stubs for HP Service Manager. 
PPM Center needs the HP Service Manager Web service stubs to connect 
to HP Service Manager. 

Configure the HP Service Manager adapter configuration file on the PPM 
Server, to support converting a change in HP Service Manager to an ALM 
request for change (RFC) and then importing the RFC into PPM Center. 
ALM provides an HP Service Manager default adapter configuration file.

If you want the integration to be bidirectional, that is, to also send updates 
that are made in PPM Center RFCs back to HP Service Manager as change 
updates, configure the PPM Center adapter configuration file on the PPM 
Server. ALM provides a default PPM Center adapter configuration file 
associated with HP Service Manager.

Configure the required server.conf parameter in PPM Center.

Restart the PPM Server in normal mode and verify that the ALM Startup 
service has started.

Configure logging of errors and events.
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Configuring HP Service Manager for Integration with PPM 
Center

Before starting these configuration procedures, make sure that the HP Service 
Manager server, HP Service Manager client, and HP Service Manager Webtier 
are installed and running.

Integration of HP Service Manager with PPM Center requires specific 
configuration of HP Service Manager, as described in the following sections.

Configuring the Change Management Module

To configure the Change Management module in HP Service Manager:

1. To enable HP Service Manager to provide PPM Center with the changes 
sorted by their last update times, as required by this integration:

a. Navigate to System Definition > Tables > cm3r > Keys and on that 
screen, click New. 

b. Add a new key constraint to the database table. The constraint should 
be of the type “Not Null” and should contain the sysmodtime field. If 
the HP Service Manager system uses another field to contain the last 
modified date/time of the record, use that field instead.

c. Add a new key constraint to the database table. The constraint should 
be of the type “Not Null” and should contain the orig.date.entered field, 

PPM Center can be integrated with multiple instances of HP Service Manager, if those 
instances are at the same version. (See the System Requirements and Compatibility 
Matrix.) However, the procedures in the following sections must be performed 
identically on the multiple HP Service Manager instances.

If you already integrated HP Service Manager with PPM Center and you upgrade the 
integration solution to PPM Center 8.03 (or later), copy and rename two web service 
objects in HP Service Manager as follows to make sure that the integration will 
continue to work:

Change -> ChangePPMIntALM

ChangeTask -> ChangeTaskPPMIntALM
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for use in the initial load mode (for more information, see the 
initial-load-state adapter attribute in Table 4-1 on page 111).

d. (For integration with PPM Center version 8.03 or later, skip this step) 
To make sure that the sysmodtime and orig.date.entered fields are 
exposed through the Change Management Web Services:

i. For version 7.01, select 
Menu Navigation > Tailoring > WSDL Configuration.

For version 7.10, select 
Menu Navigation > Tailoring > Web Services > WSDL Configuration.

ii. Type cm3r in the Name field and click Search.

For version 7.01, the search finds only the Change entity and opens 
it immediately. Perform step iii.

For version 7.10, the search finds the Change and ChangeIIA 
entities. You must open each entity and perform step iii for each 
object.

iii. Click the Fields tab to add fields with captions and types to the table 
as follows:

2. Import the unload file provided with PPM Center to set up Change 
Management Web service for the integration with PPM Center. 

For integration with PPM Center version 8.00, 8.00.01, or 8.02, the 
unload file is located at:

<PPM_Home>\conf\sdi\serviceManagerFiles\sm_operations

where <PPM_Home> represents the path where the PPM Center instance 
is installed. For example: xyzserver/E/PPMServer. 

New Field New Caption Type

sysmodtime sysmodtime DateTimeType

orig.date.entered orig.date.entered DateTimeType
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For integration with PPM Center version 8.03 (or later), the unload file 
is located at:

<PPM_Home>\conf\sdi\serviceManagerFiles\
PPMIntALMWebService.unl

where <PPM_Home> represents the path where the PPM Center instance 
is installed. For example: xyzserver/E/PPMServer.

Configuring the Change Management HP Service Manager Web Service

To configure the Change Management HP Service Manager Web service:

1. Associate a display action to the new processes:

a. To navigate to the Objects menu, select 
Menu Navigation > Tailoring > Document Engine > Objects. 

b. Type cm3r in the File name field and click Enter. 

c. Specify the default state. 

d. Add a new Display action associated with the process—associate the 
checkretract action with ccm.check.retract. 

e. Add a new Display action associated with the process—associate the 
checkapproval action with ccm.check.approval. 

f. Close the cm3r object.

g. Repeat step a through step f for the cm3t object.

2. (For integration with PPM Center version 8.03 or later, skip this step) To 
configure ChangeManagement WSDL:

a. For version 7.01, select 
Menu Navigation > Tailoring > WSDL Configuration;
For version 7.10, select 
Menu Navigation > Tailoring > Web Services > WSDL Configuration.

b. In the Service Name field, type ChangeManagement and click Search.
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c. Add the following actions for table cm3r:

d. Repeat step c for table cm3t.

Configuring Browsing of HP Service Manager Changes from a URL

This optional procedure enables RFCs in PPM Center to be updated with URL 
links to the corresponding changes in HP Service Manager, so that PPM Center 
users can easily jump directly to those changes. To enable this capability, 
configure HP Service Manager as follows (otherwise go to Configuring for 
Bidirectional Integration on page 105):

1. To configure the Web server URL in the HP Service Manager server:

a. To open the System Information Definition, select 
Menu Navigation > System Administration > Base System  
Configuration > Miscellaneous > System Information Record. 

b. In the form, select the Active Integrations tab.

c. In the WebServer URL field in the WebServer Information pane, type 
the URL of the HP Service Manager Web server configured for Web 
access. For example:

http://<Host>:<Port>/sm/index.do

d. Click OK to save the System Information Definition and exit.

2. To create and configure the record.url field in the cm3r table:

a. Create the record.url field in the cm3r table, using the following  
HP Service Manager Help topic:

“How do I add a field to a table?”

Allowed Action Action Name

checkapproval CanApprove

checkretract CanRetract
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b. Configure the record.url field as follows:

c. In the SQL mapping section, do the following:

i. Type RECORD_URL in the SQL field name field. 

ii. Type VARCHAR in the SQL data type field. 

iii. Type 400 in the SQL data length field. 

d. (For integration with PPM Center version 8.03 or later, skip this step.) 
To add record.url to the Change Management Web service:

i. For version 7.01, select 
Menu Navigation > Tailoring > WSDL Configuration.

For version 7.10, select 
Menu Navigation > Tailoring > Web Services > WSDL Configuration.

ii. Type cm3r in the Name field and click Search.

For version 7.01, the search finds only the Change entity and opens 
it immediately. Perform step iii.

For version 7.10, the search finds the Change and ChangeIIA 
entities. You must open each entity and perform step iii for each 
object.

iii. Click the Fields tab to add a field with caption and type to the table 
as follows:

Section Name Field Name Value

General Properties Type Character

General Properties Caption Change URL

New Field New Caption Type

record.url record.url StringType
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e. The record.url field is populated in the cm3r.pre.add trigger. To 
configure this trigger:

i. Navigate to System Definition > Tables > cm3r. 

ii. Open the list of triggers.

iii. Open the cm3r.pre.add trigger.

iv. Copy the following JavaScript into the trigger:

_rec_number = record.number;
var _filename = "cm3r";
var _query = "number=\"" + _rec_number+ "\"";
var _title = "Change number " + _rec_number;
var _link=system.library.urlCreator.getURLFromQuery

(_filename, _query, _title);
record.record_url =_link;

v. Click Save to save the script.

vi. Click Compile to check for any errors and compile. No errors 
should occur. 

Now, any new record will have the record.url field populated. 
However, as described in the following steps, you will need to 
perform the Mass Update procedure to populate the record.url field 
for existing records.

f. To prepare to perform the Mass Update procedure.

i. Click Change Management > Changes > Search Changes. 

ii. Use Search to display a list of change records.

iii. Select the records you want to update.

g. To perform the Mass Update procedure:

i. Click Mass Update in the toolbar to start updating the listed records.

Database Manager displays the initial form again, but with different 
options (buttons).
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ii. Do not specify values in any field. Click Complex Update. 

Database Manager displays the Mass Add/Update Instruction 
screen.

iii. Specify the following assignment statement in the Instructions for 
action on EACH RECORD input field:

record.url in $file = 
jscall("urlCreator.getURLFromQuery","cm3r",

"number=\"" + number in $file + "\"",
"Change number " + number in $file)

For each record updated, this step sets the record.url field based on 
the Web server URL entered in System Information Record. Then 
this step returns terminal control to you and displays the following 
message: 

<n> records updated in the cm3r file.

where <n> is the number of records updated.

h. To browse directly from the Web server using a URL that includes a 
ticket ID, disable the querySecurity parameter by using the 
instructions in the following HP Service Manager Help topic:

“Web parameter: sc.querySecurity”

i. Add the following line to the conversion script file in PPM Center for 
converting HP Service Manager changes to PPM Center requests:

ppmRFC.addURLReference(serviceManagerRFC.get
("record.url"), <display text for URL reference>);

where <display text for URL reference> represents the text to be 
displayed for the link to the URL.

For information about copying the sample conversion file provided 
with ALM and revising the copy, see Configuring the HP Service 
Manager Adapter Converter Property (Script) on page 115.

For information about the addURLReference function, see ppmRFC 
Object on page 118.
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Configuring for Bidirectional Integration

Perform this procedure only if you plan to configure the integration to be 
bidirectional.

To be able to verify later that bidirectional integration works, configure the 
fields that are required to map a PPM Center request to an HP Service Manager 
change. For example:

Create a structure called ppmFields in the cm3r table. See the following 
Help topic:

“How do I add a structure to the Database Dictionary?”

Create fields in the ppmFields structure. If you want to use the conversion 
script file provided with ALM as is, for HP Service Manager enter the 
following fields:

o ppmURL with a Caption of ppmURL and select a Type of StringType. 

o requestModifiedDate with a Caption of reqModDate and select a 
Type of DateTimeType. 

Generating Web Service Stubs 

In HP Service Manager, you can modify which fields are available through 
Web services. Each time you modify these settings, a new Web Services 
Description Language (WSDL) descriptor is created. In the PPM Server, you 
must regenerate the Web service stubs from the new descriptor.

To generate the stubs:

1. Navigate to the <PPM_Home>/bin/sdi directory on the PPM Server.

where <PPM_Home> represents the path where the PPM Center instance is 
installed. For example: xyzserver/E/PPMServer. 

Perform this procedure for new installations of ALM and after any upgrade of PPM 
Center.
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2. Run the following script:

./kGenerateServiceCenterStub.sh <wsdl-url> <PPM_ServerName>

where

The specific script is in the following format:

./kGenerateServiceCenterStub.sh http://<Host>:<Port>/
sc62server/PWS/ChangeManagement?wsdl <PPM_ServerName>

For example:

./kGenerateServiceCenterStub.sh http://ServManager:13080/
sc62server/PWS/ChangeManagement?wsdl kintana

3. Verify that the stubs are now in the following directory:

<PPM_Home>/server/<PPM_ServerName>/deploy/itg.war/WEB-INF/
classes/

<wsdl-url> represents the HP Service Manager WSDL URL for 
Change Management.

<PPM_ServerName> 

represents the subdirectory of <PPM_Home>/server 
specified during installation as the value for the 
KINTANA_SERVER_NAME parameter in the 
server.conf file. (This value is not necessarily the 
actual host name of the server.) When generated, the 
stubs will be placed in this subdirectory. 

The stub generation might fail if the host is not resolvable by name. To resolve the 
host by name, make an entry in the hosts file for the machine you want to connect. 
See the documentation for your operating system for the location of the hosts file.
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Configuring the HP Service Manager Adapter Configuration 
File

The HP Service Manager adapter configuration file is an XML file in PPM 
Center that enables integration of HP Service Manager with PPM Center and 
converts HP Service Manager changes to PPM Center requests. The 
configuration file consists of the following components, each with its own 
attributes or properties (see Figure 4-1 on page 95):

General settings for the adapter itself, such as its name and the name of the 
HP Service Manager application in which the changes are created.

Connector between HP Service Manager and the adapter.

Converter of changes in the HP Service Manager data model to generic 
requests in the PPM Center data model. The converter calls the scripts that 
define the field mapping and filter functions.

PPM Center sender, which sends the converted and filtered requests to 
PPM Center. 

The following sections describe how to configure the HP Service Manager 
adapter configuration file and the scripts called by its converter, and how to 
modify copies of the provided files while preserving the originals. 

If PPM Center is operating in a clustered server configuration, share or copy the 
<PPM_Home>/sdi-persistency directory and the <PPM_Home>/conf/sdi 
directory among all the servers in the cluster.
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Location, Naming, and Structure of HP Service Manager Adapter 
Configuration Files

Each HP Service Manager adapter configuration file must follow specific 
conventions for its location, naming, and structure, as described in the 
following sections.

Location and Naming of the HP Service Manager Adapter Configuration File

The adapter configuration files are located in the <PPM_Home>/conf/sdi 
directory of the PPM Server. This directory contains the following:

Configuration file for the adapter (or one for each adapter if there are 
multiple adapters). 

In this configuration file, you define a name for the adapter. The 
configuration file must have a .settings file extension.

Subdirectory (or one for each adapter configuration file if there are 
multiple files). 

The subdirectory contains the conversion scripts, which are called by the 
converter to map the fields between and to filter the changes and requests. 
The name of the subdirectory must be the same as the <adapter name> 
(for a description, see Structure of the HP Service Manager Adapter 
Configuration File on page 109 and Table 4-1 on page 111) followed by 
.ext. 

For example, if the adapter name is serviceManager-adapter, the  
<PPM_Home>/conf/sdi directory must contain a subdirectory named 
serviceManager-adapter.ext to hold all the conversion script files for 
the adapter.
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Structure of the HP Service Manager Adapter Configuration File

ALM provides, as a template, a default HP Service Manager adapter 
configuration file named serviceManager-adapter.settings1. The adapter 
file you configure and use must have a .settings file extension. 

Copy the default adapter file (to preserve the original), and rename the copy 
with a .settings file extension and, if desired, a different filename.

As detailed in subsequent sections, the adapter file has the following basic 
structure, including adapter attributes, and properties for its connector, 
converter, and sender:

<?xml version="1.0" encoding="UTF-8"?>
<settings>

<adapter adapter-name="<adapter name>">
<service-desk-application><SD application>

</service-desk-application>
<number-of-tickets><number of tickets>

</number-of-tickets>
<polling-schedules><schedule></polling-schedules>
<polling-frequency><frequency></polling-frequency>
<initial-load-state><date></initial-load-state>

<request-types>
<request-type level="1">
<polling-operation>

<connector>
<connector-type>serviceManagerChange</connector-type>

<properties>
idProperty=
userQuery=
lastUpdatedPropertyForQuery=
creationDatePropertyForQuery=
lastUpdatedPropertyForResult=
creationDatePropertyForResult=
keyMethodName=
timeZone=
wsDateFormatPattern=
queryDateFormatPattern=
userName=
password=
serviceUrl=

</properties>
</connector>
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<converter>
<converter-type>scriptConverter</converter-type>

<properties>
scripts=<convert1>.js,<convert2>.js,... 

</properties>
</converter>

</polling-operation>
</request-type>
</request-types>

<sender>
<sender-type>PPMSender</sender-type>

<properties>
userName=
password=
requestType=
updateRequest=
ticketIdFieldName=
sdSystemFieldName=
staticFieldNames=

</properties>
</sender>

</adapter>

</settings>

The following sections describe how to configure the adapter attributes, the 
connector properties, the converter property (scripts), and the sender 
properties.

Do not delete or change the values provided for <connector-type>, 
<converter-type>, or <sender-type>. 
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Configuring the HP Service Manager Adapter Attributes

Specify the adapter attributes of the HP Service Manager adapter configuration 
file, such as the adapter name and the service desk application, as described in 
Table 4-1.

Table 4-1. HP Service Manager adapter attributes (page 1 of 2)

Attribute Name 
(*Required) Description Default Value

*adapter-name

Logical name that represents the 
adapter name on the client 
machine. For example:
serviceManager-adapter
This name is also used for the 
scripts (.ext) directory. (See 
Location and Naming of the HP 
Service Manager Adapter 
Configuration File on page 108.)

(None)

*service-desk-application

Unique logical name for the service 
desk system you are using. 
For example:
HP Service Manager 

(None)

number-of-tickets Number of changes that the adapter 
processes at a time. 50

polling-schedules

Times of day that the adapter polls 
HP Service Manager for changes, 
formatted as a list of cron 
expressions separated by the new 
line character. 
For example: 
30 * * * * <new line> 0 * * * *

(None)
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polling-frequency
Frequency (in seconds) that the 
adapter polls HP Service Manager 
for changes.

If 
polling-schedules 
and 
polling-frequency 
are unspecified, 
then the default 
polling-frequency 
is 30 seconds, 
starting when 
you restart the 
PPM Server.

initial-load-state

Earliest creation date and time of 
changes the adapter retrieves from 
HP Service Manager, in the 
following format: 
MM/dd/yy HH:mm:ss z
For example:
10/19/08 21:30:00 EST
After completion, the adapter does 
not retrieve any new or updated 
changes (per the polling-schedules 
and polling-frequency attributes) 
until this attribute is commented out.

(None)

Table 4-1. HP Service Manager adapter attributes (page 2 of 2)

Attribute Name 
(*Required) Description Default Value
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Configuring the HP Service Manager Adapter Connector Properties

Specify the properties for the connector section of the HP Service Manager 
adapter configuration file as described in Table 4-2. 

Table 4-2. HP Service Manager adapter connector properties (page 1 of 3)

Property Name
(*Required) Description Default 

Value

*idProperty
Property name of the ID field in the 
instance returned from the HP Service 
Manager Web service.

(None)

userQuery

HP Service Manager query on the 
Change Management table (cm3r) 
that would work in the HP Service 
Manager query engine.

(None)

*lastUpdatedPropertyForQuery

Property name of the last-update field 
used to query the HP Service 
Manager Web service (the field name 
used in an expert search on the  
HP Service Manager client machine).

(None)

*creationDatePropertyForQuery
Property name of the creation-date 
field used to query the HP Service 
Manager Web service.

(None)

*lastUpdatedPropertyForResult

Property name of the last-update field 
in the instance returned from the  
HP Service Manager Web service 
(usually the field name exposed as 
API).

(None)

*creationDatePropertyForResult
Property name of the creation-date 
field in the instance returned from the 
HP Service Manager Web service.

(None)

*keyMethodName Name of the method for request keys 
(usually the ID field name). (None)
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*timeZone

Time zone, used for converting the 
last updated time of a request from  
HP Service Manager. Use the same 
time zone as the HP Service Manager 
server. 
The format can be GMT+<X> or 
GMT–<X>, where <X> is the offset in 
hh:mm format from GMT. For 
example, GMT–07:00.
However, to handle Daylight Saving 
Time, use an area time zone instead 
of specifying a time relative to GMT.

(None)

*wsDateFormatPattern

Date format used in the HP Service 
Manager Web service answer. 
For available formats, see the 
following URL:
http://java.sun.com/j2se/1.4.2/docs/
api/java/text/SimpleDateFormat.html

(None)

*queryDateFormatPattern

Date format used for querying the  
HP Service Manager system (as used 
in the UI expert search). 
For available formats, see the 
following URL:
http://java.sun.com/j2se/1.4.2/docs/
api/java/text/SimpleDateFormat.html

(None)

Table 4-2. HP Service Manager adapter connector properties (page 2 of 3)

Property Name
(*Required) Description Default 

Value
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Configuring the HP Service Manager Adapter Converter Property (Script)

The converter section of the HP Service Manager adapter configuration file 
contains the scripts property. The script file is written in the JavaScript 
language, and it maps the fields from the HP Service Manager data model to 
the PPM Center data model and filters the requests.

The scripts property is a script filename in the following format:

scripts=<convert1>.js 

This file must reside in the same directory as the adapter, as follows:

<PPM_Home>/conf/sdi/<adapter name>.ext

where <adapter name> is as defined in Table 4-1 on page 111.

*userName

User name in the HP Service Manager 
system that PPM Center uses to 
connect to HP Service Manager.
This user must have full access to the 
Change Management module in  
HP Service Manager.

(None)

*password
Password in the HP Service Manager 
system that PPM Center uses to 
connect to HP Service Manager. 

(None)

*serviceUrl

Web service URL of HP Service 
Manager. The format is as follows:
http://<Service_Manager_
Host>:<Port>/sc62server/PWS/
where <Service_Manager_Host> 
represents the host machine where 
HP Service Manager is running.

(None)

Table 4-2. HP Service Manager adapter connector properties (page 3 of 3)

Property Name
(*Required) Description Default 

Value

Make sure that no line in a script exceeds 256 characters.
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The conversion script is responsible for field mapping during the conversion of 
changes in the HP Service Manager data model to requests in the PPM Center 
data model, and for filtering the changes and requests. 

The script must contain the convert function and can contain the optional 
preFilter and postFilter functions, as follows: 

preFilter. The following function filters the changes before they are 
converted to the PPM Center data model, so that no unnecessary requests 
are converted:

preFilter(smChange)

For example, the following preFilter function specifies that HP Service 
Manager changes with a Low priority will not be converted and that all 
other requests will be converted:

function preFilter(smChange){
if (smChange.get("Request Urgency")==SM_PRIORITY_LOW)

return false;
else

return true;
}

convert. After identifying the PPM Center request attributes that are 
required for HP Service Manager changes, use the convert function of the 
conversion script to map fields of HP Service Manager changes to fields of 
PPM Center requests.

The following convert function uses the mapping you specify to convert 
the fields of the change in HP Service Manager to the fields of the request 
in PPM Center:

convert(smChange, ppmRFC)

Multiple scripts are supported, using a comma-separated list, in the following format:

scripts=<convert1>.js,<convert2>.js,...

The adapter searches for these conversion script files in the adapter directory.
116 Chapter 4



postFilter. The following function filters the converted requests, so that 
only the desired requests will be imported into PPM Center:

postFilter(ppmRFC)

For example, the following postFilter function specifies that only PPM 
Center requests with a status of Approved will be sent to the PPM Server:

function postFilter(ppmRFC){
ppmStatus=ppmRFC.getField("status");
if (ppmStatus==STATUS_APPROVED)

return true;
else

return false;
}

ALM provides a sample conversion script file named 
ConvertSMToPPM.js.sample in the  
<PPM_Home>/conf/sdi/serviceManager-adapter.ext directory.

Copy the sample file, delete the .sample extension in the copy, and revise the 
copied conversion script as needed. Use the syntax described in the following 
sections for the conversion script APIs. 

smChange Object

The smChange object represents the HP Service Manager change. For the 
preFilter and convert script functions, use one of the following functions to 
retrieve fields from the HP Service Manager change:

value=SMRFC.get(String fieldName); 

SMRFC.get("Request Urgency")=SM_PRIORITY_LOW; 
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ppmRFC Object

The ppmRFC object represents the PPM Center request. For the convert and 
postFilter script functions, use the following functions to modify the PPM 
Center request fields:

Reference ID

You must use the following function to track the HP Service Manager 
change ID in the PPM Center request:

setRefId(String referenceId);

Time Stamp

You must use the following function to set the last update time in the PPM 
Center request:

/**
* Set the time stamp in long format—that is, the number of
* milliseconds since January 1, 1970, 00:00:00 GMT
**/
setUpdatedTimeStamp(long updatedTimeStamp);
/**
* Set the time stamp in the Java simple date format, which is
* described at the following location: 
* http://java.sun.com/j2se/1.4.2/docs/api/java/text/

SimpleDateFormat.html
**/
setUpdatedTimeStamp(String updatedTimeStamp, String format);

Status

Use the following function to change the status of the PPM Center request 
and allow the workflow of the request to advance:

setStatus(String newStatus)

To view or change the set of statuses provided with PPM Center, open the 
request type in the PPM Workbench, select the Request Status tab, and 
click Request Status. For more information, see the HP Demand 
Management Configuration Guide. 
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General Field

Use the following function to set the value of a general field in the PPM 
Center request:

setField (String fieldName, String value);

Date

Use the following function to set the value of a date field in the PPM 
Center request:

/**
* Set the date in long format—that is, the number of
* milliseconds since January 1, 1970, 00:00:00 GMT
**/
setDateValue(String fieldName, long date);
/**
* Set the date in the Java simple date format which is
* described in the following location:
* http://java.sun.com/j2se/1.4.2/docs/api/java/text/

SimpleDateFormat.html
**/
setDateValue(String fieldName, String date, String format);

Notes to be added upon creation of a PPM Center request

Use the following function to add a note upon creation of a PPM Center 
request:

addUserNoteOnCreate(String content, String addedBy,
long time;

Notes to be added upon update of a PPM Center request

Use the following function to add a note upon update of a PPM Center 
request:

addUserNoteOnUpdate(String content, String addedBy,
long time;

URL reference creation

If you have configured HP Service Manager to expose the ticket URL as 
the record.url attribute (see Configuring Browsing of HP Service 
Manager Changes from a URL on page 101), you can use the following 
function to create a URL reference to an HP Service Manager change:

addURLReference(String attachmentURL, String attachments);
Integration of PPM Center with HP Service Manager 119



Configuring the HP Service Manager Adapter Sender Properties

Specify the properties for the sender section of the HP Service Manager 
adapter configuration file as described in Table 4-3. The sender controls 
creating RFCs in PPM Center with the converted data.

Table 4-3. HP Service Manager adapter sender properties (page 1 of 2)

Property Name 
(*Required) Description Default 

Value

*userName User name in PPM Center by whose credentials 
requests are created. (None)

*password

Password of the userName.
This password should be encrypted using the 
PPM Center script kEncrypt.sh, which is 
located in the bin directory of the PPM Server. 
Encrypted passwords must be created in a 
CDATA section.

(None)

*requestType

PPM Center request type that should be 
created for the converted changes.
For example:
ALM - Request for Change (RFC)

(None)

updateRequest

If set to true, enables updates made to  
HP Service Manager changes to be 
automatically sent to existing PPM Center 
requests.
HP recommends retaining the default value of 
false because usually, after HP Service 
Manager changes are converted to PPM Center 
requests, processing takes place entirely in 
PPM Center.

false

*ticketIdFieldName a

Field in PPM Center containing the HP Service 
Manager ticket ID. This field is presented in the 
PPM Center request as the Ticket Id field in the 
Service Desk Info section.

(None)
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The sender is the last section of the adapter configuration file. Make sure the 
file ends with the following lines: 

</adapter>
</settings>

This completes the configuration of the HP Service Manager adapter 
configuration file.

If you want to establish bidirectional integration, proceed to Configuring the 
PPM Center Adapter Configuration File. Otherwise, go to Configuring the 
server.conf Parameter on page 134.

*sdSystemFieldName a

Field in PPM Center containing the HP Service 
Manager system name. This field is presented 
in the PPM Center request as the System 
Name field in the Service Desk Info section.

(None)

*staticFieldNames
(Applicable and 
required only for 
bidirectional 
integration)

List of PPM Center request fields (separated by 
semicolons) that are not to be updated when 
changes are made to their mapped HP Service 
Manager change fields. 
This list is used to prevent inappropriate update 
of HP Service Manager tickets for bidirectional 
integration. For example, to prevent a ticket 
from being updated when the last update time in 
PPM Center changes, specify the following:
REQD-SD_LAST_UPDATE

(None)

a. If PPM Center is integrated with multiple HP Service Manager servers, the combination of values in 
the ticketIdFieldName and sdSystemFieldName properties ensures that all the tickets from all the 
HP Service Manager servers are uniquely identified in PPM Center.

Table 4-3. HP Service Manager adapter sender properties (page 2 of 2)

Property Name 
(*Required) Description Default 

Value

If PPM Center is operating in a clustered server configuration, share or copy the 
<PPM_Home>/sdi-persistency directory and the <PPM_Home>/conf/sdi 
directory among all the servers in the cluster.
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Configuring the PPM Center Adapter Configuration File

The PPM Center adapter configuration file is an XML file in PPM Center that 
enables integration of PPM Center with HP Service Manager and then converts 
PPM Center RFCs to HP Service Manager change updates. The configuration 
file consists of the following components, each with its own attributes or 
properties (see Figure 4-2 on page 96):

General settings for the adapter itself, such as its name.

Connector between PPM Center and the adapter.

Converter of RFCs in the PPM Center data model to change updates in the 
HP Service Manager data model. The converter calls the scripts that define 
the field mapping and filter functions.

Sender, which sends the converted and filtered requests to HP Service 
Manager. 

The following sections describe how to configure the PPM Center adapter 
configuration file and the scripts called by its converter, and how to modify 
copies of the provided files while preserving the originals. 

This procedure is optional. It establishes bidirectional integration. (See Introduction to 
Integration of PPM Center with HP Service Manager on page 93.) If you do not want 
to establish bidirectional integration at this time, proceed to Configuring the 
server.conf Parameter on page 134.

If PPM Center is operating in a clustered server configuration, share or copy the 
<PPM_Home>/sdi-persistency directory and the <PPM_Home>/conf/sdi 
directory among all the servers in the cluster.
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Location, Naming, and Structure of PPM Center Adapter Configuration Files

Each PPM Center adapter configuration file must follow specific conventions 
for its location, naming, and structure, as described in the following sections.

Location and Naming of the PPM Center Adapter Configuration File

The adapter configuration files are located in the <PPM_Home>/conf/sdi 
directory of the PPM Server. This directory contains the following:

Configuration file for the adapter (or one for each adapter if there are 
multiple adapters). 

In this configuration file, you define a name for the adapter. The 
configuration file must have a .settings file extension.

Subdirectory (or one for each adapter configuration file if there are 
multiple files). 

The subdirectory contains the conversion scripts, which are called by the 
converter to map the fields between and to filter the tickets and requests. 
The name of the subdirectory must be the same as the <adapter name> 
(for a description, see Structure of the PPM Center Adapter Configuration 
File on page 124 and Table 4-4 on page 126) followed by .ext. 

For example, if the adapter name is ppm-adapter, the  
<PPM_Home>/conf/sdi directory must contain a subdirectory named 
ppm-adapter.ext to hold all the conversion script files for the adapter.
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Structure of the PPM Center Adapter Configuration File

ALM provides, as a template, a default PPM Center adapter configuration file 
named ppm-sm-adapter.settings1. The adapter file you configure and use 
must have a .settings file extension. 

Copy the default adapter file (to preserve the original), and rename the copy 
with a .settings file extension and, if desired, a different filename.

As detailed in subsequent sections, the adapter file has the following basic 
structure, including adapter attributes, and properties for its connector, 
converter, and sender:

<?xml version="1.0" encoding="UTF-8"?>
<settings>

<adapter adapter-name="<adapter name>">
<service-desk-application><SD application>

</service-desk-application>
<number-of-tickets><number of tickets></number-of-tickets>
<polling-schedules><schedule></polling-schedules>
<polling-frequency><frequency></polling-frequency>

<request-types>
<request-type level="1">
<polling-operation>

<connector>
<connector-type>PPMRequest</connector-type>

<properties>
sdSystemName=
requestType=
datePattern=
userName=
password=
sdSystemFieldName=
idProperty=
updateTimeField=
createTimeField=
requestStatusNames=

</properties>
</connector>

<converter>
<converter-type>scriptConverter</converter-type>

<properties>
scripts=<convert1>.js,<convert2>.js,...

</properties>
</converter>
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</polling-operation>
</request-type>
</request-types>

<sender>
<sender-type>serviceManagerSender</sender-type>

<properties>
userName=
password=
queryDateFormatPattern=
timeZone=
keyMethodName=
serviceUrl=
staticFieldNames=
idProperty=

</properties>
</sender>

</adapter>

</settings>

The following sections describe how to configure the adapter attributes, the 
connector properties, the converter property (scripts), and the sender 
properties.

Configuring the PPM Center Adapter Attributes

Specify the adapter attributes of the PPM Center adapter configuration file, 
such as the adapter name and the service desk application, as described in 
Table 4-4.

Do not delete or change the values provided for <connector-type>, 
<converter-type>, or <sender-type>. 
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Table 4-4. PPM Center adapter attributes

Attribute Name 
(*Required) Description Default Value

*adapter-name

Logical name that represents the 
adapter name on the client 
machine. For example:
ppm-adapter
This name is also used for the 
scripts (.ext) directory. (See 
Location and Naming of the PPM 
Center Adapter Configuration File 
on page 123.)

(None)

*service-desk-application

Unique, logical name for the PPM 
Center system you are using. 
For example:
PPM 

(None)

number-of-tickets Number of tickets that the adapter 
processes at a time. 50

polling-schedules

Times of day that the adapter polls 
PPM Center for changes, formatted 
as a list of cron expressions 
separated by the new line 
character. 
For example: 
30 * * * * <new line> 0 * * * *

(None)

polling-frequency
Frequency (in seconds) that the 
adapter polls PPM Center for 
changes.

If 
polling-schedules 
and 
polling-frequency 
are unspecified, 
then the default 
polling-frequency 
is 30 seconds, 
starting when 
you restart the 
PPM Server.
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Configuring the PPM Center Adapter Connector Properties

Specify the properties for the connector section of the PPM Center adapter 
configuration file as described in Table 4-5. 

Table 4-5. PPM Center adapter connector properties (page 1 of 2)

Property Name
(*Required) Description Default Value

*sdSystemName

Name of the adapter from which changes 
are imported into PPM Center as requests. 
Must be the same value as specified for 
the service-desk-application property in 
the HP Service Manager adapter (see 
Table 4-1 on page 111).
For example:
HP Service Manager 

(None)

*requestType

PPM Center request type that should be 
created for the converted changes.
For example:
ALM - Request for Change (RFC)

(None)

datePattern

Date format for the date field. Use the 
Java™ simple date format. See the 
following URL:
http://java.sun.com/j2se/1.4.2/docs/api/
java/text/SimpleDateFormat.html

yyyy-MM-dd
HH:mm:ss

*userName User name in PPM Center by whose 
credentials requests are created. (None)

*password

Password of the userName.
This password should be encrypted using 
the PPM Center script kEncrypt.sh, 
which is located in the bin directory of the 
PPM Server. Encrypted passwords must 
be created in a CDATA section.

(None)
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*sdSystemFieldName

Field in PPM Center containing the  
HP Service Manager system name. This 
field is presented in the PPM Center 
request as the System Name field in the 
Service Desk Info section.

(None)

*idProperty
Property name of the ID field in the 
instance returned from the HP Service 
Manager Web service.

(None)

*updateTimeField
Field in PPM Center that represents the 
time the request was updated in PPM 
Center.

(None)

*createTimeField
Field in PPM Center that represents the 
time the request was created in PPM 
Center.

(None)

requestStatusNames

List of PPM Center request statuses, 
separated by semicolons (;). Only 
requests with the statuses you specify are 
retrieved from PPM Center for processing. 
However, if you do not specify any 
statuses, all requests are retrieved.

(None)

Table 4-5. PPM Center adapter connector properties (page 2 of 2)

Property Name
(*Required) Description Default Value
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Configuring the PPM Center Adapter Converter Property (Script)

The converter section of the PPM Center adapter configuration file contains 
the scripts property. The script file is written in the JavaScript language. The 
script maps the fields from the PPM Center data model to the HP Service 
Manager data model, and filters the requests.

The scripts property is a script filename in the following format:

scripts=<convert1>.js

This file must reside in the same directory as the adapter, as follows:

<PPM_Home>/conf/sdi/<adapter name>.ext

where <adapter name> is as defined in Table 4-4 on page 126.

The conversion script is responsible for field mapping during the conversion of 
requests in the PPM Center data model to change updates in the HP Service 
Manager data model, and for filtering the requests and change updates. 

The script must contain the convert function and can contain the preFilter 
and postFilter functions, as follows: 

preFilter. The following function filters the changes before they are 
converted to the HP Service Manager data model, so that no unnecessary 
requests are converted:

preFilter(ppmRFC)

Make sure that no line in a script exceeds 256 characters.

Multiple scripts are supported, using a comma-separated list, in the following format:

scripts=<convert1>.js,<convert2>.js,...

The adapter searches for these conversion script files in the adapter directory.
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convert. After identifying the HP Service Manager change attributes that 
need to be updated from the PPM Center requests, use the convert 
function of the conversion script to map fields of PPM Center requests to 
fields of HP Service Manager changes.

The following convert function uses the mapping you specify to convert 
the fields of the request in PPM Center to the fields of the change in  
HP Service Manager:

convert(ppmRFC, smChange)

postFilter. The following function filters the converted change updates, so 
that only the desired updates will be applied to the corresponding change in 
HP Service Manager:

postFilter(smChange)

ALM provides a sample conversion script file named 
ConvertPPMToSM.js.sample in the  
<PPM_Home>/conf/sdi/serviceManager-adapter.ext directory.

Copy the sample file, delete the .sample extension in the copy, and revise the 
copied conversion script as needed. Use the syntax described in the following 
sections for the conversion script APIs. 

ppmRFC Object

The ppmRFC object represents the PPM Center request. For the preFilter 
and convert script functions, use the following function to retrieve request 
fields from PPM Center:

get(String fieldName);
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smChange Object

The smChange object represents the HP Service Manager ticket. For the 
convert and postFilter script functions, use the following functions to 
modify the ticket fields:

Reference ID

You must use the following function to track the HP Service Manager 
change ID in the PPM Center request:

setRefId(String referenceId);

Time Stamp

You must use the following function to set the last update time in the PPM 
Center request:

/**
* Set the time stamp in long format—that is, the number of 
* milliseconds since January 1, 1970, 00:00:00 GMT
**/
setUpdatedTimeStamp(long updatedTimeStamp);
/**
* Set the time stamp in the Java simple date format, which is 
* described at the following location: 
* http://java.sun.com/j2se/1.4.2/docs/api/java/text/

SimpleDateFormat.html
**/
setUpdatedTimeStamp(String updatedTimeStamp, String format);

General Field

Use the following function to set a value of a general field in the PPM 
Center request:

setField (String fieldName, String value);
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Date

Use the following function to set a value of a date field in the PPM Center 
request:

/**
* Set the date in long format—that is, the number of 
* milliseconds since January 1, 1970, 00:00:00 GMT
**/
setDateValue(String fieldName, long date);
/**
* Set the date in the Java simple date format which is
* described in the following location:
* http://java.sun.com/j2se/1.4.2/docs/api/java/text/

SimpleDateFormat.html
**/
setDateValue(String fieldName, String date, String format);

Configuring the PPM Center Adapter Sender Properties

Specify the properties for the sender section of the PPM Center adapter 
configuration file as described in Table 4-6. The sender controls updating 
changes in HP Service Manager with the converted data.

Table 4-6. PPM Center adapter sender properties (page 1 of 2)

Property Name 
(*Required) Description Default 

Value

*userName

User name in the HP Service Manager 
system that PPM Center uses to connect to 
HP Service Manager.
This user must have full access to the 
Change Management module in HP Service 
Manager.

(None)

*password
Password in the HP Service Manager system 
that PPM Center uses to connect to  
HP Service Manager. 

(None)

*queryDateFormatPattern

Date format used for querying the HP Service 
Manager system (as used in the UI expert 
search). 
For available formats, see the following URL: 
http://java.sun.com/j2se/1.4.2/docs/api/java/
text/SimpleDateFormat.html

(None)
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*timeZone

Time zone, used for converting the last 
updated time of a request from HP Service 
Manager. Use the same time zone as the  
HP Service Manager server. 
The format can be GMT+<X> or GMT–<X>, 
where <X> is the offset in hh:mm format from 
GMT. For example, GMT–07:00.
However, to handle Daylight Saving Time, 
use an area time zone instead of specifying a 
time relative to GMT.

(None)

*keyMethodName Name of the method for request keys (usually 
the ID field name). (None)

*serviceUrl

Web service URL of HP Service Manager. 
The format is as follows:
http://<Service_Manager_Host>:<Port>/
sc62server/PWS/
where <Service_Manager_Host> represents 
the host machine where HP Service Manager 
is running.

(None)

*staticFieldNames
(Applicable and required 
only for bidirectional 
integration)

List of HP Service Manager change fields 
(separated by semicolons) that are not to be 
updated when changes are made to their 
mapped PPM Center request fields. 
This list is used to prevent inappropriate 
update of PPM Center requests for 
bidirectional integration. For example, to 
prevent a request from being updated when 
the last update time in HP Service Manager 
changes, specify the following:
sysmodtime

(None)

idProperty
Property name of the ID field in the instance 
returned from the HP Service Manager Web 
service.

(None)

Table 4-6. PPM Center adapter sender properties (page 2 of 2)

Property Name 
(*Required) Description Default 

Value
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The sender is the last section of the adapter configuration file. Make sure the 
file ends with the following: 

</adapter>
</settings>

This completes the configuration of the PPM Center adapter file.

Configuring the server.conf Parameter

To add and specify the parameter related to HP Service Manager integration to 
the PPM Center server.conf configuration file: 

1. Stop the PPM Server.

2. Run the following script: 

sh ./kConfig.sh 

Set the parameter and value as shown in the following table. (All parameter 
names begin with com.kintana.core.server. but that is not shown in 
the table.)

3. Restart the PPM Server.

If PPM Center is operating in a clustered server configuration, share or copy the 
<PPM_Home>/sdi-persistency directory and the <PPM_Home>/conf/sdi 
directory among all the servers in the cluster.

For more information about the steps in this procedure, see the Installation and 
Administration Guide. 

Parameter Value

MAC_LOG_SEVERITY

Specify the level of logging to be used. When set 
to 0 (the default), only integration exceptions 
(errors) and a summary are logged. When set to 
1, non-error events related to the processing of 
changes are also logged. See Error and 
Non-Error Logging on page 136.
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Enabling the ALM Startup Service 

To enable the ALM Startup service:

1. Log on to PPM Center. 

2. From the menu bar, select Open > Administration > Schedule Services. 

The Schedule Services page opens.

3. In the Service Name column, select the ALM Startup service.

4. In the Status column for the service, select Enabled. 

5. Specify one hour for the interval in the Schedule column. This interval has 
no effect on the polling of HP Service Manager for tickets.

6. Click Save. 

7. If a date was specified in the initial-load-state HP Service Manager 
adapter attribute in order to retrieve existing HP Service Manager changes 
from that date forward, those changes will be retrieved, converted, and sent 
to PPM Center, but then no new HP Service Manager changes will be 
retrieved. In this case, to retrieve HP Service Manager changes on an 
ongoing basis, do the following: 

a. Stop the PPM Server. 

b. Comment out the initial-load-state HP Service Manager adapter 
attribute.

c. Restart the PPM Server in normal mode.

d. Repeat step 1 through step 6 to verify that the ALM Startup service is 
running. 

For more information about the steps in this procedure, see the Installation and 
Administration Guide. 
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Error and Non-Error Logging

As described in the following sections, logging is essential for ensuring correct 
operation of the integration. You can specify the following two types of 
logging for HP Service Manager integration: 

System-level logging using a summary logs table and a log details table. 
See System-Level Logging.

Configurable logging for conversion scripts. See Configurable Logging for 
Conversion Scripts on page 139.

System-Level Logging

System-level logging is the only way to administer the integration on an 
ongoing basis. HP recommends creating a portlet or a report to regularly query 
and display the logging tables and help you identify potential problems.

You can configure ALM to log only errors for integration exceptions and a 
summary, or to also log entries for non-error events related to the processing of 
changes. For information about setting the server.conf parameter that 
controls the level of logging (MAC_LOG_SEVERITY), see Configuring the 
server.conf Parameter on page 134. 

Setting the MAC_LOG_SEVERITY parameter to 0 causes the summary logs table 
(SDI_SUMMARY_LOGS) to include only a summary of errors. Setting this 
parameter to 1 causes the summary logs table to also include information about 
tickets as they are being processed. 

The summary logs table maintains only one row for each unique combination 
of the TICKET_ID and ADAPTER_NAME columns. See Summary Logs Table 
on page 137. Each row is updated on an ongoing basis as status changes.

The log details table (SDI_LOG_DETAILS) includes details about the errors that 
have a value of Y in the MESSAGES column of the summary logs table. See 
Log Details Table on page 138. (The setting of the MAC_LOG_SEVERITY 
parameter in the server.conf file does not affect the contents of the log 
details table.) 
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Summary Logs Table

The columns in the summary logs table (SDI_SUMMARY_LOGS) that contain 
useful information are described in Table 4-7. 

Table 4-7. Summary logs table (SDI_SUMMARY_LOGS) (page 1 of 2)

Column Description

LOG_ID Primary key for this table.

TICKET_ID
Ticket ID imported using the connector. In some cases 
such as connection errors or authentication failures, the 
value is SUMMARY. 

STATUS

Current state of the ticket. Possible values are as follows:
Retrieved/Not processed. The ticket was retrieved 
and has not been processed. 
preFilter Passed. The ticket passed the preFilter 
function and was sent to the convert function.
Rejected in preFilter. The ticket did not pass 
preFilter criteria. 
Ticket converted. The ticket passed the convert 
function and was sent to the postFilter function. 
postFilter Passed. The ticket passed the 
postFilter function and was sent to the sender 
function. 
Rejected in postFilter. The ticket did not pass the 
postFilter function. 
Error occurred in JavaScript. An exception occurred 
in the preFilter, convert, or postFilter 
function when processing the JavaScript conversion 
file. 
Ticket processed. The ticket was created in the target 
system. 
Errors occurred when sending the ticket. An 
exception occurred and the ticket could not be sent to 
the sender. 

LAST_UPDATE_DATE Last time the ticket was updated in PPM Center.

COMPONENT Component that logged the message—the connector, 
converter, or sender. 
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Log Details Table

The log details table (SDI_LOG_DETAILS) includes the details described in 
Table 4-8 for the errors that have a value of Y in the MESSAGES column of the 
summary logs table. 

ADAPTER_NAME Service desk name in the adapter settings file.

MESSAGES 
If the value is Y, further details for this log entry are 
provided in the log details table (SDI_LOG_DETAILS). If 
the value is N, no further details are provided.

IN_PROCESS
If the value is Y, processing of this ticket is complete. If 
the value is N, processing of this ticket is not yet 
complete.

Table 4-7. Summary logs table (SDI_SUMMARY_LOGS) (page 2 of 2)

Column Description

Table 4-8. Log details table (SDI_LOG_DETAILS)

Column Description

LOG_DETAIL_ID Primary key for this table

LOG_ID Foreign key to the entry in the SDI_SUMMARY_LOGS table

DETAILS Detailed error message captured when the error occurred
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Configurable Logging for Conversion Scripts

Configurable logging is useful for debugging your integration mapping. 
During testing, you can specify log messages that appear at key points in the 
conversion script to indicate correct or incorrect conversion. Before deploying 
the integration to production, you would typically want to comment out the 
messages for correct operation so they do not quickly accumulate in the logs.

If you want to view log messages describing the activity that occurs during the 
request conversion process, you can include logging objects in your conversion 
scripts. During the conversion process, you can view the log messages in the 
conversion script log files, located in the <PPM_Home>/script-logs directory. 
Each adapter logs messages in a separate log file. The names of the log files are 
based on the names of the adapters for which the files log errors.

Within any of the script functions, a logging object with the following syntax 
should be included:

logger.<type of message>("<log message>");

The following message types can be used:

info. Records all processing activity that is performed.

warn. Records warning messages.

error. Records error messages.

For example, you can include a logging object such as the following:

logger.info("Processing ticket " +
serviceManagerRFC.get("header.changeNumber"));

If you want the conversion script log files to display a list of all service desk 
application fields, you can include the following logging object in your 
conversion script:

logger.info(BeanUtils.describe(ticket));

If you use this logging object, make sure the following line is included at the 
beginning of the conversion script:

importPackage(Packages.org.apache.commons.beanutils);

Logging is also controlled by the severity specified in the PPM Center 
logging.conf file.
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5 Integration of PPM Center with 
Universal CMDB 
Introduction to Integration of PPM Center with Universal CMDB

HP Universal CMDB consists of a business-service-oriented data model with 
built-in discovery of the following:

Configuration items (CIs) and their dependencies

Visualization and mapping of business services

Tracking of configuration changes

When you integrate PPM Center with Universal CMDB, you can select CIs 
and run impact analysis reports from change requests in PPM Center, to 
determine which components of a system will be affected by a software 
change, and to what extent. The integration assists IT managers and Change 
Advisory Boards in deciding whether a change request should be approved for 
development or deployment. 

For example, your software change might involve upgrading a database server. 
Before you can perform the upgrade, you need to stop the server. In some cases 
this could prevent users from accessing crucial services, or even cause a crash 
of your production system. Impact analysis determines the effect on the entire 
system of stopping the server, and gives you a report showing the components 
that will be impacted. This enables you to plan the change with minimal 
disturbance to your operations.

For more information about the benefits of this integration, see Integration of 
PPM Center with HP Universal CMDB on page 19.

For information about the versions supported for integration, see the System 
Requirements and Compatibility Matrix. 
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For references to more information about HP Universal CMDB, see  
HP Universal CMDB Documentation on page 23.

Using Impact Analysis in a Change Request Lifecycle

Since a software change might be developed and deployed over a lengthy 
period of time, you might want to generate an Impact Analysis Report at the 
following stages in the lifecycle of the change request:

Before you approve or develop the change. Before you approve or 
develop the change, it is useful to forecast the effect that introducing the 
change will have on your production system. You describe the intended 
change, specify the components that you think will be affected, and run 
impact analysis to forecast the effect of the change. 

The resulting report gives you an indication of how your system will cope 
with the change after the change has been developed and deployed, and 
helps you decide whether to approve the change for development.

After the change is approved for deployment to a production system, 
but before you deploy the change. While the software change is being 
developed and then evaluated for quality, modifications may occur in your 
system infrastructure. For example, servers might be added or removed, or 
applications might be changed. As a result, the original impact analysis 
may no longer give an accurate indication of what will happen when you 
introduce the change. So after the change has been developed, evaluated, 
and approved for deployment, you perform another impact analysis to give 
you an up-to-date picture. 

No software needs to be installed on the HP Universal CMDB server to integrate PPM 
Center and HP Universal CMDB. However, see the System Requirements and 
Compatibility Matrix. 

Integration of PPM Center with Mercury Application Mapping was supported with PPM 
Center version 7.5 and Managing Application Change (MAC), but integration of PPM 
Center with Mercury Application Mapping is not supported with PPM Center version 
8.00 and ALM. The MAM Impact Analysis field group is no longer available in version 
8.00. During an upgrade of PPM Center to version 8.00, any MAM Impact Analysis 
reports in version 7.5 are attached to the associated requests as references, so the 
reports remain available to view after the upgrade.
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Configuring Universal CMDB for the Integration

To configure Universal CMDB for the integration, configure views in 
Universal CMDB and create a PPM Center user and password in Universal 
CMDB. See the Universal CMDB documentation, listed in HP Universal 
CMDB Documentation on page 23.

Configuring PPM Center for the Integration

Perform the procedures in this section to configure PPM Center for the 
integration.

Configuring server.conf Parameters in PPM Center

To add and specify the parameters related to Universal CMDB integration to 
the PPM Center server.conf configuration file:

1. Stop the PPM Server.

2. Run the following script: 

sh ./kConfig.sh 

Set the parameters and values as shown in the following table. (All 
parameter names begin with com.kintana.core.server. but that is not 
shown in the table.)

PPM server must have the same domain name as the Universal CMDB server. For 
example, if the Universal CMDB server domain name is abc.chn.hp.com, the PPM 
server must be xyz.chn.hp.com, such as anbo.chn.hp.com.
PPM server must be running on the save protocol as the Universal CMDB server. 
For example, if the Universal CMDB server is running on HTTPS, the PPM server 
must be running on HTTPS as well.

For more information about the steps in this procedure, see the Installation and 
Administration Guide. 
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Parameter Value

UCMDB_SERVER_URL

URL of the Universal CMDB server:
http://<UCMDB_Host>:<port>/ucmdb/ 
or
https://<UCMDB_Host>:<port>/ucmdb/ 
where <UCMDB_Host> represents the host 
machine on which Universal CMDB is running.
Note: If the Universal CMDB server is 
configured to support HTTPS, make sure you 
configure the 
UCMDB_SSL_KEYSTORE_PATH parameter.

UCMDB_GATEWAY_URL

URL of the Probe Gateway component of the 
Discovery and Dependency Mapping (DDM) 
Probe. The Probe Gateway provides 
communication (HTTP or HTTPS) between the 
Probe Manager and the Universal CMDB user 
for processes such as downloading tasks and 
returning task results. 
The value for <UCMDB_Host>:<port> is 
usually the same as for the 
UCMDB_SERVER_URL parameter.
http://<UCMDB_Host>:<port>/mam/
gateway? 

UCMDB_USER

Universal CMDB user name, for example, 
admin.
This user name must include only single-byte 
characters.

UCMDB_PASSWORD

Password for Universal CMDB user specified 
in UCMDB_USER.
This password must be encrypted as 
described in Encrypting the Password 
Specified as a server.conf Parameter.
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3. Restart the PPM Server.

Encrypting the Password Specified as a server.conf Parameter

The password that you assigned to the UCMDB_PASSWORD parameter must be 
encrypted, as follows:

For PPM Center versions 8.00, 8.00.01, and 8.02

a. Navigate to the <PPM_Home>/bin/ucmdb directory.

b. Run the kEncryptUcmdbPassword.sh utility.

UCMDB_SERVER_VERSION

Version of the Universal CMDB server. 
For Universal CMDB versions 7.50 and 
8.00, specify 7.5 or 7.50 as the version of 
Universal CMDB being used on the 
Universal CMDB server, even if Universal 
CMDB is at version 8.00.
For Universal CMDB version 9.00, specify 
9.00 as the version of Universal CMDB.

UCMDB_MAX_CI_NUMBER

Maximum number of CIs a request is allowed 
to have. Valid values are from 1 to 100. If a 
value greater than 100 is specified, the PPM 
Server will not restart and displays an error 
message. The default is 20.

UCMDB_SSL_KEYSTORE_
PATH

Universal CMDB keystore path, used only if 
the UCMDB_SERVER_URL parameter uses 
HTTPS.

IMPACT_ANALYSIS_
REPORT_CATEGORY 

Impact analysis report category, for example, 
UCMDB.

IMPACT_ANALYSIS_
REPORT_SEVERITY 

Impact analysis report severity, for example, 
Warning(1).

UCMDB_NAME_FIELD The field that stores the CI name, for example, 
name.

Parameter Value
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c. Specify the password you want to encrypt.

The utility encrypts the password and displays the encrypted text.

d. Copy the text in the Encrypted text section on the screen and paste 
the text as the value for UCMDB_PASSWORD in the server.conf file, 
making sure that you do not copy any carriage returns into the file. 

For PPM Center version 8.03 and later

Starting from PPM Center version 8.03, you need to encrypt the Universal 
CMDB password with PPM’s encryption tool kEncrypt.sh.

To encrypt the password, 

a. Navigate to the <PPM_Home>/bin directory.

b. Run the following:

sh kEncrypt.sh -t admin

The encrypted text returns. 

c. Copy and paste the encrypted text as the value for parameter 
UCMDB_PASSWORD in the server.conf file.

Configuring a Request Type

The integration requires a request type with the Universal CMDB Impact 
Analysis field group. The ALM - Request for Change (RFC) request type 
provided with ALM includes this field group, which is enabled by default. 

If necessary, you can add the Universal CMDB Impact Analysis field group to 
a different request type, as follows:

1. Log on to PPM Center.

2. From the menu bar, select Open > Administration > Open Workbench.

The PPM Workbench opens.

Cookies need to be enabled for the browser you use.
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3. From the shortcut bar, select Demand Mgmt > Request Types. 

The Request Types Workbench opens.

4. Select the request type to which you will add the Universal CMDB Impact 
Analysis field group.

5. Open the request type and its request header type.

6. Click Field Groups. 

7. In the Field Groups window, scroll down and select the checkbox to enable 
the Universal CMDB Impact Analysis field group.

8. Click OK to add the Universal CMDB Impact Analysis field group to the 
request header type.

9. Expand Universal CMDB Impact Analysis in the Prompt column on the 
Fields tab in the request header type.

10. Select the CI List field, and click Edit. 

11. On the Attributes tab, select No for the Display Only option and select Yes 
for the Display option. 

12. Select the Security tab and edit field-level security for the CI List field as 
needed.

13. Click OK to save and close the Edit window and click OK to save and close 
the Request Header Type window.

14. Return to the request type, which now has the Universal CMDB Impact 
Analysis section, including the CI List field, based on the changes you 
made to the request header type.

15. Use the Layout tab to reposition the Impacted Configuration Items section 
on the request type, as desired.

On the Status Dependencies tab for the CI List field, leave the Required, 
Reconfirm, and Clear options set to No. 
You can change the Visible and Editable options as desired.
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Using the Integration 

The Configuration Management Database (CMDB) in Universal CMDB 
contains information about all your CIs (servers, applications, hosts, and so on) 
and their relationships. CIs can vary widely in complexity, size, and type, from 
an entire system (including all hardware, software, and documentation) to a 
single module or minor hardware component.

For example, the CMDB contains information about which CIs are affected 
when other CIs stop functioning or have operational problems.

You generally perform impact analysis as follows:

Select the CIs that you suspect might be affected by the planned software 
change.

Run impact analysis on the selected CIs. Impact analysis analyzes the 
relationships among the selected CIs in the CMDB, and generates a report 
showing the CIs that will be affected by the planned change.

Run impact analysis at additional points. Examples:

o Before approving a change, to forecast the effect that the change will 
have on your system.

o After the change has been created, in case your system infrastructure 
has changed since the previous impact analysis was performed.

HP recommends using CI names in Universal CMDB that will be meaningful to 
you in PPM Center.
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Selecting CIs in Universal CMDB and Adding the CIs to a Request

To select the desired CIs in Universal CMDB to add to the request:

1. Log on to PPM Center.

2. From the menu bar, select Create > Request. 

3. Create a request using a request type that includes the Universal CMDB 
Impact Analysis field group.

4. In the Impacted Configuration Items section of the new request, click Select 
Configuration Items. 

The CI selector applet from Universal CMDB launches, with Browse and 
Search tabs.

5. Use the tabs to select the desired CIs for the request.

To use the Browse tab, select a view such as Network Topology from 
the View list.

Expand the view as desired. You can select multiple items in the tree by 
using Ctrl + click or Shift + click. 
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To use the Search tab, complete the Search for field to limit the search 
results, and select a CI Type. Click the search icon for the CI Name field 
and select items as needed. You can select multiple items by using 
Ctrl + click or Shift + click. 

6. Click OK to add the selected CIs to the request, under the Impacted 
Configuration Items heading in the Universal CMDB Impact Analysis 
section. The added CIs are shaded in color. Duplicate CIs are not added. 

For each CI, data appears in the CI Name and CI ID columns. If you selected 
CIs using the Browse tab in the Universal CMDB applet, data also appears 
for the View Name, View Type, View Tree Name, and View TQL Name 
columns. Data does not appear for these columns if you selected CIs using 
the Search tab, because the same CI can exist in multiple views.

If adding the CIs to the request would exceed the maximum number 
allowed by the UCMDB_MAX_CI_NUMBER parameter in the server.conf file, 
none of the selected CIs are added.

When you select and add CIs in Universal CMDB to the PPM Center 
request, the CIs are never changed or deleted in Universal CMDB.
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7. As necessary, click the Delete icon to the left of any CI you want to delete.

The Delete icon becomes an undo icon to allow you to undo the pending 
deletion.

8. After the desired CIs are listed in the request, click Submit (or Save for an 
existing request) to add the list of CIs to the request.

If a request with a list of CIs is copied, the list of CIs is not copied to the new request.
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Generating Impact Analysis Reports

To generate an Impact Analysis Report for the CIs that have been added to a 
request:

1. Click the Launch HP Universal CMDB Impact Analysis button in the 
Impacted Configuration Items section of the request. Log in to Universal 
CMDB if prompted to do so. 

An Impact Analysis Report is generated in Universal CMDB.

2. Add the Impact Analysis Report to the request, using the Impact Analysis 
Report field in the Impact & Resource Assessment section of the request.

3. Based on the impact analysis report, make your recommendations in an 
Impact Assessment Report. Add your report to the request using the Impact 
Assessment Report field in the Impact & Resource Assessment section of 
the request.

The Launch HP Release Control button appears if PPM Center is also 
integrated with HP Release Control or HP Change Control Management, as 
described in Chapter 7, Integration of PPM Center with Release Control or 
Change Control Management, on page 241.

Attaching Impact Analysis Report for CIs to a Request in PDF format

In addition to viewing Universal CMDB Impact Analysis Report online by 
clicking the Launch HP Universal CMDB Impact Analysis button on the request 
page, starting from PPM Center version 8.03, you can also attach a Universal 
CMDB Impact Analysis Report for CIs in PDF format to requests in PPM 
Center.

The CIs in a request are available as part of standard Web services for a request. The 
token is REQ_VP_KNTA_UCMDB_CI_LIST. The value of the field represented by this 
token is a comma-separated list of CI IDs.

This integration solution applies to Universal CMDB version 8.06 only.
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New and Modified Settings

To enable this integration, the following settings are modified or introduced:

Universal CMDB Impact Analysis field group: This field group is modified 
to include a new field Report. When the field group is enabled for a request 
type, an Impact Analysis Report field for report attachment will be added to 
any request you create based on the request type.

ksc_download_ucmdb_impactreport: A new system special command 
added for downloading the Universal CMDB Impact Analysis Report. 

The following three optional values are available for advanced 
configuration purpose. You can append them to the special command, 
which will offer you the flexibility of setting filters for the report to be 
generated on the request page. 

o -CATEGORY "<value>"

o -SEVERITY "<value>"

o -LANG "<value>"

If no values are set for the command, the values in server.conf will take 
effect. If no values are found in the server.conf file, the following 
Universal CMDB built-in default values will take effect:

Examples:

o To invoke the special command directly without any parameters:
ksc_download_ucmdb_impactreport

o To invoke the special command with parameters:
ksc_download_ucmdb_impactreport -CATEGORY "change" -
SEVERITY "plan" -LANG "fr"

Parameter Value

Category Change

Severity New

Lang en
Integration of PPM Center with Universal CMDB 153



o To invoke the special command with token parameters:
ksc_download_ucmdb_impactreport -CATEGORY "[REQD.P.<token 
name>]"

New server.conf parameters

Table 5-1 lists new parameters that are added to the server.conf 
configuration file to enable the integration.

Table 5-1. New server.conf parameters

Table 5-2. Universal CMDB category and severity parameters

The parameter names listed in this table are shortened versions of the actual 
names, all of which start with the string com.kintana.core.server. For 
example, the full name of the CMQC_SUPPORT_REQUEST_ID parameter is 
com.kintana.core.server.CMQC_SUPPORT_REQUEST_ID. To add a 
parameter to the server.conf file, you must use its full name.

Parameter Name Brief Description

IMPACT_ANALYSIS_
REPORT_CATEGORY

Sets default category value for the impact 
analysis report, for example, change or 
operation.

IMPACT_ANALYSIS_
REPORT_SEVERITY

Sets default severity value for the impact 
analysis report, for example, MINOR(3). For 
available values, see Table 5-2.

IMPACT_ANALYSIS_
REPORT_LANGUAGE

Sets default language code, for example, fr. 
For supported languages and codes, see 
Table 5-3.

ONLINE_IMPACT_
ANALYSIS_REPORT

Enable or disable online impact analysis 
report. By default, it is enabled.

Category
Severity

ID Code

Change

0 NO CHANGE

1 PLAN

2 NEW

3 CANCEL
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Table 5-3. Languages supported for the Impact Analysis Report

Operation

0 NORMAL

1 WARNING(1)

2 WARNING(2)

3 MINOR(3)

4 MINOR(4)

5 MINOR(5)

6 MINOR(6)

7 MAJOR(7)

8 MAJOR(8)

9 CRITICAL

Description Code

GERMAN de

ENGLISH en 

SPANISH es

FRENCH fr

ITALIAN it

JAPANESE ja

KOREAN ko

BRAZILIAN PORTUGUESE pt

RUSSIAN ru

SIMPLIFIED CHINESE zh

Category
Severity

ID Code
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Basic Configuration Example

For a basic configuration, default values will be used.

1. In PPM Workbench, create a new request header type by going to Demand 
Mgmt > Request Header Type > New Request Header Type. Enable 
Universal CMDB Impact Analysis field group, and set Display attribute for 
both Report and CI List fields to Yes.

2. Create a new request type using the request header type you just created. 
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3. Create a workflow execution step that invokes the special command for 
downloading Universal CMDB Impact Analysis Report: ksc_download_
ucmdb_impactreport.

a. In PPM Workbench, click Configuration > Workflows.

b. In the Workflow Step Sources window, under Workflow Step Sources, 
select Executions, and click New. The Execution window opens.

c. Provide a name for the execution step, select Workflow Step Commands 
for Execution Type field, and click New Cmd. In the New Command 
window, enter the new system special command, and click OK. 

d. Save the Execution step.
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4. Create a new workflow.

a. In the Workflow Workbench window, click New Workflow. In the 
Workflow window that opens, provide a name, and select Requests for 
the Workflow Scope field, and select Yes for Enabled.

b. Go to Layout tab, drag the workflow execution step you just created to 
the Layout window, set Security, configure the transitions. 

c. Save the workflow.

5. In PPM Center, create a Universal CMDB request based on the request 
type you created in step 2 on page 156. 

a. For Workflow field, select the workflow you created earlier. 

b. Under Universal CMDB Impact Analysis section, click Select 
Configuration Items and add CIs for which you need to generate a 
report.
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c. Provide values for other fields as necessary and submit the request. 

6. Open the request and click Execute Now to execute the command.
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7. The Impact Analysis Report is attached to the request in PDF format, with 
automatically generated file name of <YYYYMMDDHHMMSS>.pdf.

8. You may click the PDF report link to view the report.

Advanced Configuration Example

You can choose to pass optional category, severity, and language 
parameters for Universal CMDB Impact Analysis Report to the system special 
command. You can also pass them by token.

1. Create new validations for request type field options.

a. Category
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b. Severity

(Optional) You can create an auto-complete list to implement severity 
cascade on the basis of the above ucmdbSeverity validation.
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c. Language

2. Create a Universal CMDB request type, with three request type fields for 
Category, Severity, and Language.
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3. Create a workflow execution step that invokes the special command for 
downloading Universal CMDB Impact Analysis Report with advanced 
options: 
ksc_download_ucmdb_impactreport -CATEGORY 
"[REQD.P.CATEGORY]" -SEVERITY "[REQD.P.SEVERITY]" -LANG 
"[REQD.P.LANGUAGE]"

4. Create a workflow with the above workflow execution step, configure the 
workflow transitions, and save the workflow.

Enter the command manually. Copying and pasting the command may introduce 
unwanted characters, which may result in potential execution error.
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5. In PPM Center, create a Universal CMDB request using the request type 
you just created. For Workflow field, select the one you created earlier. 
Select configuration items in order to generate an impact analysis report, 
and submit the request.

6. Open the request, execute the first workflow execution step.
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7. Go to the Request Type Fields section of the request, set desired values for 
Category, Severity, and Language fields as filters for the report to be 
generated, then click Execute Now to execute the second workflow 
execution step. 

8. The impact analysis report is attached to Impact Analysis Report field, with 
automatically generated file name of <YYYYMMDDHHMMSS>.pdf.

9. You may click the PDF file link to view the report.

10. (Optional) To generate a report for more CIs, you can click the Redo CI 
Selection workflow step in the Available Actions section to run the 
workflow again.
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6 Integration of PPM Center with Quality 
Center 
Introduction to Integration of PPM Center with Quality Center 

Integrating PPM Center with Quality Center enables you to create Quality 
Center requirements and defects while using PPM Center. This allows users of 
both applications to participate in the processing of defects, change requests, 
and release requests. 

In PPM Center, a request type is a template, and when you create a request, 
you must select a request type. With integration, creating the request also 
automatically creates a defect or requirement in the Quality Center project to 
which the PPM Center request type is mapped as part of configuring the 
integration. For example, a PPM Center request of type Defect could create a 
defect in Quality Center project A, whereas a PPM Center request of type 
RequestForChange could create a requirement in Quality Center project B. 

When an IT manager or business liaison enters a change request or creates a 
release comprising a group of change requests in PPM Center, PPM 
Center–Quality Center integration causes a requirement to be created in 
Quality Center. This informs QA personnel that they should begin the QA 
process.

PPM Center–Quality Center integration allows ongoing synchronization 
between fields such as status fields that have been mapped in a request for 
change in PPM Center and the corresponding defect or requirement in Quality 
Center.

Upon completion of the QA process, the IT manager or business liaison is 
notified via the PPM Dashboard and can complete the deployment process.
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A software tool with wizards is provided to simplify the integration process, 
including mapping fields in PPM Center requests to fields in Quality Center 
projects.

One PPM Server can work with multiple Quality Center projects, even projects 
on multiple Quality Center servers. 

For more information about the benefits of this integration, see Integration of 
PPM Center with HP Quality Center on page 20 and Benefits and 
Functionality of the Integration.

For information about versions supported for integration, see the System 
Requirements and Compatibility Matrix. 

For references to more information about HP Quality Center, see HP Quality 
Center Documentation on page 23.

Benefits and Functionality of the Integration

Integrating PPM Center and Quality Center provides the following benefits to 
users of each application:

Data sharing. The integration allows data sharing between PPM Center 
and Quality Center. Business managers and IT personnel using PPM 
Center gain visibility into how a project is affected by both the quality 
control process and the parameters that are collected in Quality Center. 
They can use Quality Center capabilities when creating requests for 
changes.

Inclusion of Quality Center data in the workflow. The PPM Center 
workflow is a well-defined process that allows IT managers to plan, track, 
and deploy software enhancements. Integration allows you to build your 
own workflows and steps in PPM Center while using fields and data from 
Quality Center. The Quality Center defect resolution capabilities become 
part of the workflow. This makes the quality process an integral and formal 
part of the IT processes.

No software needs to be installed on the Quality Center server to integrate PPM 
Center and Quality Center. However, see the System Requirements and 
Compatibility Matrix. 
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QA-dependent workflow progression. Progress from one step in the 
workflow to the next can be made dependent on progress by the QA team. 
PPM Center shows the IT manager how a project is affected by the quality 
defects that are collected in Quality Center. The IT manager can view the 
information from Quality Center and decide whether a defect has been 
resolved or an enhancement can be deployed. Drill-down capabilities 
between PPM Center and Quality Center provide more detailed data than 
each application provides separately.

Direct activation of processes, and creation of Quality Center 
requirements and defects from PPM Center. Processes can be activated 
by PPM Center—creating a request in PPM Center also creates a defect or 
requirement in Quality Center when the relevant step in the PPM Center 
workflow is activated. When you create a new request in PPM Center of a 
type that is synchronized with Quality Center, you can select the Quality 
Center server on which a corresponding requirement or defect gets created.

Synchronization of mapped field values between PPM Center and 
Quality Center. When fields are mapped between a PPM Center request 
type and a Quality Center defect or requirement, changing the value of a 
mapped field in one application can automatically change the value of the 
corresponding field in the other application. For example, when you 
change a status of a defect to Fixed in PPM Center, one of the provided 
execution steps changes the status in the corresponding Quality Center 
project to Fixed. 

Users can specify that one of the following occurs for a pair of mapped 
fields:

o Changing the field in Quality Center automatically changes the field in 
PPM Center to the same value, that is, Quality Center is dominant for 
the mapped pair.

o Changing the field in PPM Center automatically changes the field in 
Quality Center to the same value, that is, PPM Center is dominant for 
the mapped pair.

o Changing the field in either application automatically changes the field 
in the other application, that is, the mapping is bidirectional.
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Synchronization of defects enables the following:

o Developers can use PPM Center to manage the defect-fixing process, 
while QA personnel continue to use Quality Center.

o Project managers and IT managers can view all the defects in the 
system, whether the defects originated in PPM Center or in Quality 
Center. This helps the managers to decide on content for the next 
release or new requirements and enhancements.

o QA personnel can use Quality Center to manage defects created 
through PPM Center.

Request hierarchy synchronization. The hierarchical structure of 
requirements in Quality Center can be synchronized with the structure of 
the corresponding requests in PPM Center.

Synchronization of the PPM Center Notes field. The integration allows 
you to synchronize the PPM Center Notes to be added on save field with a 
field in Quality Center. When you update the content of the field in a PPM 
Center request, the corresponding field is updated in Quality Center.

ALM - Defect Template with Quality Center Integration Request Type

The PPM Center request type provided for the Quality Center integration is the 
ALM - Defect Template with Quality Center Integration request type. This 
request type uses only the ALM - Defect Template with Quality Center 
Integration workflow, and you cannot choose a different workflow. This 
prevents you from inadvertently using a workflow that is not enabled for 
integration.

The integration also uses the general purpose ALM - Release Management 
request type (see ALM - Release Management Request Type on page 70).

Figure 6-1 shows the Create New ALM - Defect Template with Quality Center 
Integration page that appears when you create a request and select the 

Although you can create new request types from scratch, HP recommends that you 
use the provided request type as a template to create them. In the PPM Workbench, 
you can copy the provided request type and modify the copy. If you create your own 
request types to integrate PPM Center and Quality Center, make sure you use 
workflows that are enabled for integration.
You can also create a new request type with a customized request header type.
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ALM - Defect Template with Quality Center Integration request type. 
Table 6-1 describes the fields in the Defect Template with Quality Center 
Integration request, including some fields that do not appear until the request is 
created or until other conditions are met.

Figure 6-1. ALM - Defect Template with Quality Center Integration request
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Table 6-1. ALM - Defect Template with Quality Center Integration request fields 
(page 1 of 2)

Field Name (*Required) Description

Summary section

Request No. (Added after the request is created) Number of the 
request

Created On (Added after the request is created) Date the 
request was created

*Summary Summary description of the request

Department Department to which the user belongs

Created By User who created the request

*Severity Severity of the defect

Assigned To Developer assigned to work on the defect

Detected in Version Version of the application in which the defect was 
detected

Assigned Group Group responsible for addressing the defect

Defect Priority Priority of the defect

Application Application in which the defect was discovered

Reproducible Option to indicate whether the defect is 
reproducible

Request Status Status of the request

Quality Center Defect Information section a

*Quality Center Instance Quality Center instance that will receive the new 
PPM Center request

*Quality Center Domain Quality Center domain of the working project

*Quality Center Project Quality Center project that is linked with this 
request type

Detected in Quality Center by User in Quality Center who detected the defect
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Defect Number (Added after the defect is created in Quality Center) 
Defect number in Quality Center

Quality Center Defect Status (Added after the defect is created in Quality Center) 
Status of the defect in Quality Center

Quality Center Message

(Read-only. Added after the defect is created in 
Quality Center.) Message indicating whether the 
last update to the request was successfully 
synchronized in the Quality Center defect, or an 
error message if synchronization failed

Quality Center Attachments URL of the attached requirement document

Planned vs. Actual section

Planned Closing Version Version of the application targeted to have the 
defect fix

Closed in Version Version of the application that has the defect fix

Estimated Fix Time (days) Original estimate of the number of days it would 
take to fix the defect

Actual Fix Time (days) Actual number of days it took to fix the defect

Closed on Date the defect was closed in Quality Center

Defect Information section

Detailed Description Detailed description of the defect

Developer Comments Developer comments regarding the defect

a. Fields in the Quality Center Defect Information section remain visible by default but are not used if 
PPM Center is not integrated with HP Quality Center.

Table 6-1. ALM - Defect Template with Quality Center Integration request fields 
(page 2 of 2)

Field Name (*Required) Description

The administrator can remove the Quality Center Defect Information section from 
the request type by removing the Quality Center Defect Information field group from 
the ALM - Defect Template with Quality Center Integration request header type. 
See the HP Demand Management Configuration Guide for details about request 
header types and field groups.
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To submit an ALM - Defect Template with Quality Center Integration request:

1. Log on to PPM Center.

2. From the menu bar, select Create > Request. 

The Create New Request page appears.

3. On the Create New Request page, in the Request Type field, select 
ALM - Defect Template with Quality Center Integration and click Create. 

The Create New ALM - Defect Template with Quality Center Integration 
page appears, displaying the appropriate release request fields.

Required fields have a red asterisk. All other fields are optional, but are 
often helpful when others are reviewing an open request. For information 
concerning a specific field, click the Help icon next to the field (if 
available). 

4. Complete the fields in all sections as appropriate.

The Notes section contains fields where notes and information concerning 
the request can be entered and stored. Typically, when you create a request, 
you do not need to add a note to it. However, add a note if you want to 
convey additional information to the reviewers and processors of the 
request.

In the References section of the request, you can add useful references such 
as a Web-accessible file or a document or file attached from a local 
machine. For more information about adding references, see the  
HP Demand Management User’s Guide. 

5. On the Create New Request page, click Submit. 

The request is submitted. The Request Creation Confirmed page appears.

After submitting the request, on the Request Creation Confirmed page you 
can click the link for the particular request number in the Request # field to 
view the detail page of the newly generated request. 

PPM Center can be configured to allow you to save the request before you submit 
it. To have this feature enabled, see your application administrator.
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When the request is submitted, it is assigned an initial status, such as New. The 
request is then routed along the ALM - Defect Template with Quality Center 
Integration workflow (see ALM - Defect Template with Quality Center 
Integration Workflow on page 176).

Request Header Types

By default, when you create a new request type from a provided one, the new 
request type uses the same request header type as the provided request type 
uses.

When creating a new request type, you can do the following:

Use the supplied request header type as is.

Copy the request header type, customize the copy, and use the customized 
copy in the new request type.

Create a completely new request header type.

If you create a new request header type, add the required integration fields by 
selecting the appropriate field group, as follows:

1. Log on to PPM Center.

2. From the menu bar, select Open > Administration > Open Workbench. 

The PPM Workbench opens.

3. From the shortcut bar, select Demand Mgmt > Request Header Types. 

The Request Header Type Workbench opens. 

4. In the Request Header Type Workbench, click New Request Header Type. 

The Request Header Type window opens.

5. Click Field Groups. 

The Field Groups window lists the available field groups.

Your request header type must include the Quality Center fields that appear in the 
provided request header type. If you customize a request header type, make sure you 
do not delete the Quality Center fields.
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6. To select the appropriate field group:

For a defect header, select the Quality Center Defect Information field 
group.

For a request for change header, select the Quality Center Info field 
group.

ALM - Defect Template with Quality Center Integration Workflow

For integration of PPM Center with Quality Center, ALM provides the 
ALM - Defect Template with Quality Center Integration workflow, which 
includes execution steps to create a defect or requirement in Quality Center. 
You can use this workflow as a template for creating your own workflows.

Although you can create new workflows from scratch, HP recommends that 
you create them from this template. To create a new workflow, you use the 
PPM Workbench to create a copy of a provided workflow, and then modify the 
copy (add, delete, or change its steps) to suit your needs.

The integration also uses the general purpose ALM - Release Request 
workflow to create a release entity that includes several requests for change. 
This workflow can be used for ITIL purposes whether or not PPM Center is 
integrated with other applications. For more information, see ALM - Release 
Request Workflow on page 76.

The ALM - Defect Template with Quality Center Integration workflow is used 
to create a defect and to track how the defect is resolved. See Figure 6-2 and 
workflow step 5, Defect Verification.
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Figure 6-2. ALM - Defect Template with Quality Center Integration workflow

When a request of type ALM - Defect Template with Quality Center 
Integration is created in PPM Center, the first step in the workflow creates a 
defect in Quality Center. Subsequent steps cause the defect status in Quality 
Center to change to Open, Reopen, Fixed or Closed, depending on the stage in 
the PPM Center workflow.

Types of Workflow Steps

As with any PPM Center workflow, the ALM - Defect Template with Quality 
Center Integration workflow can contain the following types of steps:

Decision steps. Steps that require action from the user in order to proceed. 
When the user reaches the decision step, the user sees a set of choices. 
Each choice causes the workflow to proceed in a different manner. For 
example, at one decision step in a workflow, a project manager might be 
offered the choice of either deploying a package or sending it back to QA 
for more testing.
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Condition steps. Steps that determine the direction that the workflow 
takes.

Execution steps. Steps that are automated through PPM Center. For 
example, an execution step might create a requirement or defect in Quality 
Center, execute a script, or run a build.

ALM provides two execution steps that can be used in PPM Center to build a 
workflow for integration of PPM Center with Quality Center. The execution 
steps create a defect or a requirement in Quality Center.

PPM Center-Quality Center Integration Tool

Integration requires installing the PPM Center-Quality Center Integration Tool 
on any Windows machine that can open HTTP connections to the PPM Server 
and to the Quality Center server. This tool enables Quality Center projects for 
integration and maps PPM Center fields to Quality Center fields.

When the user enables a Quality Center project for integration using the PPM 
Center-Quality Center Integration Tool, the tool performs one of the following 
actions:

If the project is new, the tool creates Quality Center lists and adds Quality 
Center workflow scripts to the user’s existing scripts.

If the project already exists, the tool updates some of the Quality Center 
lists so that those lists contain the same values as they would for a new 
project.

The lists and Quality Center scripts create a Quality Center project that can 
work as is with the provided PPM Center components.

As described in the following sections, the integration tool changes the value 
lists and workflow enforcement in a Quality Center project to enable the 
project for integration.
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Changes to Value Lists

For a new project, the integration tool adds two new value lists and adds a new 
value to an existing default value list, as follows:

New Requirement Status list, with the following values: 

o New

o Cancelled

o Closed

o 1-Requirements Setup Completed

o 2-Test Plan Setup Completed

o 3-Test Lab Setup Completed

o 4-Running Tests in Quality Center

o 5-Test Execution Completed

o 6-Running Sanity Tests in Quality Center

o 7-Sanity Testing Completed

New Test Level list, with the following values:

o Functional

o Integration

o Regression

o Sanity

New value of Deleted for the existing Bug Status list

For an existing project, these lists are updated or added as necessary to contain 
the same values as they would for a new project.
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Workflow Enforcement

The PPM Center-Quality Center Integration Tool will update the Quality 
Center project workflow to enforce the following constraints on Quality Center 
entities:

Defect. The user can make only the following status changes:

o Fixed to Closed

o Rejected to Closed

o Fixed to Reopen

Requirement. The user can make only the following status changes: 

o New to 1-Requirements Setup Completed

o 1-Requirements Setup Completed to 2-Test Plan Setup Completed

o 2-Test Plan Setup Completed to 3-Test Lab Setup Completed

o 4-Running Tests in Quality Center to 5-Test Execution Completed

o 6-Running Sanity Tests in Quality Center to 7-Sanity Testing 
Completed

Overview of Installation and Configuration Process

The procedures for configuring PPM Center and Quality Center for integration 
are described in detail in the following sections, and are summarized as 
follows:

If an earlier version of the PPM Center-Quality Center Integration Tool 
was installed, uninstall it.

Install the PPM Center-Quality Center Integration Tool. This tool enables a 
Quality Center project for integration and maps PPM Center fields to 
Quality Center fields in an XML mapping.
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Configure integration of a Quality Center project as follows:

o Use the PPM Center-Quality Center Integration Tool to enable a 
Quality Center project for integration.

o Use the PPM Center-Quality Center Integration Tool to create a 
mapping between PPM Center fields and Quality Center fields.

o Map the Notes field in an existing project.

o Use the PPM Center-Quality Center Integration Tool to deploy the 
mapping to PPM Center and Quality Center.

o Configure a new project if you want to integrate both existing and new 
defects in a Quality Center project.

Configure PPM Center for integration, including specifying server.conf 
parameters.

As necessary, use the request type and workflow provided as templates in 
ALM to create your own PPM Center request types and workflows enabled 
for integration of PPM Center with Quality Center.

Configure request hierarchy synchronization, if desired.

Installing the PPM Center-Quality Center Integration Tool

Integration requires installing the PPM Center-Quality Center Integration Tool 
on a Windows machine that can open HTTP connections to the PPM Server 
and to the Quality Center server.

To install this tool:

1. If an earlier version of the PPM Center-Quality Center Integration Tool 
was installed, uninstall it. See Uninstalling the Integration Tool.
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2. Copy the PPM Center-Quality Center Integration Tool setup.exe file to a 
Windows machine that can open HTTP connections to the PPM Server and 
to the Quality Center server. This file is located in the PPM Server at: 

<PPM_Home>/integration/mac/ppmqcintegrationtool

where <PPM_Home> represents the path where your PPM Center instance is 
installed. For example: xyzserver/E/PPMServer. 

3. Double-click the setup.exe file to launch the InstallShield wizard.

By default, the tool gets installed in the C:/Program Files/
Hewlett-Packard/PPM Center-Quality Center Integration Tool 
directory.

4. Follow the instructions in the wizard. When the installation completes, do 
not launch the PPM Center-Quality Center Integration Tool yet.

Proceed to Configuring a Quality Center Project for the Integration 
on page 183.

Uninstalling the Integration Tool

If you want to uninstall the PPM Center-Quality Center Integration Tool (for 
example, to be able to run the tool from another Windows machine only), 
select Start > Settings > Control Panel > Add/Remove Programs and follow the 
instructions on the screen.

You use the tool to create an initial mapping between PPM Center fields and 
Quality Center fields (or to revise an existing mapping). Unless you need to 
install a later version of the tool, before you uninstall the tool, remember to use 
it to deploy the mapping to both PPM Center and Quality Center 
simultaneously. 
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Configuring a Quality Center Project for the Integration

Before beginning this configuration, verify that Web services are enabled for 
use with PPM Center, as follows: 

1. Stop the PPM Server.

2. Run the following script:

sh ./kConfig.sh 

3. Verify that the ENABLE_WEB_SERVICES parameter in the PPM Center 
server.conf configuration file is set to true. 

4. Restart the PPM Server.

As documented in the following sections, you establish integration of PPM 
Center with Quality Center independently for each Quality Center project as 
needed, using wizards in the PPM Center-Quality Center Integration Tool to 
do the following: 

Enable a Quality Center project for integration

Create the XML mapping file between PPM Center and Quality Center 
fields

Deploy this mapping file to PPM Center and Quality Center

You might also need to manually map the Notes field in a PPM Center request 
to the Quality Center project.

For more information about the steps in this procedure, see the Installation and 
Administration Guide. 
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Enabling a Quality Center Project for the Integration

Use the PPM Center-Quality Center Integration Tool to enable a Quality 
Center project for the integration as described in this section.

To enable a Quality Center project for integration:

1. From the Windows Start menu, select All Programs > Hewlett-Packard > 
PPM Center-Quality Center Integration Tool. 

The main PPM Center-Quality Center Integration Tool window opens.

HP strongly recommends that you enable a project only once, otherwise problems 
might occur in the integration. There is no reason to enable a project twice. You can 
use the integration tool to change the configuration of a project at any time.
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2. Select File > PPM Center Settings. 

The PPM Center Settings window opens.

3. In the Host field, type the URL of the PPM Server.

4. In the Administrator User Name and Administrator Password fields, type 
the PPM Center user name and password.

5. Click Test Connection to test the connection with PPM Center.

6. If a message appears stating that connection was successful, click OK to 
close the PPM Center Settings window, otherwise resolve the connection 
issue.

If the PPM Server is installed in a WAN, use the IP address for the PPM Server, 
for example http://192.60.28.01:8080, rather than its host name, for 
example http://ppmhost:8080. 
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7. In the main PPM Center-Quality Center Integration Tool window, select 
Action > Enable Project. 

The Enable Quality Center Project wizard opens.

8. Click Next to continue.

9. In the Host field, type the URL of the Quality Center server.
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10. Click Next to continue.

11. In the User Name and Password fields, specify the user name and password 
of the Quality Center project administrator. 

12. Click Test Connection to test the connection with Quality Center.

13. If a message appears stating that connection was successful, click OK on 
the message, then click Next. Otherwise resolve the connection issue.
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14. Select a Quality Center domain and project, and specify whether you want 
to map Quality Center defects, requirements, or both. 

If you are enabling defects but not requirements for integration, skip to 
step 17 on page 189.

15. Click Next to continue.

If you are enabling requirements for integration, the following window 
appears.

You can use this window to do the following:

Request notification by email when a PPM Center request creates a 
new Quality Center requirement.

Request notification by email when a PPM Center request updates a 
field in an existing Quality Center requirement.

Synchronize the PPM Center request hierarchy with the Quality Center 
requirement hierarchy. For information about this synchronization, see 
Request Hierarchy Synchronization on page 222.

16. Select the desired checkboxes. 
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17. Click Next to continue.

The wizard displays the user-defined fields in the PPM Center project that 
will be added to the Quality Center project to enable mapping the Quality 
Center fields to PPM Center fields, for defects, requirements, or both, as 
specified in step 14 on page 188.

18. Click Next to continue.

The listed fields are added to the Quality Center project, and the Quality 
Center workflow script is updated to support integration with PPM Center.

Prior to version 7.0, PPM Center was known as Mercury IT Governance Center or 
ITG. For PPM Center version 8.00, field names in Quality Center and in the 
integration tool in the context of Quality Center still use ITG when referring to PPM 
Center.

If the Quality Center project already contains one or more fields with the same 
names, a dialog box asks you whether you want to change the names of the 
added fields. If you select Yes, the added fields will be given different names. If 
you select No, the procedure to enable the project for integration is aborted.
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19. Click Finish to complete enabling the project for integration and close the 
wizard.

If the Quality Center project does not have a workflow script in its repository, a 
dialog box asks you whether you want to create a new one. If you select Yes, a 
new script with support for the integration is added to the Quality Center 
repository. If you select No, the script file is not created. 
If the project is not new and its script files have been previously customized, 
select No and manually merge the customized scripts with the scripts that the 
wizard adds automatically, which are located in the installation directory of the 
PPM Center-Quality Center Integration Tool.
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Creating the Mapping Between PPM Center and Quality Center Fields

After you enable a Quality Center project for the integration, you use the PPM 
Center-Quality Center Integration Tool to map a particular PPM Center 
request type to a Quality Center defect or requirement and to specify the 
desired mapping between the PPM Center fields and the Quality Center fields.

To create the mapping:

1. In the left pane of the PPM Center-Quality Center Integration Tool, expand 
the tree until the child node at the lowest level (defect, requirement, or 
both) is visible.

For information about the provided default mappings, see Default Quality 
Center–PPM Center Field Mappings on page 231.
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2. Click the child node you want to map and select Action > Add Mapping (or 
right-click the node you want to map and click Add Mapping).

The Map Fields wizard opens.

3. Click Next to continue.

4. In the User Name and Password fields, type the user name and password of 
the Quality Center administrator.
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5. Click Next to continue.

The PPM Center Request Type field appears with a drop-down list.

6. Click the arrow of the drop-down list to display a list of all the PPM Center 
request types that can be mapped to a Quality Center defect or requirement 
(depending on which you selected in step 2 on page 192).

As provided by HP, the only PPM Center request type available to map to a 
Quality Center defect is the ALM - Defect Template with Quality Center 
Integration request type.

As provided by HP, the only PPM Center request types available to map to 
a Quality Center requirement are the following:

ALM - Release Management

ALM - Request for Change (RFC)

7. Select the request type in PPM Center that is to be mapped to the Quality 
Center defect or requirement.
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8. If you are mapping the request type to a defect, but not if you are mapping 
the request type to a requirement, the window includes the Default Mapping 
checkbox. 

If this is the first mapping you are creating from a PPM Center request type 
to a Quality Center defect for the project, the checkbox is selected and 
disabled so that you cannot clear the checkbox. 

If this is not the first such mapping, the checkbox is cleared and enabled. 
Select the checkbox if you want the request type you are now mapping to 
become the default PPM Center request type for Quality Center defects for 
the project. 

9. Click Next to continue.

From the integration tool, the wizard displays the default mapping between 
the Quality Center fields and PPM Center fields for the request type you 
selected. In this Map Fields window, the fields map either a PPM Center 
request type for defects to a Quality Center defect, or a PPM Center request 
type for changes to a Quality Center requirement.

The Quality Center Field column displays the DB field name (the name of 
the column in the database) in parentheses.

The PPM Center Field column displays the PPM Center token in 
parentheses.
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The Override column specifies which field, if any, is the dominant field for 
a pair. The Override column can have one of the following values for any 
pair of mapped fields (row):

QC. In this case, changing the value of the Quality Center field causes 
the same change to be applied to the mapped PPM Center field. That is, 
the Quality Center field is dominant. If the value in the PPM Center 
field is changed, the value in the Quality Center field is not affected.

PPM. In this case, changing the value of the PPM Center field causes 
the same change to be applied to the mapped Quality Center field. That 
is, the PPM Center field is dominant. If the value in the Quality Center 
field is changed, the value in the PPM Center field is not affected.

BIDIRECTIONAL. In this case, changing the value of the field in either 
PPM Center or Quality Center causes the same change to be applied to 
the mapped field in the other application.

10. If you want to change which field, if any, is dominant for a field mapping, 
click the value in the Override column for the field mapping of interest, and 
select another value from the list that appears.

11. If you want to add a pair of fields to the mapping, do the following:

a. Click Add. 

The Add Field window opens.

b. In Quality Center Field and PPM Center Field, select the fields you want 
to map to each other.

c. Click OK. 

The pair of fields is added to the mapping and appears in the list.

If the mapped fields in a pair have different sets of valid values, you must resolve 
the differences so that a change to one field can update the other. See Resolving 
Lists of Valid Values on page 198.
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12. If you want to remove a pair of fields from the mapping, do the following:

a. Click a line to select the pair.

b. Click Remove. 

c. When the application asks whether you want to delete the selected line 
or lines, click Yes. 

13. Click Next to continue.
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14. Click Finish to save the mapping and close the wizard.

The new mapping is displayed in the PPM Center-Quality Center 
Integration Tool. (In the example, expand the defect list.)

15. By default, a local copy of the mapping file (ITGQCIntegration.xml) is 
saved in the Windows directory in which you installed the PPM 
Center-Quality Center Integration Tool. As discussed later, you will use 
the tool to deploy the mapping file to the PPM Server and the Quality 
Center server. Then the integration can operate without any dependency on 
the local Windows machine.

If you want to save the XML file elsewhere, select File > Save To and 
specify the location.

If you want to open an XML file stored in another location, click 
File > Open. 

16. Click File > Exit to close the PPM Center-Quality Center Integration Tool.
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Resolving Lists of Valid Values

This section describes how to resolve differences between the sets of valid 
values for a pair of mapped fields, so that a change to one field correctly 
updates the other.

To open the mapping file and access the Map Value Lists window:

1. Open the mapping file as described in Viewing and Changing a Mapping 
on page 210. 

2. Select the row for the pair of fields of interest and click Map Value Lists. 

The Map Value Lists window opens, displaying the lists of valid values for 
each field in the pair.

Resolve the differences between the sets of valid values based on which of the 
following three cases applies.

Case One

If you created a new user-defined field in Quality Center and mapped the field 
to a PPM Center field that has a list of values, create a new Quality Center list 
of valid values from the PPM Center list, as follows:

1. Select the Create a new list in Quality Center... option in the Map Values 
List window.

2. In the List Name field, specify a name for the list or accept the default.

3. Click OK. 

A new Quality Center value list containing the PPM Center values is 
created and associated with the Quality Center field.

Some field pairs are automatically mapped and their mappings cannot be 
changed.
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Case Two

If the fields in the pair have different sets of values and some records in the 
Quality Center project already use the current list values, but from now on you 
want to use the values that appear in the PPM Center list, add the PPM Center 
values to the Quality Center list, as follows:

1. Select the Add the PPM Center values to the existing Quality Center list 
option in the Map Values List window.

2. Click OK. 

The Quality Center value list now includes the PPM Center values as well 
as the original Quality Center values.

Case Three

If both fields in the pair already have lists of values that you need to map or 
remap, do so as follows:

1. Select the Map Values option in the Map Values List window.

2. Select a value in the Quality Center list, select the value in the PPM Center 
list to which you want to map it, and click the right-arrow button. 

The pair of mapped values appears in the right pane of the Map Value Lists 
window. For example, if the value representing lowest impact in the 
Quality Center field is Enhancement and the value representing lowest 
impact in the PPM Center field is 1-Low, map the two values as shown in 
the following figure. 
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Between the QC and PPM columns in the right pane, the mapping displays 
one of the following:

--> if the Override column for the pair of fields is set to QC 

<-- if the Override column for the pair of fields is set to PPM 

<--> if the Override column for the pair of fields is set to 
BIDIRECTIONAL 

3. Repeat step 2 for all the values that require mapping. 

You must map all the values in the Quality Center list if Quality Center 
is dominant for that field pair, as indicated by QC in the Override 
column in the Map Fields window and by --> between the QC and PPM 
columns in the right pane of the Map Value Lists window. 

Similarly, you must map all the values in the PPM Center list if PPM 
Center is dominant for that field pair, as indicated by PPM in the 
Override column in the Map Fields window and by <-- between the QC 
and PPM columns in the right pane of the Map Value Lists window. 

You must map all the values in both lists if neither field of the pair is 
dominant, as indicated by BIDIRECTIONAL in the Override column in 
the Map Fields window and by <--> between the QC and PPM columns 
in the right pane of the Map Value Lists window.

If you map two or more values in one list to one value in the other list, you 
must select a checkbox in the Default column to indicate which mapping 
prevails. 
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Consider the example in the following figure, where the two value lists are 
of different lengths and the mapping is BIDIRECTIONAL. 

In this example, you must do the following:

a. Map two or more values in one list to a single value in the other list. 
Here, both the values Critical and Urgent for the field in Quality Center 
have been mapped to a value of Urgent for the field in PPM Center.

b. Select the appropriate Default checkbox to eliminate ambiguity as to 
which pair will be used to map the values. In this example, if the field 
in PPM Center changes to a value of Urgent, the value of the field in 
Quality Center becomes Critical, based on the selected Default pair of 
values. If the second checkbox, for which the PPM Center value is also 
Urgent, had been chosen as the default instead, when the field in PPM 
Center changes to a value of Urgent, the value of the field in Quality 
Center would become Urgent. 

4. Click OK. 

The PPM Center values and Quality Center values for the field become 
mapped as you have specified.
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Mapping the Notes Field in PPM Center to an Existing Project

When you enable a new Quality Center project for integration, the integration 
tool attempts to create new fields in the Quality Center project to correspond to 
the Notes to be added on save field for the PPM Center request. When you 
update the content of this field in a PPM Center request, the corresponding 
field is updated in Quality Center. 

When you enable a new project, the new fields are named as follows:

For a defect, the added field in the Defects table is called BG_USER_<XX>, 
for example BG_USER_25. 

For a requirement, the added field in the Requirements table is called  
RQ_USER_<XX>, for example RQ_USER_26. 

Since the Quality Center fields are memo fields and there can be no more than 
three user-defined memo fields per table, the attempt to map Notes to memo 
fields may fail. If the attempt fails, you cannot use the integration tool to map 
the Notes to be added on save field. Instead, you must add the memo fields to 
the project manually, and edit the XML mapping file by adding one of the 
following to the appropriate mapping file, using the example:

For defects:

<param name="BUG_ITG_NOTES">BG_USER_25</param>

For requirements:

<param name="REQ_ITG_NOTES">RQ_USER_26</param>

If you enable an existing project that already includes some user-defined memo fields, 
the added fields may have different names.
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Deploying the Mapping File to PPM Center and Quality Center

After you have completed the mapping, use the PPM Center-Quality Center 
Integration Tool to deploy the XML mapping file (ITGQCIntegration.xml) 
to PPM Center and to Quality Center.

To deploy the XML mapping file to PPM Center and Quality Center:

1. Verify that the PPM Center server.conf parameters are as specified in 
step 2 on page 206. Set the ENABLE_QUALITY_CENTER_INTEGRATION 
parameter to true. 

2. In the main window of the PPM Center-Quality Center Integration Tool, 
select File > Deploy to Centers. 

The Deploy Configuration File to Centers window opens, listing the URLs 
of the PPM Center and Quality Center servers to which the mapping file 
will be deployed.

At certain times, you might need to manually edit or back up the XML mapping file. 
When you created the XML mapping file, it was stored either in the directory in which 
you installed the integration tool or in another directory that you specified (see step 15 
on page 197). If you do not know where the file is located, check the Windows 
registry. The path in the registry is HKEY_LOCAL_MACHINE\SOFTWARE\
Hewlett-Packard\PPM Center-Quality Center Integration Tool. 
Remember to redeploy the mapping file to both PPM Center and Quality Center.
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3. Click Deploy. 

The tool starts the deployment process. If any errors occur during 
deployment, a message is displayed in the window.

4. When the deployment completes, a message indicating that deployment 
completed successfully is added to the Deploy Configuration File to 
Centers window.

5. Click OK to close the window.

On the PPM Server, the mapping file is deployed to the <PPM_Home>/conf 
directory, where <PPM_Home> represents the path where the PPM Center 
instance is installed. 

On the Quality Center server (or servers), the mapping file is deployed to the 
<QC_Home>/repository/sa/DomsInfo/BTO directory, where <QC_Home> 
represents the path where Quality Center is installed.

For information about changing and otherwise maintaining existing mappings, 
see Managing Existing Mappings on page 207.

This completes creating and deploying the mapping file. To configure PPM 
Center for the integration, proceed to Configuring PPM Center for the 
Integration.
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Configuring PPM Center for the Integration

Before beginning to configure the integration as described in the following 
sections, make sure that ALM has been installed and initially configured as 
described in Chapter 2, Installing and Setting Up ALM Software, on page 25.

Establishing Server Connections for Supported Versions

Make sure that the HTTP port is open between the PPM Server and Quality 
Center machines. 

Verify that a supported version of Quality Center is installed and running (see 
the System Requirements and Compatibility Matrix).

Configuring server.conf Parameters in PPM Center

Add and specify (or, if present, just specify) the parameters related to Quality 
Center integration to the PPM Center server.conf configuration file, as 
follows:

1. Stop the PPM Server.

For more information about the steps in this procedure, see the Installation and 
Administration Guide. 
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2. Run the following script: 

sh ./kConfig.sh 

Set the parameters and values as shown in the following table. (All 
parameter names begin with com.kintana.core.server. but that is not 
shown in the table.)

3. Restart the PPM Server.

For information about using the integration, see Using the Integration of PPM 
Center with Quality Center on page 215.

Parameter Value

ENABLE_QUALITY_
CENTER_INTEGRATION

Set this parameter to false if an XML 
mapping file has not been generated and 
deployed to PPM Center and Quality Center.
Set this parameter to true if an XML 
mapping file has been generated and 
deployed to PPM Center and Quality Center, 
so that integration can be enabled. If a 
mapping file has not been deployed and you 
set this parameter to true, the PPM Server 
will not restart.
This parameter controls whether PPM 
Center attempts to send information to 
Quality Center. (Even if this parameter is set 
to false, Quality Center sends information 
to PPM Center.)

BASE_URL
(already present in 
server.conf)

The URL of the PPM Server. By default, 
contains the host name of the PPM Server, 
for example, http://ppmhost:8080. 
However, if the PPM Server is installed in a 
WAN, use the IP address of the PPM 
Server, for example,  
http://192.60.80.01:8080, rather 
than its host name.

ENABLE_QUALITY_
CENTER_METRICS_SYNC

Always set this parameter to false. It 
does not apply to ALM.
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Managing Existing Mappings

After you have configured PPM Center and Quality Center for integration, you 
can use the integration tool to make changes to the configuration.

You can change the configuration for a request type mapping or for an entire 
Quality Center project. When you change a mapping for a project, the changes 
apply to all the request types mapped to the project. For example, if you delete 
the mapping for a project, the mapping for all of the project’s mapped request 
types is also deleted.

As described in the following sections, you can do the following:

Delete a mapping

Disable a mapping

Re-enable a previously disabled mapping

View and change a mapping

Change the default request type

Enable and disable request hierarchy synchronization

Enable and disable email notification on requirement creation

Enable and disable email notification on requirement update

Remember to redeploy the mapping file to PPM Center and Quality Center after any 
mapping revision described in the following sections. See Deploying the Mapping File 
to PPM Center and Quality Center on page 203.
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Deleting a Mapping

When you delete a mapping, the connection between the corresponding fields 
in PPM Center and Quality Center is removed, and updating a field in one 
application no longer causes an update in the other. 

To delete a mapping:

1. Right-click the project or request type of interest and select Delete 
Mapping. 

The tool asks whether you want to delete the mapping.

2. Click Yes. 

If you later want the applications to update each other, you will need to create a new 
mapping.
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Disabling and Re-Enabling a Mapping

When you disable a mapping, the mapping is not deleted, but creating a request 
in PPM Center does not create a defect or requirement in the Quality Center 
project, and creating a defect in Quality Center does not create a request in 
PPM Center. In addition, updating a field in one application does not update 
the field to which it is mapped in the other application.

To disable the mapping between a request type and a defect or requirement:

1. Right-click the project or request type of interest and select Disable 
Mapping. 

The tool asks whether you want to disable the mapping.

2. Click Yes. 

To enable a mapping that was previously disabled, right-click the project or 
request type and select Enable Mapping. 
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Viewing and Changing a Mapping

To view a mapping and make changes to the mapping:

1. Right-click the request type of interest and select Mappings. 

The Map Fields window opens.
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2. If the Mapping tab is not already selected, select it to display the mapping.

3. Use this tab to change the mapping in the same way you created the 
original mapping. See Creating the Mapping Between PPM Center and 
Quality Center Fields on page 191.

Changing the Default Request Type for a Quality Center Defect

To change the default request type used to create a request in PPM Center 
when you create a defect in Quality Center, right-click the request type you 
want to use as the default, and select Make Default. 
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Enabling and Disabling Request Hierarchy Synchronization

You can enable or disable the request hierarchy synchronization between a 
PPM Center request and a Quality Center requirement.

To enable the synchronization:

1. Right-click requirement. 

2. If the Synchronize Request Hierarchy option is not selected (has no check 
mark), click it to select the option. 

To disable the synchronization:

1. Right-click requirement. 

2. If the Synchronize Request Hierarchy option is selected (has a check mark), 
click it to clear the option. 

For information about request hierarchy synchronization, see Request 
Hierarchy Synchronization on page 222.
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Enabling and Disabling Email Notification on Requirement Creation

You can enable or disable sending an automatic email notification when a 
requirement is created by the integration.

To enable the email notification for requirement creation:

1. Right-click requirement. 

2. If the Notify When Created option is not selected (has no check mark), click 
it to select the option. 

To disable the email notification for requirement creation:

1. Right-click requirement. 

2. If the Notify When Created option is selected (has a check mark), click it to 
clear the option. 
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Enabling and Disabling Email Notification on Requirement Update

You can enable or disable sending an automatic email notification when a 
requirement is updated by the integration.

You can enable or disable sending an automatic email notification when a 
requirement is created by the integration.

To enable the email notification for requirement update:

1. Right-click requirement. 

2. If the Notify When Update option is not selected (has no check mark), click 
it to select the option. 

To disable the email notification for requirement update:

1. Right-click requirement. 

2. If the Notify When Update option is selected (has a check mark), click it to 
clear the option. 
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Using the Integration of PPM Center with Quality Center
This section describes how the request types and workflows provided in ALM 
support integration of PPM Center with Quality Center.

Steps in PPM Center Workflows that Involve Integration with Quality Center

Several workflows and subworkflows provided in ALM have steps that are 
related to the integration of PPM Center with Quality Center, as follows:

The ALM - Request For Change workflow (see ALM - Request For 
Change Workflow on page 43) calls the following subworkflows at the 
indicated steps:

o At step 17, the ALM - Request For Change workflow calls the Plan 
Tests Sub WF (see ALM - Plan Tests Sub WF Subworkflow 
on page 54).

In this subworkflow, step 1, Quality Process Mode, determines whether 
the test planning will be done manually or using integration of PPM 
Center with Quality Center. If integration is to be used, the following 
additional subworkflow steps relate to the integration:

Step 4, Quality Process Entry

Step 5, Generate Requirement in Quality Center

Step 6. Quality Center Failure

Step 7, Quality Center Requirements Setup

Step 8, Quality Center Test Plan Setup

Step 9, Quality Center Test Lab Setup

o At step 22, the ALM - Request For Change workflow calls the Deploy 
and Test Changes Sub WF (see ALM - Deploy and Test Changes 
Sub WF Subworkflow on page 56).

In this subworkflow, step 3, Quality Process Mode, determines whether 
the testing will be done manually or using integration of PPM Center 
with Quality Center. If integration is to be used, the following 
additional subworkflow step relates to the integration:

Step 5, Quality Center Test Execution
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The ALM - Defect Template with Quality Center Integration workflow 
generates a defect or requirement in Quality Center as soon as a request of 
the associated type is created. See ALM - Defect Template with Quality 
Center Integration Workflow on page 176.

The ALM - Release Request workflow (see ALM - Release Request 
Workflow on page 76), includes the following steps that relate to 
integration of PPM Center with Quality Center for the release management 
process:

o Step 3, Integrate with Quality Center?

o Step 4, Quality Process Entry

o Step 5, Create Release Requirement in Quality Center

o Step 6, Quality Center Failure

Configuring Request Types and Workflows for the Integration

This section provides guidelines on how to build request types and workflows 
that support the integration of PPM Center with Quality Center.

To enable integration between PPM Center requests and Quality Center 
projects, you must ensure that the request types and projects have the necessary 
matching fields and that the workflows use steps that support integration. 

ALM provides request types and workflows that use Quality Center 
capabilities, and the workflows include the required steps. You can create 
integration-enabled request types and workflows in any of the following ways:

By using the PPM Workbench to copy the provided ALM request types 
and workflows, which already contain the components required for 
integration, and changing the copies as needed. This is often the easiest 
approach.

By creating new request types and workflows that incorporate the 
components required for integration.

By customizing your existing PPM Center request types and workflows by 
adding the components required for integration.
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After you configure the required request types and workflows, you use the 
PPM Center-Quality Center Integration Tool to map the PPM Center fields and 
their valid values to the Quality Center fields and their valid values (see 
Creating the Mapping Between PPM Center and Quality Center Fields 
on page 191).

For detailed information about configuring request types and workflows, see 
the HP Demand Management Configuration Guide as necessary.

Configuring Request Types

The guidelines to configure a request type for integration are as follows:

Make sure the request header type for the request type includes the Quality 
Center Info field group. Only request types with this field group can be 
mapped to Quality Center defects or requirements. See Request Header 
Types on page 175.

Decide which request type to map to each Quality Center project, then 
make sure that the request type and project have the required mapping of 
corresponding fields.

Make sure that each pair of mapped fields includes the required valid 
values. For example, if a Quality Center field contains a lookup list, make 
sure that the corresponding field in the PPM Center request accepts those 
values. If you update a field in one application with a value that is not valid 
in the other application, the field in that other application will not be 
updated. 

For details, see Resolving Lists of Valid Values on page 198.

By default, the Quality Center Info field group is included in the ALM - Request for 
Change (RFC) request type and in the ALM - Release Management request type, 
but not in the ALM - Defect Template with Quality Center Integration request type.

Quality Center workflows can limit the changes a user can make to a field. For 
example, a script might specify that at a certain point in the Quality Center 
workflow, the user cannot change the status from Open to Closed.
If you update a PPM Center field with a value that is valid in the corresponding 
Quality Center field, the Quality Center field will be updated, even if it should not 
be updated according to the Quality Center workflow script.
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Configuring Workflows

The guidelines to configure a workflow for integration are as follows (refer to 
the HP Demand Management Configuration Guide for details as necessary):

Make sure the workflow includes execution steps and decision steps that 
enable the integration of PPM Center with Quality Center. The workflows 
provided by ALM include such steps. 

If you need to customize a workflow to create a defect or a requirement, 
HP recommends using the execution steps that are included in the 
ALM - Defect Template with Quality Center Integration workflow, instead 
of building the steps yourself. To create defects or requirements in Quality 
Center, your workflow must include one of the following execution steps 
that uses the stated special command:

o To create defects, the ALM - Create QC Defect execution step with the 
ksc_create_defect_in_QC special command

o To create requirements, the ALM - Create QC Requirement execution 
step with the ksc_create_requirement_in_QC special command

In the Properties tab of the workflow execution step, specify a value in the 
Request Status field that is valid for Quality Center, for example, 
1-Requirements Setup Completed when creating a requirement.

Once an execution step has created a requirement or defect in Quality 
Center, then every time the PPM Center request status changes, the Quality 
Center requirement or defect status also changes if the same PPM Center 
status exists for the Quality Center requirement or defect. For example, if 
the PPM Center request status changes to Open, the Quality Center 
requirement or defect status will also change to Open, as long as Open is 
one of the values allowed in the status field of the requirement or defect.

For more information about configuring workflow steps, see the  
HP Demand Management Configuration Guide. 

A PPM Center decision step that depends on Quality Center (that is, a PPM 
Center request that is supposed to be updated by a Quality Center status change) 
can have its status changed in Quality Center only by a user who has 
Administrator rights.
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When a PPM Center request is integrated with a Quality Center project, 
you can use a change in the Quality Center status to cause the PPM Center 
request to advance through an active decision step to the next step in the 
associated PPM Center workflow. For example, when the QA manager sets 
the status of a Quality Center project to indicate that test planning is 
complete, the corresponding request in PPM Center can automatically 
advance from the step in the associated workflow awaiting that 
notification.

Conversely, whenever the status of a PPM Center request changes, PPM 
Center notifies Quality Center, and (assuming the new status is valid in 
Quality Center), Quality Center users can take appropriate action such as 
starting tests.

To enable this functionality, you must design the workflow decision steps 
such that the following three items have the same values:

o Quality Center status that will trigger the advancement in the PPM 
Center workflow.

o Transition name (which is specified as the Meaning field of the 
validation value for the workflow step source) for the active decision 
step in the PPM Center workflow.

HP recommends that you give the Meaning field of the transition a 
value that is unique to this transition, that is, a value that does not exist 
anywhere else in the workflow. When this value becomes assigned to 
the ITG Status field in Quality Center, the PPM Center workflow 
advances if the value matches a valid transition in an active workflow 
step. If the workflow has more than one active step and the Meaning is 
not unique, the workflow could advance to an unintended step.

After Quality Center sends an update to PPM Center, Quality Center waits for a 
response, and the Quality Center record remains locked until Quality Center 
receives the response. Meanwhile, if PPM Center advances to the next workflow 
step and attempts, for example, to update (synchronize) Quality Center with a 
new request status, Quality Center rejects the update since the record is locked.
Therefore, a PPM Center workflow should not contain successive steps such that 
the first causes a PPM Center request to advance based on a change in Quality 
Center status, and the second causes PPM Center to attempt to update Quality 
Center. Make sure there is an intervening step between two such steps.
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o Request Status field in the destination step in the PPM Center 
workflow.

If the Quality Center status does not appear in the list of valid request status 
values in PPM Center, PPM Center sends an error message to Quality 
Center, the Quality Center status reverts to its previous value, and the PPM 
Center workflow does not advance.

For example, in the following portion of the ALM - Plan Tests Sub WF 
subworkflow, the transition from step 7 to step 8 is called 1-Requirements 
Setup Completed. 

If you double-click step 8 (the destination step), the Properties tab of the 
Workflow Step window shows that the value in the Request Status field is 
also 1-Requirements Setup Completed. 
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All three items—the Quality Center status, the transition, and the Request 
Status field of the destination step—have the same value. Therefore, if the 
QA team changes the Quality Center status to 1-Requirements Setup 
Completed when step 7 is active, the workflow will advance to step 8. 

If you need to change the value of the Request Status field of the 
destination step, in the Properties tab of the Workflow Step window for 
that step, specify the new value in the Request Status field and click OK. 

If you need to change the Meaning field that defines the transition name, 
right-click the preceding decision step and select Edit Source; in the 
Validation section of the Decision window, click Open; click the validation 
value (row) of interest and click Edit; specify the new value in the Meaning 
field; and click OK to close all open windows. For more detailed 
information, see the HP Demand Management Configuration Guide. 
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Request Hierarchy Synchronization

The integration of PPM Center with Quality Center allows you to synchronize 
the hierarchies of requests in PPM Center and requirements in Quality Center, 
as in the following example sequence:

1. A PPM Center request named Request A is created.

2. With integration, a corresponding Requirement A is automatically created 
in Quality Center.

3. A PPM Center request named Request B is created with a reference to 
Request A indicating that Request A is the parent of Request B.

4. A corresponding Requirement B is automatically created in Quality Center. 
If request hierarchy synchronization is implemented, since Request B is the 
child of Request A, Requirement B is automatically created as the child of 
Requirement A.

If you later delete the relationship (the reference) between Request A and 
Request B in PPM Center, the relationship between Requirement A and 
Requirement B is automatically deleted in Quality Center. Instead of being a 
child of Requirement A, Requirement B becomes a child of the Quality Center 
default root requirement for PPM Center requests.

If you synchronize hierarchies, any changes you make to the hierarchy in PPM 
Center are automatically reflected in the hierarchy of the Quality Center 
project. Thus, changes made to a Quality Center project can be overridden later 
by updates to the corresponding PPM Center request.

PPM Center allows a request to have multiple parents, but Quality Center 
limits a requirement to only one parent. If a PPM Center request has multiple 
parents, Quality Center does not duplicate that hierarchy in the project, and 
PPM Center displays a message indicating a problem with hierarchy 
synchronization.

If Requirement A does not exist in Quality Center, creating a reference in PPM 
Center from Request B to Request A has no effect on Quality Center.
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Enabling Request Hierarchy Synchronization

Synchronization between the PPM Center request type and the Quality Center 
project must be enabled as follows, depending on whether a mapping has been 
created:

If a mapping has not been created between the Quality Center requirement 
and the PPM Center request type, as you use the PPM Center-Quality 
Center Integration Tool to enable the project for integration, select the 
checkbox in the Request Hierarchy section in the Enable Quality Center 
Project wizard. See step 15 on page 188.

If a mapping has been created, in the PPM Center-Quality Center 
Integration Tool, right-click the request type and select Synchronize 
Request Hierarchy. 

Example of Request Hierarchy Synchronization

The following screen shows a Quality Center requirement called 
Req. Hierarchy with three requirements. 

Each requirement is mapped to a PPM Center request of type ALM - Request 
for Change (RFC). The request numbers in PPM Center are shown in the 
ITG Request Id column. When created, the RFC Summary fields of the requests 
were specified as Parent Requirement, Child Requirement, and Grand-child 
Requirement to indicate their intended hierarchy (first in PPM Center and then 
automatically as requirements in Quality Center) after the relationships among 
the requests are established in PPM Center.

When you open a request, you can add a different request in the References 
section and specify the relationship of the reference request to the request you 
opened. For example, the reference request can be a child or a parent of the 
open request.
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For the example, you could use any one of the following methods to establish 
the relationships among requests, which would then automatically synchronize 
the relationships among the associated Quality Center requirements:

Open request 30002 and make it the parent of request 30003, and then open 
request 30003 and make it the parent of request 30004. 

Open request 30003 and make it the child of request 30002, and then open 
request 30004 and make it the child of request 30003. 

Open only request 30003 and make it both the child of request 30002 and 
the parent of request 30004. This method is slightly quicker and is used in 
the following procedure.

To create the relationships between the requests, in PPM Center:

1. Select and open the request for which you want to define one or more 
relationships.

In the example, open request 30003.
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2. In the Reference Additions section of the request, in the New Reference 
drop-down list, select Request (Existing). 
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3. Click Add. 

The Add Reference: Request window opens.
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4. Specify data about the request to be related to the open request, and click 
Search. 

In this example, type 30002 in the Request # field and click Search. 

If the search is successful, the following window opens.

The window allows you to select from the search results which requests 
will be references (in the example, 30002 is the only request found using 
the specified search criteria), and to select an option to specify the 
relationship the reference request (or requests) will have to the open 
request (30003 in the example).

5. In the Request Search Results section, select the checkbox for the request 
that is to be made a reference.

6. In the upper section of the window, select the option for the relationship 
you want this reference request to have to the open request. 

In this example, select Parent of this Request because you want reference 
request 30002 to be the parent of open request 30003.

7. Click Add. 

The reference request and its relationship are added to the References to be 
added on Save text box in the open request.
Integration of PPM Center with Quality Center 227



8. Repeat step 2 on page 225 through step 7 (or step 3 on page 226 through 
step 7) as necessary to create parent and child relationships with additional 
requests.
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In this example, follow step 3 through step 7, but in step 4 type 30004 in 
the Request # field to make that request the one to reference, and in step 6 
select Child of this Request because you want reference request 30004 to be 
the child of open request 30003.
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9. Click Save. 

The reference requests with which you have defined relationships are listed 
in the References section, Requests subsection of the open request. 
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In Quality Center, the requirements (rows) are now reorganized and 
indented to reflect the relationship hierarchy you specified among the PPM 
Center requests.

Default Quality Center–PPM Center Field Mappings

This section lists the default field mappings that are available when integrating 
the following:

The Requirements Module in Quality Center with the ALM - Request for 
Change (RFC) request type in PPM Center (see Default Field Mappings 
for Quality Center Requirements)

The Defects Module in Quality Center with the ALM - Defect Template 
with Quality Center Integration request type in PPM Center (see Default 
Field Mappings for Quality Center Defects on page 236)
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Default Field Mappings for Quality Center Requirements

This section summarizes the default field mappings for the integration between 
the Requirements Module in Quality Center and the ALM - Request for 
Change (RFC) request type in PPM Center. This section includes the following 
tables:

Table 6-2 describes the default requirement mappings that can be 
modified. The Override column indicates which field is dominant by 
default—PPM Center (if set to PPM), Quality Center (if set to QC), or 
neither (if set to BIDIRECTIONAL). For more information, see step 9 
on page 194.

Table 6-3 on page 234 describes the fields that were added to Quality 
Center requirements to support integration with PPM Center requests. 
These fields should not be modified (except for their Labels, as desired).

Table 6-4 on page 235 describes the fields that were added to PPM Center 
requests to support integration with Quality Center requirements. These 
fields should not be modified (except for their Field Prompts, as desired).

Table 6-2. Requirements mapping you can modify (page 1 of 2)

Quality Center Field Name,
Database ID, 
and Field Type

PPM Center Field Name,
Database ID a, 
and Field Type

Override

Priority
RQ_REQ_PRIORITY
Enumeration 

RFC Priority
PRIORITY_CODE
Drop-down list 

PPM

Author b

RQ_REQ_AUTHOR
User list 

Created By
CREATED_BY
User list 

PPM
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ITG Request Status c, d

RQ_USER_XX e

Enumeration 

RFC Status c

STATUS_ID
List 

PPM c

Quality Center Status d

KNTA_QC_REQUIREMENT_STATUS
Text (300) 

QC d

Name
RQ_REQ_NAME
Text (255) 

RFC Summary
DESCRIPTION
Text (200)

PPM

ITG Request Description
RQ_USER_XX e

Memo

RFC Description
RFC_DESCRIPTION
Text (1800)

PPM

Assigned To
RQ_USER_XX e

User list

Quality Center Assigned To User
KNTA_QC_ASSIGNED_TO
Quality Center user list (uses a special 
validation that retrieves the Quality 
Center user list for a specific project)

PPM

a. The listed PPM Center database IDs are the same as in the PPM Workbench. The exact database IDs 
are displayed by the integration tool.

b. The Author field in Quality Center displays the name of the user who created the request in PPM Center. 
Quality Center can accept any name, but PPM Center cannot. If you configure this field to be 
bidirectionally updateable and a user selects a user name in Quality Center that does not exist in PPM 
Center, the operation will fail. User name lists must therefore be synchronized. 

c. When the RFC Status field is updated in PPM Center, the new status is sent to Quality Center. If the new 
status matches one of the requirement statuses in Quality Center, the ITG Request Status field in Quality 
Center is updated; if not, the update is ignored by Quality Center. 

d. When the status of a requirement is updated in Quality Center, the Quality Center Status field in PPM 
Center is correspondingly updated if the value sent by Quality Center is a valid workflow step transition in 
PPM Center.

e. The Quality Center fields with the database ID of RQ_USER_XX are user fields that are added to Quality 
Center when using the integration tool to enable a project. The value of XX is determined when the user 
field is added to Quality Center.

Table 6-2. Requirements mapping you can modify (page 2 of 2)

Quality Center Field Name,
Database ID, 
and Field Type

PPM Center Field Name,
Database ID a, 
and Field Type

Override
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Table 6-3 describes the fields that were added to Quality Center requirements 
to support integration with PPM Center requests. These fields should not be 
modified (except for their Labels, as desired).

Table 6-4 describes the fields that were added to PPM Center requests to 
support integration with Quality Center requirements. These fields should not 
be modified (except for their Field Prompts, as desired).

Table 6-3. Fields added to Quality Center requirements to support integration 
with PPM Center requests

Field Name Field Database ID Field Type Description

ITG Server RQ_USER_XX Text (120) User field containing the 
PPM Center URL.

ITG Request Type RQ_USER_XX Text (40)

User field containing the 
PPM Center request type of 
the corresponding PPM 
Center request. Used for 
field mapping.

ITG Notes RQ_USER_XX Memo

Quality Center memo field. 
Stores PPM Center notes. 
Always overridden by PPM 
Center. Added to Quality 
Center if the user chooses 
to synchronize the Notes 
field.

ITG Updates RQ_USER_XX Text (120)

User field for integration 
messages. Shows last 
operation success/error 
message in case of failure.

ITG Request ID RQ_REQUEST_ID Integer System field containing 
PPM Center request ID.
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Table 6-4. Fields added to PPM Center requests to support integration with Quality Center 
requirements

Field Name Field Database ID Field Type Description

Quality Center Instance KNTA_QC_INSTANCE
List retrieved 
from the XML 
mapping file

Quality Center 
instance URL.

Quality Center Domain KNTA_QC_DOMAIN
List retrieved 
from the XML 
mapping file

Quality Center 
domain.

Quality Center Project KNTA_QC_PROJECT
List retrieved 
from the XML 
mapping file

Quality Center project.

Quality Center Assigned 
To User KNTA_QC_ASSIGNED_TO Not applicable

Obsolete field that is 
not used by ALM. Do 
not use.

Quality Center 
Requirement No. KNTA_QC_REQUIREMENT_NO Numeric Text 

(10 digits)
Quality Center 
requirement ID.

Quality Center Status KNTA_QC_REQUIREMENT_
STATUS Text (300) Quality Center 

requirement status.

Quality Center Message KNTA_QC_REQUIREMENT_
INT_MSG Text (300)

Integration messages. 
Shows last operation 
success/error 
message.

Quality Center 
Attachments

KNTA_QC_REQUIREMENT_
ATT_URL URL

URL for Quality 
Center attachments 
page.

Quality Center 
Dashboard Subject

KNTA_QC_DASHBOARD_
SUBJECT Not applicable

Obsolete field that is 
not used by ALM. Do 
not use.

Quality Center 
Requirements coverage

KNTA_QC_REQUIREMENT_
COVERAGE Not applicable

Obsolete field that is 
not used by ALM. Do 
not use.

Quality Center Open 
Defects KNTA_QC_OPEN_DEFECTS Not applicable

Obsolete field that is 
not used by ALM. Do 
not use.
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Default Field Mappings for Quality Center Defects

This section summarizes the default field mappings for the integration between 
the Defects Module in Quality Center and the ALM - Defect Template with 
Quality Center Integration request type in PPM Center. This section includes 
the following tables:

Table 6-5 describes the default defect mappings that can be modified. The 
Override column indicates which field is dominant by default—PPM 
Center (if set to PPM), Quality Center (if set to QC), or neither (if set to 
BIDIRECTIONAL). For more information, see step 9 on page 194.

Table 6-6 on page 239 describes the fields that were added to Quality 
Center defects to support integration with PPM Center requests. These 
fields should not be modified (except for their Labels, as desired).

Table 6-7 on page 240 describes the fields that were added to PPM Center 
requests to support integration with Quality Center defects. These fields 
should not be modified (except for their Field Prompts, as desired).

Table 6-5. Defect mappings you can modify (page 1 of 3)

Quality Center Field Name,
Database ID,
and Field Type

PPM Center Field Name,
Database ID a, 
and Field Type

Override

Reproducible
BG_REPRODUCIBLE
Y/N

Reproducible
REPRODUCIBLE
Y/N

QC

Project
BG_PROJECT
List

Application
APPLICATION_CODE
List

QC

Actual Fix Time
BG_ACTUAL_FIX_TIME
Date

Actual Fix Time (days)
ACTUAL_FIX_TIME
Date

QC
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Closed in Version
BG_CLOSING_VERSION
List

Closed in Version
CLOSING_VERSION
Text (40)

QC

Severity
BG_SEVERITY
Enumeration

Severity
SEVERITY
Drop-down list

BIDIRECTIONAL

Closing Date
BG_CLOSING_DATE
Date

Closed on
CLOSING_DATE
Date

QC

Detected in Version
BG_DETECTION_VERSION
List

Detected in Version
DETECTION_VERSION
Text (40)

BIDIRECTIONAL

Planned Closing Version
BG_PLANNED_CLOSING_VER
List

Planned Closing Version
PLANNED_CLOSING_VER
List

BIDIRECTIONAL

Estimated Fix Time
BG_ESTIMATED_FIX_TIME
Number

Estimated Fix Time (days)
ESTIMATED_FIX_TIME
Numeric Text (10 digits)

BIDIRECTIONAL

Comments
BG_DEV_COMMENTS
Memo

Developer Comments
DEV_COMMENTS
Text (1800)

PPM

Detected on Date
BG_DETECTION_DATE
Date

Created On
CREATION_DATE
Date

PPM

Priority
BG_PRIORITY
Enumeration

Priority
DEFECT_PRIORITY_CODE
Drop-down list

BIDIRECTIONAL

Table 6-5. Defect mappings you can modify (page 2 of 3)

Quality Center Field Name,
Database ID,
and Field Type

PPM Center Field Name,
Database ID a, 
and Field Type

Override
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Description
BG_DESCRIPTION
Memo

Detailed Description
DEFECT_DESCRIPTION
Text (1800)

BIDIRECTIONAL

Detected By
BG_DETECTED_BY
Quality Center users list

Detected in Quality Center by
QC_DETECTED_BY
Text (40)

QC

Status b, c

BG_STATUS
Enumeration

Request Status b

STATUS_ID
List

PPM b

Quality Center Defect Status c

KNTA_QC_DEFECT_STATUS
Text (300)

QC c

Summary
BG_SUMMARY
Text (255)

Summary
DESCRIPTION
Text (200)

BIDIRECTIONAL 

a. The listed PPM Center database IDs are the same as in the PPM Workbench. The exact database IDs 
are displayed by the integration tool.

b. When the Request Status field is updated in PPM Center, the new status is sent to Quality Center. If the 
new status matches one of the defect statuses in Quality Center, the Status field in Quality Center is 
updated; if not, the update is ignored by Quality Center. 

c. When the status of a defect is updated in Quality Center, the Quality Center Defect Status field in PPM 
Center is correspondingly updated if the value sent by Quality Center is a valid workflow step transition in 
PPM Center.

Table 6-5. Defect mappings you can modify (page 3 of 3)

Quality Center Field Name,
Database ID,
and Field Type

PPM Center Field Name,
Database ID a, 
and Field Type

Override
238 Chapter 6



Table 6-6 describes the fields that were added to Quality Center defects to 
support integration with PPM Center requests. These fields should not be 
modified (except for their Labels, as desired).

Table 6-6. Fields added to Quality Center defects to support integration 
with PPM Center requests

Field Name Field Database ID Field Type Description

ITG Server BG_USER_XX a Text (120) User field containing PPM 
Center URL.

ITG Request Type BG_USER_XX a Text (40)

User field containing the 
PPM Center request type of 
the corresponding PPM 
Center request. Used for 
field mapping.

ITG Notes BG_USER_XX a Memo

Quality Center memo field. 
Stores PPM Center notes. 
Always overridden by PPM 
Center. Added to Quality 
Center if the user chooses 
to synchronize the Notes 
field.

ITG Request ID BG_REQUEST_ID Integer System field containing 
PPM Center request ID.

a. The Quality Center fields with the database ID of BG_USER_XX are user fields that are added to 
Quality Center when using the integration tool to enable a project. The value of XX is determined 
when the user field is added to Quality Center.
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Table 6-7 describes the fields that were added to PPM Center requests to 
support integration with Quality Center defects. These fields should not be 
modified (except for their Field Prompts, as desired).

Table 6-7. Fields added to PPM Center requests to support integration with Quality Center defects

Field Name Field Database ID Field Type Description

Quality Center Instance KNTA_QC_DEFECT_
INSTANCE

List retrieved 
from the XML 
mapping file

Quality Center instance 
URL.

Quality Center Domain KNTA_QC_DEFECT_
DOMAIN

List retrieved 
from the XML 
mapping file

Quality Center domain.

Quality Center Project KNTA_QC_DEFECT_
PROJECT

List retrieved 
from the XML 
mapping file

Quality Center project.

Detected in Quality Center by QC_DETECTED BY Text (40) The Quality Center user 
who detected the defect.

Defect Number KNTA_QC_DEFECT_NO Numeric Text 
(10 digits) Quality Center defect ID.

Quality Center Defect Status KNTA_QC_DEFECT_
STATUS Text (300) Quality Center defect 

status.

Quality Center Message KNTA_QC_DEFECT_
INT_MSG Text (300)

Integration messages. 
Shows last operation 
success/error message.

Quality Center Attachments KNTA_QC_DEFECT_
ATT_URL URL URL for Quality Center 

attachments page.

Quality Center Assigned To 
User

KNTA_QC_DEFECT_
ASSIGNED_TO List

Obsolete field that is not 
used by ALM. Do not 
use.
240 Chapter 6



7 Integration of PPM Center with Release 
Control or Change Control Management
Introduction to Integration of PPM Center with Release Control 
or Change Control Management 

Integrating PPM Center with HP Change Control Management or its successor 
product, HP Release Control, enables you to link directly from a change 
request in PPM Center to associated impact analysis data in HP Change 
Control Management or HP Release Control. Based on the information 
provided in HP Change Control Management or HP Release Control, you can 
then decide whether to approve or reject the deployment of the change request. 

For more information about the benefits of this integration, see Integration of 
PPM Center with HP Release Control or HP Change Control Management 
on page 21. 

For information about the versions supported for integration, see the System 
Requirements and Compatibility Matrix. 

For references to more information about HP Release Control or HP Change 
Control Management, see HP Release Control Documentation on page 23 or 
HP Change Control Management Documentation on page 24.

In this chapter, references to HP Release Control (the successor product to  
HP Change Control Management) also apply to supported versions of HP Change 
Control Management, except where distinctions between Release Control and 
Change Control Management are described as needed.

No software needs to be installed on the HP Release Control or Change Control 
Management server to integrate PPM Center with HP Release Control or Change 
Control Management. However, see the System Requirements and Compatibility 
Matrix. 
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Configuring HP Release Control for the Integration

To configure HP Release Control for integration, you must do the following:

Configure the PPM Center Web Services adapter in HP Release Control

Configure the JavaScript files in HP Release Control

Before beginning this configuration, verify that Web services are enabled for 
use with PPM Center, as follows: 

1. Stop the PPM Server.

2. Run the following script:

sh ./kConfig.sh 

3. Verify that the ENABLE_WEB_SERVICES parameter in the PPM Center 
server.conf configuration file is set to true. 

4. Restart the PPM Server.

For more information about the steps in this procedure, see the Installation and 
Administration Guide. 
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Configuring the PPM Center Web Services Adapter

To establish integration, you must configure the PPM Center Web Services 
adapter in HP Release Control to convert change requests that come from PPM 
Center to generic requests that HP Release Control can process, as follows:

1. Configure the PPM Center Web Services connector settings as described in 
the HP Release Control Installation and Configuration Guide or the  
HP Change Control Management Installation and Configuration Guide. 

2. In the itg-ws-adapter.settings file, under <request-type 
level="1">, set the requestTypeName to the name of the PPM Center 
request type representing a PPM Center release, for example, 
ALM - Release Management. 

3. In the itg-ws-adapter.settings file, under <request-type 
level="2">, set the requestTypeName to the name of the PPM Center 
request type representing a PPM Center change, for example, 
ALM - Request for Change (RFC), and set the parentRequestTypeName to 
the value of the requestTypeName in step 2. 

Before version 7.0, PPM Center was known as Mercury IT Governance Center or 
ITG. HP Release Control and HP Change Control Management software and 
documentation might still refer to PPM Center as IT Governance Center or ITG.
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Configuring the JavaScript Files

Configure the JavaScript files in HP Release Control or HP Change Control 
Management for the integration with PPM Center. 

Refer to documentation for HP Release Control or HP Change Control 
Management, and contact HP Release Control Support as necessary.

Configuring PPM Center for the Integration

Before beginning to configure the integration as described in this section, make 
sure that ALM has been installed and initially configured as described in 
Chapter 2, Installing and Setting Up ALM Software, on page 25.

Establishing Server Connections for Supported Versions

Make sure that the HTTP port is open between the PPM Server and the 
HP Release Control or HP Change Control Management machines. 

Verify that a supported version of HP Release Control or HP Change Control 
Management is installed and running (see the System Requirements and 
Compatibility Matrix).

If PPM Center is (or will be) integrated with HP Universal CMDB as well, additional 
configuration steps may be required in HP Release Control or HP Change Control 
Management before configuring the JavaScript.
244 Chapter 7



Configuring the server.conf Parameter in PPM Center

To be able to open HP Release Control from PPM Center as part of the 
integration, add and specify the parameter related to Release Control 
integration to the PPM Center server.conf configuration file, as follows:

1. Stop the PPM Server.

2. Run the following script: 

sh ./kConfig.sh 

Set the parameter and value as shown in the following table. (All parameter 
names begin with com.kintana.core.server. but that is not shown in 
the table.)

3. Verify that the ENABLE_WEB_SERVICES parameter in the server.conf file 
is set to true. 

4. Restart the PPM Server.

For more information about the steps in this procedure, see the Installation and 
Administration Guide. 

Parameter Value

CCM_MACHINE_URL

URL of the Release Control server:
http://<CCM_Host>:<Port>/ccm/ 
where <CCM_Host> represents the host machine 
on which Release Control is running
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Using the Integration of PPM Center with Release Control 

ALM provides the ALM - Releases portlet to facilitate the release request 
process (see ALM - Releases Portlet on page 84). If PPM Center and  
HP Release Control are integrated, for each release request you can click the 
Click to View link in the View Impact column in the portlet to log in to  
HP Release Control. When you log in, HP Release Control displays the 
Overview tab and other tabs. The information displayed for the selected change 
request includes the following, for example:

The “service desk application” from which the request originated. From the 
perspective of HP Release Control, PPM Center is a service desk 
application in this context. 

On the Request Details tab, the request ID number of the original change 
request, with a link to open the change request in PPM Center.

On the Request Details tab, the planned and actual start and end times for 
execution of the request. 

On the Overview tab, the number of configuration items (CIs) and 
applications that are affected by the request, with links that access the 
Impact Analysis tab, where details of the affected CIs and applications are 
displayed.

On the Collaboration tab, the communication among users regarding action 
items.

If PPM Center is integrated with HP Release Control (or HP Change Control 
Management) and with HP Universal CMDB, you can click the Launch  
HP Release Control button in the Impacted Configuration Items section of an 
ALM - Request for Change (RFC) request in PPM Center to access  
HP Release Control.
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See ALM entries.

B
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See Change Control Management.
Change Control Management

documentation,  24
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using,  246
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 65
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Manager,  97
integration of PPM Center with Universal 
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Manager,  122

security groups for integrations using 
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Service Manager adapter file,  107
validation CRT - Priority - Enabled for 

integrations using ALM,  30
workflow security for integrations using 

ALM,  31
contact user data configuration for integrations 

using ALM,  28
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documentation
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ALM-related,  33
errors

logging for integration with Service 
Manager,  136

events
logging for integration with Service 

Manager,  136

H
hierarchy synchronization of Quality Center 

requirements with PPM Center requests, 
 222

I
impact analysis

See Universal CMDB.
installing

ALM
procedure,  26
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PPM Center with Change Control 

Management using ALM
See Change Control Management: 

integration with PPM Center.
PPM Center with Quality Center using 
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See Quality Center: integration with 
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PPM Center with Release Control using 
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See Release Control: integration with 
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using ALM
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with PPM Center.
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ALM
See Service Manager: integration with 
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See Universal CMDB: integration with 
PPM Center.
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See PPM Center-Quality Center Integration 

Tool.
integrations

with other products using ALM
See name of specific product that 

integrates with PPM Center.
ITIL Change Management,  14

See also change management, ITIL.
roles,  15

ITIL Release Management,  16
See also release management, ITIL.
roles,  17

K
kConfig.sh script,  134,  143,  183,  206,  242,  245

L
logging

errors and events for Service Manager 
integration,  136

M
MAC

considerations when ALM is installed,  26
Managing Application Change

considerations when ALM is installed,  26
mapping of PPM Center and Quality Center 

fields,  169
creating,  191
defaults,  231
deploying,  203
managing,  207
Notes field in PPM Center,  202

N
Notes field in PPM Center, mapping to Quality 

Center,  202
249



P
portlets
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priority validation configuration for 
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Q
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documentation,  23
enabling a project for integration with PPM 

Center,  184
integration with PPM Center,  20,  167

configuring,  180
using,  215

special commands for integration,  92
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Release Control

documentation,  23
integration with PPM Center,  21,  241
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release management, ITIL
portlets,  80
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ALM - Deployed Releases,  81
ALM - My Releases,  82
ALM - Open Releases,  83
ALM - Releases,  84
ALM - Releases By Category,  85
ALM - Releases By Type,  86
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reports,  88
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ALM - Release Content,  90
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request type
ALM - Release Management,  70

workflows
ALM - Release Distribution workflow, 

 80
ALM - Release Request workflow,  76

reports
ALM - Change Summary,  67
ALM - Forward Schedule of Changes for 

RFC,  68
ALM - Forward Schedule of Releases,  89
ALM - Release Content,  90
ALM - Release Summary,  91
change management,  67
modifying ALM-related,  34
release management,  88

Request for Change,  34
request hierarchy synchronization for 

integration between PPM Center and 
Quality Center,  222

request types
ALM - Defect Template with Quality 

Center Integration,  170
ALM - Release Management,  70
ALM - Request for Change (RFC),  34
modifying ALM-related,  34

requirements, system
See system requirements.

RFC,  34
roles

ITIL Change Management,  15
ITIL Release Management,  17

S
scripts

kConfig.sh,  134,  143,  183,  206,  242,  245
setServerMode.sh,  27,  32

security group configuration for integrations 
using ALM,  31

service desk application integration with PPM 
Center,  17

See also Service Manager.
Service Manager

adapter file, configuring,  107
documentation,  22
integration with PPM Center,  17,  93

configuring,  97
logging of errors and events,  136

setServerMode.sh script,  27,  32
special commands

integration of PPM Center with Quality 
Center using ALM,  92

modifying ALM-related,  34
stubs, Web services

generating for integration with Service 
Manager,  105

subworkflows
See workflows.

system requirements
installing ALM,  25

U
Universal CMDB

documentation,  23
integration with PPM Center,  19,  141

configuring,  143
using,  148

Universal Configuration Management 
Database
See Universal CMDB.

V
validation configuration for integrations using 

ALM,  30

W
Web services

stubs for integration with Service Manager, 
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workflow security configuration for 
integrations using ALM,  31
251



workflows
ALM - Change Migration workflow,  61
ALM - Change Review and Approval Sub 

WF subworkflow,  50
ALM - Defect Template with Quality 

Center Integration workflow,  176
ALM - Deploy and Test Changes Sub WF 

subworkflow,  56
ALM - Impact & Resource Assessment Sub 

WF subworkflow,  52
ALM - Infrastructure Changes Sub WF 

subworkflow,  53
ALM - Non Release Sub WF subworkflow, 

 58
ALM - Plan Tests Sub WF subworkflow, 

 54
ALM - Release Distribution Sub WF 

subworkflow,  80
ALM - Release Distribution workflow,  80
ALM - Release Request workflow,  76
ALM - Release Sub WF subworkflow,  60
ALM - Request For Change workflow,  43
ALM - RFC - Urgent Change Management 

Sub WF subworkflow,  49
modifying ALM-related,  34
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